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Introduction

This document covers the Thermo Scientific™ INSIGHT™ software and the Evolution™ 200 
series UV-Visible spectrophotometers and accessories.

About the Software and Hardware

Overview

The Evolution 200 series UV-visible spectrophotometers integrate advanced hardware 
features with the power and flexibility of a wide range of Smart Accessories™. The 200 series 
spectrophotometers include:

• Evolution 201

• Evolution 220

• Evolution 260 Bio

For a list of sampling and other accessories available for these instruments, see Evolution 200 
Series Accessories.

Contents

• About the Software and Hardware

• Contacting Us

• Product Warranty

• Trademarks

• Site Preparation and Safety

Contents

• Overview

• Setting Up the Instrument

• Before Using the Spectrophotometer
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All instruments include our INSIGHT software for data collection and analysis. The 
INSIGHT software provides five modes of operation:

• Fixed, to measure the light passing through the sample at one or more wavelengths.

• Scan, to measure the light that passes through the sample over a range of wavelengths.

• Quant, to set up and perform quantitative analyses of sample data.

• Rate, to make time- and temperature-based kinetics measurements.

• Live Display, for quick measurements and simplified data collections in Fixed or Scan 
mode.

The Evolution 260 Bio systems also have operating modes for the common biological 
applications, including Nucleic Acid and Protein A280. See INSIGHT Bio Applications for 
more information.

Setting Up the Instrument

The spectrophotometer can be run from the optional touchscreen (Local Control) or from a 
Windows®-compatible computer connected to the instrument (Computer Control). Local 
Control instruments include an embedded computer preloaded with software. Computer 
Control instruments must be connected to an external computer with the proper software 
installed. All instruments include a keypad.

For instructions to set up a Computer Control or Local Control spectrophotometer and 
perform basic operations using the keypad, see Using the Spectrophotometer.

Before Using the Spectrophotometer

The spectrophotometer contains precise optical components. Handle it carefully. Before using 
the system, review the Site Preparation and Safety information and Operating Precautions.

About This Document
Contents

• Organization

• Conventions



 1 Introduction
About This Document

Thermo Scientific Evolution 200 Series Spectrophotometer User Guide 3

Organization

This document has the following main sections:

Conventions

This document uses the following conventions:

Section Description

Introduction Overview of the instrument and this document plus 
information about registering your instrument, contacting us, 
and the system warranty.

Evolution 200 Series 
Spectrophotometers

Complete instructions for using and maintaining the 
instrument.

INSIGHT Software Complete instructions for using software features other than 
biological applications and Performance Verification (see below).

Bio Applications Instructions for using biological applications to analyze samples.

Accessories Complete instructions for using accessories with the instrument.

Performance Verification Instructions for setting up and running tests to check the 
performance of the instrument.

INSIGHT Security Optional software that adds features for digitally signing files 
and verifying digital signatures.

WARNING  Indicates a hazardous situation which, if not avoided, could result in death or 
serious injury.

CAUTION  Indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury.

NOTICE    Follow instructions with this label to avoid damaging the system hardware or 
losing data.

Note  Contains helpful supplementary information.

Tip  Provides helpful information that can make a task easier.
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Contacting Us
For U.S. Technical Support, please contact:

Thermo Fisher Scientific
5225 Verona Road
Madison, WI 53711-4495 U.S.A.
Telephone: 1 800 532 4752
E-mail: us.techsupport.analyze@thermofisher.com

For International Support, please contact:

Thermo Fisher Scientific
Telephone: +1 608 273 5017
E-mail: support.madison@thermofisher.com

E-mailing Data Files
If you have questions about your data, you can send it to us as an archived workbook file 
(*.iwbk). Please send us the appropriate file as an e-mail attachment. See the description of 
E-mail Current Workbook in Menus and the description of E-mail in Data Store Tab for 
more information.

Product Warranty
Warranties herein are for products manufactured by Thermo Fisher Scientific or its authorized 
dealers.

Thermo Fisher Scientific warrants that this product is free from defects in labor and materials 
and shall conform to its product specifications as defined in the product user documentation.

This warranty covers parts (except those specified below) and labor, and applies only to 
equipment which has been installed and operated in accordance with the documentation 
supplied by Thermo Fisher Scientific, and which has been serviced only by authorized 
Thermo Fisher Scientific dealers or service personnel. This warranty does not apply to 
equipment and accessories that have been modified or tampered with in any way, misused, or 
damaged by accident, neglect, or conditions beyond Thermo Fisher Scientific’s control.

Note  Please have the instrument serial number available when you contact us.

Note  Please do not send exported report files or user-defined workbooks—these do not 
contain the information we need.
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Related Topics

Warranty Period

Items Not Covered by Warranty

Warranty Repair

Shipping Cost for Items Covered by Warranty

Update Policy

Warranty Period

With the exception of SPECTRONIC™ 20+, SPECTRONIC 20D+, GENESYS™ 20 and the 
Helios™ Epsilon spectrophotometers, all UV Visible spectrophotometers come with a 
standard warranty that is fourteen months from the date of shipment or twelve months from 
the date of installation (whichever occurs first). The replacement parts and spare components 
are warranted for 90 days from the date of shipment. If such parts are intended for long term 
storage, it is recommended that their functionality is tested immediately upon receipt and any 
problems reported to Thermo Fisher Scientific within the above specified warranty period.

The following warranties apply to instrument light sources:

1. Xenon lamps are warranted against failure for a period of three (3) years.

2. Tungsten and deuterium lamps will be replaced under warranty if they fail on the initial 
power-up or within the first month of operation.

Thermo Fisher Scientific reserves the right to request the return of failed components that are 
being replaced under warranty.

User should complete and return the Product Registration card, and retain proof of delivery 
date.

Items Not Covered by Warranty

This warranty does not apply to glassware, expendable components, peripheral devices or 
accessories not manufactured by Thermo Fisher Scientific. The manufacturer of these 
products may offer specific warranties for such parts and components.

Cleaning and calibration service is not covered by this warranty.
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Warranty Repair

In the event of failure within the warranty period, Thermo Fisher Scientific will at Thermo 
Fisher Scientific’s option, repair or replace the product not conforming to this warranty. There 
may be additional charges, including freight, for warranty service performed in some 
countries. For service, call Thermo Fisher Scientific (or its authorized dealer outside the 
United States and Canada). Thermo Fisher Scientific reserves the right to ask for proof of 
delivery date.

Warranty repairs for UV Visible instruments may vary per product line and region. UV 
Visible products manufactured by Thermo Fisher Scientific are covered by a 
“return-to-factory” parts and labor warranty. In some regions, on-site warranties, extended 
warranties and service contracts may be purchased for all products.

In the event that on-site warranty service is required, and no on-site service contract is active 
on this product, the customer is responsible for any travel expenses, labor costs, and additional 
expenses which may be incurred in the performance of on-site warranty service.

Please contact your dealer or Thermo Fisher Scientific Technical Service department for 
further information. A Return Authorization Number must be obtained from Thermo Fisher 
Scientific Technical Service before returning any product for in-warranty repair or 
replacement.

Shipping Cost for Items Covered by Warranty

It is customer’s responsibility to pay for the shipment of the product under warranty to 
Thermo Fisher Scientific.

This warranty covers return shipment (standard ground) charges for returning the repaired or 
replaced product to the customer.

Update Policy

Thermo Fisher Scientific may, from time to time, revise the performance of its products, and 
in doing so incur no obligation to furnish any such revisions to any Thermo Fisher Scientific 
customer.

THIS WARRANTY IS IN LIEU OF ALL WARRANTIES EXPRESSED, IMPLIED, OR 
STATUTORY, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF FITNESS 
FOR A PARTICULAR PURPOSE OR MERCHANTABILITY OR OTHERWISE, and 
states Thermo Fisher Scientific’s entire and exclusive liability and the Customer’s exclusive 
remedy for any claim in connection with the sale or furnishing of services, goods, or parts, 
their design, suitability for use, installation, or operations. Thermo Fisher Scientific will in no 
event be liable for any direct, indirect, special, or consequential damages, whatsoever, 
including loss of goodwill, whether grounded in tort (including negligence), strict liability or 
contract, and Thermo Fisher Scientific’s liability under no circumstances will exceed the 
contract price for the goods and/or services for which liability is claimed. 
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REPRESENTATION AND WARRANTIES MADE BY ANY PERSON, INCLUDING 
ITS AUTHORIZED DEALERS, REPRESENTATIVES AND EMPLOYEES OF 
THERMO FISHER SCIENTIFIC WHICH ALTER OR ARE IN ADDITION TO THE 
TERMS OF THIS WARRANTY SHALL NOT BE BINDING UPON THERMO 
FISHER SCIENTIFIC UNLESS IN WRITING AND SIGNED BY ONE OF ITS 
OFFICERS.

Trademarks
Microsoft, Windows and Excel are either trademarks or registered trademarks of Microsoft 
Corporation in the United States and/or other countries.

Teflon, Viton and Freon are either trademarks or registered trademarks of E. I. du Pont de 
Nemours and Company (DuPont) or its affiliates in the United States and/or other countries. 

Starna is either a trademark or a registered trademark of Starna Scientific Limited in the 
United States and/or other countries.

Hellma is either a trademark or a registered trademark of Hellma GmbH in the United States 
and/or other countries.

AccuVac and Hach are either trademarks or registered trademarks of Hach Company in the 
United States and/or other countries.

Spectralon is either a trademark or a registered trademark of Labsphere, Inc. in the United 
States and/or other countries.

All other trademarks are the property of Thermo Fisher Scientific Inc. and its subsidiaries.

Site Preparation and Safety
Before using the system, read the site preparation and safety manual on the provided 
documentation CD. Always follow the safety precautions in that manual and in this 
document when using the system.
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Evolution 200 Series Spectrophotometers

The Evolution™ 200 series UV-Visible spectrophotometers include three models:

• Evolution 201

• Evolution 220

• Evolution 260 Bio (includes biological applications).

Safety Considerations
Each person using the spectrophotometer should read the general safety information in the 
Site and Safety Information guide (see the documentation CD) and the instrument-specific 
safety information provided here.

Contents

• Safety Considerations

• Operating Precautions

• Spectrophotometer Basics

• Installing and Removing Accessories

• Using the Spectrophotometer

• Maintenance

• Ordering Parts

Contents

• Safety Label Locations

• Lifting or Moving the Instrument

WARNING  Do not operate this system without following the safety precautions described 
in this manual and the documentation that came with your system.
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Safety Label Locations

This section shows the locations of safety labels on the spectrophotometer. If there are 
questions or problems with the safety labels, contact us using the information provided at the 
beginning of this document.

Back view

Right side view

Compliance label

UV radiation warning label (under mercury lamp access cover)
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Left side view

Related Topics

Removing and Installing the Detector Module

Lifting or Moving the Instrument

To avoid risk of injury, use proper techniques when lifting or moving the instrument or other 
system components.

UV radiation warning label (under detector access cover)

Hand hold

Hand hold
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Operating Precautions
The spectrophotometer contains precise optical components. Handle it carefully and follow 
these precautions:

• Do not allow moisture to leak into the instrument interior.

• Wipe off spilled chemicals immediately.

• Do not drop the instrument.

• Protect the instrument from mechanical shock.

• Protect the instrument from dust.

Spectrophotometer Basics
Contents

• Spectrophotometer Components

• Connectors

• Removable Panels

• Corrosion Protection



 2 Evolution 200 Series Spectrophotometers
Spectrophotometer Basics

Thermo Scientific Evolution 200 Series Spectrophotometer User Guide 13

Spectrophotometer Components

The following illustration identifies major components visible on the outside of a typical 
spectrophotometer. (Some components may not be present on all instruments.)

The z-height (distance from the bottom of the cell to the center of the light beam) for the 
spectrophotometer is 8.5 mm.

Related Topics

Opening and Closing the Sample and Reference Compartment Doors

Local Control or Computer Control

INSIGHT Software

Keypad

Touchscreen

Opening and Closing the Sample and Reference Compartment Doors

To open the sample compartment, press the button on its door. To close the compartment, 
slide the door forward until it latches.

To access the reference compartment, lift or lower the door.

Optional touchscreen
Sample compartment

Keypad

Reference compartment
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Related Topics

Sample Compartment Front Panel

Tubing Access Panel

Local Control or Computer Control

The spectrophotometer can be run from the optional touchscreen (Local Control) or from a 
Windows®-compatible computer connected to the instrument (Computer Control). Local 
Control instruments include an embedded computer preloaded with software. Computer 
Control instruments must be connected to an external computer with the proper software 
installed.

Related Topics

Local Control Instruments

Computer Control Instruments

INSIGHT Software

All instruments include our INSIGHT™ software for data collection and analysis. See 
INSIGHT Software.

Keypad

All instruments include the keypad shown below. For a list of keypad functions, see Using the 
Spectrophotometer.

Related Topics

Keypad Operation

Touchscreen

The touchscreen is included only on Local Control versions of the spectrophotometer.

Related Topics

Touchscreen keyboard
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Cleaning the Touchscreen

Connectors

This section shows the locations of the connectors inside and outside the spectrophotometer.

Outside Cover

This illustration shows the connectors on the instrument outside cover.

Back view

Contents

• Outside Cover

• Inside the Sample Compartment

Label Function

Computer Dedicated USB port for connecting an external computer. See 
Computer Control Instruments.

Hg lamp Connects to the optional Mercury Lamp accessory.

Power Connects to main power cord.

Power switch System power On/Off switch.

Purge Connects to optional purge source. See Purging the Sample 
Compartment.

Purge

USB

USB

Computer
Power

Power switch

Hg lamp
Trigger
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The system supports these USB devices:

• External USB mouse

• External USB keyboard

• Portable USB memory

• Windows-compatible USB printer

To ensure proper shielding of USB devices, install a Ferrite ring (samples provided) on the end 
of any USB cable connected to the instrument. Loop the cable once and clamp the ring over 
the loop as shown below.

Trigger Connects to optional accessories that accommodate external trigger 
input or output. For more information, find the Integrated Fiber Optic 
Module User Guide in the documentation media.

INSIGHT can be used to send a 3.3V TTL output signal that triggers 
an installed accessory to begin an operation. The signal can be sent at the 
start or end of a measurement. See Options > Preferences > Triggering.

INSIGHT accepts a contact closure input trigger (equivalent to pressing 
Run on the instrument keypad).

USB General purpose USB connectors (Local Control systems only). See 
below for proper shielding of USB cables.

Label Function

WARNING  Avoid shock hazard. Power off the spectrophotometer and disconnect the 
power cord from the wall outlet or power strip before disconnecting the power cord from 
the spectrophotometer.

Note  The spectrophotometer does not support high power USB devices.

Ferrite ring
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Related Topics

Triggering

Purging the Sample Compartment

Computer Control Instruments

Inside the Sample Compartment

This illustration identifies the connectors inside the sample compartment.

Related Topics

Installing a Smart Accessory

Removable Panels

This section covers panels that can be removed to allow access to features on the instrument.

Smart Accessory 
connector

Contents

• Sample Compartment Front Panel

• Tubing Access Panel

• Mercury Lamp Access Cover

• Detector Access Cover

• Detector Access Panel
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Sample Compartment Front Panel

To remove the front panel, open the sample compartment door and then pull the panel 
forward and up to free it.

To replace the panel, align the tab on the bottom edge with the slot in the instrument cover 
and press the panel in place.

Related Topics

Installing a Manual Accessory

Installing a Liquid Thermostatted Accessory

Installing a Smart Accessory

Removable panel

Tab
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Tubing Access Panel

To access external ports for routing fluid from a recirculator to the instrument, remove the 
panel below the sample compartment.

Internal fluid ports for routing fluid from the instrument to an installed accessory are located 
inside the sample compartment.

The connectors fit 1/4-inch internal diameter tubing. An adapter may be required to connect 
the tubing to the accessory or recirculator. Purchase adapters separately.

Cords and cables for installed accessories can also be routed behind this panel. Push the cord 
through the foam and the opening below it. The panel itself can be removed temporarily to 
accommodate a large connector. To remove the panel, loosen the screw.

Related Topics

Installing a Liquid Thermostatted Accessory

External fluid ports

Internal fluid ports Screw
Foam
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Mercury Lamp Access Cover

Lift the cover to install the optional Mercury Lamp.  For more information, refer to the 
Mercury Lamp User Guide in the documentation media.

Right side view

Detector Access Cover

Some accessories require removing the instrument detector module. The module is beneath 
the detector access cover shown below. Avoid UV radiation hazard in the detector 
compartment. Protect eyes and skin from exposure.

WARNING  Avoid UV radiation hazard in the mercury lamp compartment. Protect eyes 
and skin from exposure.

Mercury lamp access cover

CAUTION  Safety glasses with side shields or goggles with solid side pieces are the only 
equipment that provides adequate eye protection against direct and reflected UV light.
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Left side view

Related Topics

Removing and Installing the Detector Module

Detector Access Panel

Detector Access Panel

To remove the panel between the detector and sample compartment, remove the sample 
compartment window and then loosen the thumbscrew.

To replace the panel, hook the tabs on the bottom edge over the slots in the sample 
compartment side wall and tighten the thumbscrew.

Detector access cover

Removable panel

Thumbscrew
Window (optional)

Thumbscrew
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Related Topics

Removing and Installing the Detector Module

Detector Access Cover

Installing Sample Compartment Windows

Corrosion Protection

The spectrophotometer contains precise optical components that may be damaged by a 
corrosive environment. Before using the instrument to analyze volatile, corrosive or caustic 
samples, install the optional sample compartment windows and, if necessary, purge the sample 
compartment.

Related Topics

Installing Sample Compartment Windows

Purging the Sample Compartment

Installing Sample Compartment Windows

The optional windows attach to the sample compartment side walls using magnets.

Related Topics

Purging the Sample Compartment

NOTICE    The warranty does not cover damage to internal optics or electronics caused by 
failure to use sample compartment windows.

Sample compartment window (2)
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Purging the Sample Compartment

Purging the sample compartment removes moisture from the sampling area for subambient 
temperature-controlled measurements. When purging the instrument, install sample 
compartment windows in addition to purge.

Related Topics

Installing Sample Compartment Windows

Selecting a Purge Gas

Installing Purge

Selecting a Purge Gas

Use dry air or dry nitrogen to reduce or eliminate condensation. The purge gas must be free of 
moisture, oil and other reactive materials. To remove particulate matter and oil, install a 
10-micrometer filter.

Related Topics

Installing Sample Compartment Windows

Installing Purge

Installing Purge

Use 1/4-inch internal diameter tubing to connect a purge gas source to the purge fitting on 
the back of the spectrophotometer.

Related Topics

Installing Sample Compartment Windows

Selecting a Purge Gas

WARNING  Never use a flammable gas to purge the instrument.



2 Evolution 200 Series Spectrophotometers
Installing and Removing Accessories

24 Evolution 200 Series Spectrophotometer User Guide Thermo Scientific

Installing and Removing Accessories

Standard Cell Holders

The instrument includes one sample and one reference cell holder. For a list of optional cell 
holders and other accessories, click the Evolution 200 Series Accessories button in the 
documentation media.

Related Topics

10 mm Rectangular Sample Cell Holder

Rectangular Reference Cell Holder

10 mm Rectangular Sample Cell Holder

This single-cell holder is mounted on the standard baseplate and accommodates standard 
10 mm pathlength cells. See Installing a Manual Accessory.

Use the cell lifter to raise the cell for easy removal. This cell holder allows fine adjustment of 
the vertical and horizontal position of the cell. This feature is useful for aligning reduced 
volume and microcuvettes with the light beam. See z-height.

Related Topics

Rectangular Reference Cell Holder

Contents

• Standard Cell Holders

• Installing a Manual Accessory

• Installing a Smart Accessory

• Installing a Liquid Thermostatted Accessory

• Installing a Reference Cell Holder

Cell lifter and vertical alignment
Horizontal alignment
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Spectrophotometer Z-height

Rectangular Reference Cell Holder

For measurements with a reference sample, install a reference cell holder in the reference 
position. See Installing a Reference Cell Holder.

The standard reference holder accommodates rectangular reference cells with these 
pathlengths: 10 mm, 20 mm, 40 mm, 50 mm and 100 mm.

Related Topics

10 mm Rectangular Sample Cell Holder

Installing a Manual Accessory

Manual sampling accessories are mounted on a common baseplate. The kinematic mount 
ensures correct alignment of the accessory within the instrument.

It is not necessary to power off the instrument while installing or removing a manual 
accessory.
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Sample compartment top view

 To install a manual accessory

1. Open the sample compartment door. See Opening and Closing the Sample and 
Reference Compartment Doors.

2. Remove any accessory from the compartment (see the instructions below).

3. Position the accessory so the two alignment holes on its baseplate fit over pins A and B in 
the sample compartment.

4. Gently push down on the front edge of the baseplate until it snaps in place under the 
toggle.

5. Close the sample compartment door. See Opening and Closing the Sample and Reference 
Compartment Doors.

For operating instructions and installation details, see the user guide for the accessory.

 To remove a manual accessory

1. Use the handle or finger hole on the accessory baseplate to release the plate from the 
toggle.

2. Lift the plate off the alignment pins and remove the accessory from the sample 
compartment.

Related Topics

Installing a Liquid Thermostatted Accessory

Installing a Smart Accessory

Installing a Reference Cell Holder

Alignment pins

Toggle

A B
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Installing a Smart Accessory

Smart Accessories include cell changers and sample holders that feature auto recognition, 
smart alignment and serial number reporting. Smart Accessories ensure software methods are 
properly configured.

These accessories install in the sample compartment. A connector under the accessory 
baseplate provides data communication and power.

It is not necessary to power off the instrument while installing or removing a Smart Accessory.

Sample compartment top view

 To install a Smart Accessory 

1. Open the sample compartment door. See Opening and Closing the Sample and 
Reference Compartment Doors.

2. Remove the sample compartment front panel. See Sample Compartment Front Panel.

3. Remove any cell holder or accessory. See To remove a Smart Accessory.

4. Insert the accessory.

a. Grasp the accessory by the handles and lower it into the sample compartment 
aligning the connector under the baseplate with the connector in the sample 
compartment floor.

Alignment pins

Toggle

A B

Smart Accessory connector

Alignment pins
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Use the alignment pins on either side of the connector as guides.

b. Line up the two holes at the back of the accessory with pins A and B in the sample 
compartment.

c. Press down on the front of the accessory to secure the connection.

The software displays a prompt to initialize the accessory.

5. Replace the sample compartment front panel. See Sample Compartment Front Panel.

6. Close the sample compartment door. See Opening and Closing the Sample and Reference 
Compartment Doors.

7. Click OK to initialize the accessory.

Initialization reads information about the accessory and, for cell changers, moves it to 
position 1.

For operating instructions and installation details, see the user guide for the accessory.

 To remove a Smart Accessory

1. Open the sample compartment door. See Opening and Closing the Sample and 
Reference Compartment Doors.

2. Remove the sample compartment front panel. See Sample Compartment Front Panel.

3. Grasp the handles and pull the accessory up and out of the sample compartment.

Alignment pins

Smart Accessory connector

Smart Accessory

Connector (under baseplate)

CAUTION  Avoid pinch hazard. Keep hands and objects clear of the accessory during 
initialization.
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The software confirms the accessory has been removed.

4. Replace the sample compartment front panel. See Sample Compartment Front Panel.

5. Close the sample compartment door. See Opening and Closing the Sample and Reference 
Compartment Doors.

Related Topics

Installing a Liquid Thermostatted Accessory

Installing a Manual Accessory

Installing a Reference Cell Holder

Installing a Liquid Thermostatted Accessory

A liquid thermostatted accessory has ports and internal chambers for circulating fluids 
through the unit for temperature-controlled measurements. Other accessories circulate fluids 
to cool heated components.

The Recirculator Tubing Kit provides parts for connecting an accessory to a temperature 
controller or fluid recirculator.

 To install a thermostatted accessory

1. Install the accessory.

See Installing a Manual Accessory or Installing a Smart Accessory.

2. Remove the tubing access panel. See Tubing Access Panel.

3. Use 1/4-inch internal diameter tubing to connect the temperature controller, water 
supply or recirculator to the external fluid ports on the instrument.
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If the connectors on the temperature controller, water supply or recirculator are a 
different size, use a tubing adapter.

4. Use additional tubing and adapters (not included), if necessary, to connect the fluid ports 
inside the sample compartment to the ports on the accessory.

For a cell changer, set the changer to position 1 before connecting the tubing to the ports 
on the accessory. Use just enough tubing to allow the cell changer to move through all 
possible positions. This requires approximately 10 inches (25 cm) of tubing for each port.

Related Topics

Installing a Smart Accessory

Installing a Manual Accessory

Installing a Reference Cell Holder

Note  Ensure the tubing does not obstruct the light beam or prevent the sample 
compartment door from closing. If necessary, secure the tubing using the supplied 
clips.

External fluid ports

Internal fluid ports
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Installing a Reference Cell Holder

 To install a reference cell holder

1. Open the reference compartment cover. See Opening and Closing the Sample and 
Reference Compartment Doors.

2. Grasp the cell holder by the handle and lower it into the reference compartment.

3. Insert the pin in the alignment hole and press the holder in place.

4. Close the reference compartment cover.

For descriptions of the available reference holders, see Reference Cell Holders or search for that 
name in the INSIGHT Help system.

Related Topics

Installing a Smart Accessory

Installing a Manual Accessory

Installing a Liquid Thermostatted Accessory

Using the Spectrophotometer
This section explains how to set up a Computer Control or Local Control spectrophotometer 
and perform basic operations using the keypad.

Handle

Contents

• Computer Control Instruments

• Local Control Instruments
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Computer Control Instruments

Computer Control instruments must be connected to an external computer with the proper 
software installed.

All instrument features can be run from the computer using our INSIGHT software. Basic 
operations such as powering the spectrophotometer on and off, measuring a sample or 
baseline and running predefined macros can also be performed from the instrument keypad 
(see Keypad Operation).

Related Topics

Setting up a Computer Control Instrument

Turning off a Computer Control Instrument

Local Control Instruments

Setting up a Computer Control Instrument

 To set up a Computer Control instrument

1. Connect the supplied USB cable to the Computer port on the back of the 
spectrophotometer.

2. Connect the other end of the cable to the USB port on the back of the computer.

3. Turn on the spectrophotometer main power switch (on the back panel).

4. If the main power switch is already on, press the Power button on the keypad.

Wait for the system to initialize. This may take several minutes. The power indicator on 
the keypad stops blinking when initialization is complete.

5. Turn on the remote computer.

6. Double-click the INSIGHT desktop icon to start the software.

Related Topics

Turning off a Computer Control Instrument

Local Control Instruments

Note  If the instrument fails to initialize, the power indicator blinks rapidly. Contact us.

Tip  For routine use, leave the power switch on the instrument back panel in the On 
position and use the Power button on the keypad to turn the instrument on and off (press 
and hold the keypad Power button 4 seconds to power off ).
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Turning off a Computer Control Instrument

 To turn off the instrument

1. Close INSIGHT software.

2. Hold down the Power button on the keypad for 4 seconds.

3. If necessary, turn off the spectrophotometer main power switch (on the back panel).

Related Topics

Setting up a Computer Control Instrument

Local Control Instruments

Local Control Instruments

Local Control instruments include a touchscreen and an embedded computer preloaded with 
INSIGHT software. Follow these steps to set up a Local Control instrument to run from the 
touchscreen or from a remote computer.

All instrument features can be run from the touchscreen or remote computer. Basic operations 
such as powering the spectrophotometer on and off, measuring a sample or baseline and 
running predefined macros can also be performed from the instrument keypad (see Keypad 
Operation).

Related Topics

Setting up a Local Control instrument for touchscreen operation

Setting up a Local Control instrument for remote operation

Turning off a Local Control Instrument

Computer Control Instruments

Setting up a Local Control instrument for touchscreen operation

 To set up a Local Control instrument (no computer connected to the instrument)

1. Turn on the spectrophotometer main power switch (on the back panel).

2. Press the Power button on the keypad.

Wait for the system to initialize. The power indicator on the keypad stops blinking when 
initialization is complete. INSIGHT software starts automatically and appears on the 
touchscreen.
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Related Topics

Setting up a Local Control instrument for remote operation

Turning off a Local Control Instrument

Computer Control Instruments

Touchscreen keyboard

Setting up a Local Control instrument for remote operation

 To set up a Local Control instrument to run from a remote computer

1. Connect the supplied USB cable to the Computer port on the back of the 
spectrophotometer.

2. Connect the other end of the cable to the USB port on the back of the computer.

3. Turn on the spectrophotometer main power switch (on the back panel).

4. Press the Power button on the keypad.

Wait for the system to initialize. The power indicator on the keypad stops blinking when 
initialization is complete. INSIGHT software starts automatically and appears on the 
touchscreen.

5. Make sure the remote computer is on.

6. Do one of the following:

• Hold down the Function 4 and Function 2 keys on the instrument keypad for 
4 seconds.

• From the INSIGHT software displayed on the touchscreen, choose System Settings 
> System. In the Instrument Control group, select Computer.

7. Double-click the INSIGHT desktop icon on the remote computer to start the software.

Tip  For routine use, leave the power switch on the instrument back panel in the On 
position and use the Power button on the keypad to turn the instrument on and off.
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Related Topics

Setting up a Local Control instrument for touchscreen operation

Turning off a Local Control Instrument

Computer Control Instruments

Turning off a Local Control Instrument

 To turn off the instrument

1. Close INSIGHT software.

2. Press the Power button on the keypad.

3. Respond to the prompt to shut down Windows software.

4. If necessary, turn off the spectrophotometer main power switch (on the back panel).

Related Topics

Setting up a Local Control instrument for touchscreen operation

Setting up a Local Control instrument for remote operation

Computer Control Instruments

Note  To return control to the touchscreen, from the INSIGHT software displayed on the 
remote computer:

1. Do one of the following:

• Choose System Settings > System. In the Instrument Control group, select 
Instrument Local.

• Hold down the Function 4 and Function 1 keys on the instrument keypad for 
4 seconds.

2. Double-click the INSIGHT desktop icon on the touchscreen to start the software.

Tip  For routine use, leave the power switch on the instrument back panel in the On 
position and use the Power button on the keypad to turn the instrument off.
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Keypad Operation

Use the keypad on the Evolution 200 instrument front panel to perform the following 
operations.

Keypad Shortcuts

Button Label Function

Enter Confirm highlighted choices in menus and text entry boxes.

Run Perform the measurements specified using the current settings.
When the Loading Guide is displayed, pressing Run is equivalent 
to clicking the OK button in the software.

Stop Stop the current operation.
When the Loading Guide is displayed, pressing Stop is equivalent 
to clicking the Cancel button in the software.

Zero/Base Perform a zero measurement or baseline scan.

Power Turn the instrument on or off (press and hold 4 seconds to power 
off ).

Function Start an assigned program or CUE script. See Assigning Programs 
to Function Keys for details. Use the CUE application to edit 
scripts. See the CUE on-line help for details.

Action Keypad Shortcut

For Local Control instruments:

• Switch INSIGHT control from touchscreen to 
remote computer

• Switch INSIGHT control from remote computer 
to touchscreen

Function 4/Function 2 (hold 
down 4 seconds)

Function 4/Function 1 (hold 
down 4 seconds)
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Assigning Programs to Function Keys

The function keys on the Evolution 200 instrument front panel are managed by the 
INSIGHT Launcher application, which opens automatically each time a user logs on to the 
system computer. When the INSIGHT Launcher is running, the INSIGHT icon appears in 
the Windows status tray area (on the right side of the Windows task bar) as shown below.

Each function key can be assigned to any executable program such as the Windows Notepad 
application or a script created using our CUE application.

 To assign an executable program to a function key

1. Open INSIGHT software.

2. Double-click the INSIGHT icon on the right side of the Windows task bar. 

The Instrument Button Configuration window is displayed.

Note  Function key assignments are shared by all users of the system computer. However, 
a specific user’s ability to run a program from a function key is controlled by their 
Windows user account privileges, which are assigned by the Windows administrator.
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3. To associate an executable program with a function key, enter the program’s full path 
name in one of the Button boxes or use the browse (...) button to the right of an entry box 
to locate and select the program and then click Open.

This example shows how to select a script from the CUE Example Scripts folder provided 
with INSIGHT software. CUE scripts have the file name extension *.TCUE.

4. Assign other programs to the remaining function keys as desired.

The example below shows two CUE scripts assigned to buttons 1 and 2 and the Windows 
Notepad application assigned to button 3.
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5. When you are finished assigning programs to function keys, click Apply and then click 
Close.

The button assignments are persistent and will be active the next time a user logs on.

Maintenance

Routine Maintenance

Clean the instrument regularly using approved methods (wipe off spilled chemicals 
immediately).

Related Topics

Maintenance

Cleaning the Instrument

Clean the exterior of the instrument and the sample and reference compartment interior 
periodically. These compartments have a port to allow small amounts of liquid to drain from 
the instrument.

To clean the touchscreen, see Cleaning the Touchscreen.

 To clean the instrument exterior and the sample or reference compartment interior

1. Use a lint-free cloth dampened with a weak solution of detergent and water to wipe the 
surface as necessary.

2. Repeat using a cloth dampened with plain water.

3. Dry the surface with another cloth.

Related Topics

Maintenance

Contents

• Routine Maintenance

• Cleaning the Instrument

• Cleaning the Touchscreen

• Removing and Installing the Detector Module

NOTICE    Do not allow moisture to leak into the instrument interior.
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Cleaning the Touchscreen

Clean the instrument touchscreen as needed to remove dust, fingerprints and other materials.

 To clean the touchscreen

1. Press the Power button on the keypad to turn off the spectrophotometer.

2. Wipe the screen gently with a soft, lint-free cloth dampened (not wet) with distilled 
water.

To remove stubborn materials or oil, use a standard screen cleaner kit that includes 
antistatic wipes. Spray a little solution on the wipe and rub it gently across the screen.

3. Dry the screen with a clean, lint-free cloth.

Related Topics

Maintenance

Removing and Installing the Detector Module

Some accessories have a dedicated detector and require removing the instrument detector 
module before they can be installed.

Avoid UV radiation hazard in the detector compartment. Protect eyes and skin from 
exposure.

 To remove the detector module

1. Turn off the spectrophotometer main power switch (on the back panel).

2. Remove the detector access cover. See Detector Access Cover.

CAUTION  Safety glasses with side shields or goggles with solid side pieces are the only 
equipment that provides adequate eye protection against direct and reflected UV light.
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3. Loosen the thumbscrew that attaches the detector module to the instrument, and 
carefully lift the module straight up.

4. Replace the detector access cover.

5. Store the detector module in a secure, dust-free location.

 To install the detector module

1. Turn off the spectrophotometer. See Using the Spectrophotometer.

2. Remove the detector access cover. See Detector Access Cover.

3. Unplug the accessory detector cable if necessary.

4. Position the detector module so its thumbscrew faces left.

5. Line up the connector on the bottom of the detector module with the connector in the 
detector compartment, and then press down on the module to secure the connection.

6. Tighten the thumbscrew by hand.

7. Replace the detector access cover.

Related Topics

Maintenance

NOTICE    Avoid touching the connector pins on the bottom of the detector module.

Thumbscrew

Detector module

Thumbscrew
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Detector Access Cover

Detector Access Panel

Ordering Parts
To order replacement parts, contact us using the information provided at the beginning of this 
document.
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3

INSIGHT Software

Applications

Contents

• Applications

• The INSIGHT Window

• Thermo Software IQ

• Operation

• Options

• System Settings

• Keyboard Shortcuts

Contents

• Fixed

• Scan

• Quant

• Rate

• Live Display

INSIGHT Bio Applications may also be available.
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Fixed

Related Topics

The INSIGHT Window

Performing a Fixed Measurement

Setting Application Parameters

Scan

Related Topics

The INSIGHT Window

Performing a Scan Measurement

Setting Application Parameters

Quant

Related Topics

The INSIGHT Window

Setting Application Parameters

Performing a Quantitative Analysis

The Fixed application measures the light passing through 
the sample at one or more wavelengths. To work with this 
application, click Fixed in the right pane in Home.

The Scan application measures the light that passes 
through the sample over a range of wavelengths. To work 
with this application, click Scan in the right pane in 
Home.

Use the Quant application to set up and perform 
quantitative analyses of sample data for Fixed or Scan 
applications. To work with this application, click Quant 
in the right pane in Home.
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Rate

Related Topics

The INSIGHT Window

Setting Application Parameters

Performing a Rate Measurement

Live Display

Related Topics

The INSIGHT Window

Acquiring Data using Live Display

Performing Fixed Measurements

Performing Scan Measurements

The INSIGHT Window
The INSIGHT window is divided into panes. At the left is the navigation pane, which 
contains task buttons and action buttons for displaying software features and performing 
operations. The right pane provides access to applications, stored data, software settings and 
data acquisition features.

Above the panes is a menu bar that can include features for working with workbooks, 
performing math, analysis and other operations, and getting help. The available features 
depend on the selected application, whether spectral data is displayed, etc.

Use the Rate application to make time- and 
temperature-based kinetics measurements. To work with 
this application, click Rate in the right pane in Home.

Use the Live Display application for quick measurements 
and simplified data collections in Fixed or Scan mode. To 
work with this application, click Live Display in the right 
pane in Home.

Click Home in the navigation pane at any time to see 
applications available in the right pane.



3 INSIGHT Software
The INSIGHT Window

46 Evolution 200 Series Spectrophotometer User Guide Thermo Scientific

 To “right-click” a software feature on a Local Control system

1. Click the feature.

2. Display the keyboard by clicking  or .

3. Click the key indicated below.

Related Topics

Navigation Pane

Right Pane

Menus

Instrument Status Monitors

Navigation Pane

The navigation pane at the left side of the window contains features for the current 
application:

Task Buttons
Action Buttons
Other Navigation Pane Features

To display a keyboard for entering information or for “right-clicking” software 
features (for example, to display a shortcut menu) on a Local Control system, click 
this icon in the lower-left corner of the INSIGHT window. See the procedure below 
for more information.

Alternatively, click this icon on the Windows taskbar. If the taskbar is not visible, click 
the bottom (or other) edge of the Windows desktop to display it. 

Click this key
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Related Topics

Right Pane

Menus

Task Buttons

The main task buttons (present when the software starts) provide access to basic operations:

Other task buttons may be available for specific applications:

Related Topics

Action Buttons

Other Navigation Pane Features

Button Description

Home Gives access to user groups and their applications. (The default is Classic.)

My Data Provides tools for storing and retrieving data and other information.

Options Includes features for controlling how users interact with the software.

System Settings Provides features for aligning accessories, calibrating lamps, updating 
firmware and performing other tasks.

If a Local Control instrument is connected to an external computer 
running INSIGHT software, use the Instrument Control options on the 
System tab to select the desired location of instrument control.

Button Description

Measure (current 
application)

Displays data acquisition features for the current application.

Reports Configures reports containing sample data and specifies how to 
print reports.

Oligo Calculator Calculates molecular weight, extinction coefficients, concentration 
factors and melting points for nucleic acid sequences.

Dye/Chrom. Editor For entering and editing new dyes rather than using one of the 
precoded default dyes.
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Action Buttons

These action buttons appear at the top of the navigation pane when appropriate for the 
opened application:

Other action buttons may appear for some tasks.

Related Topics

Task Buttons

Other Navigation Pane Features

Button Description

Starts sample data acquisition, displaying prompts for confirming samples 
information, loading samples, saving data or performing other actions. Available 
only after a blank measurement for some applications. May measure single or 
multiple samples, depending on the application settings.

Measures the baseline for the application.

Measures the blank for the application.

Stops data acquisition.

Prints a copy of the spectrum and associated sample data to the default printer.

Note  To start data acquisition automatically after a specified delay instead of responding 
to a prompt, use Enable auto input trigger on the Preferences tab in Options.
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Other Navigation Pane Features

Feature Description

Overlay data Displays multiple spectra or multiple fixed data points as they are 
acquired. The overlaid sample IDs appear in the upper-left corner of the 
data display. To display the spectrum or data point of interest in red, click 
its sample ID. The last sample measured appears in red at the top of the 
legend. Available for Fixed and Scan applications only.

Advanced 
Calculations

For selecting predefined formulas for additional data processing, with the 
results appearing in a calculations table at the bottom of the right pane. 
Options include basic math and statistics. The formulas can be applied 
to specific samples and columns of data in the sample measurements 
table or to selected rows and columns in the calculations table for the 
current workbook or template. Calculations are applied to all 
subsequently acquired data. Custom calculations are saved with the 
workbook or template. Available for all applications except Rate.

To delete the contents of a cell in the calculations table, right-click the 
cell and choose Delete.

 To add column and row headings to the calculations table

1. Click a cell that needs a heading or other label.

2. In the Advanced Calculations Cell Properties box, choose Text.

3. Type the heading or label text.

4. To select the background color for the text displayed in the 
calculations table, click Background, choose a color and click OK.

5. To display the cell contents in bold text, click Bold Text.

6. Click OK.
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 To define calculations based on the samples table

1. In the calculations table, click the cell where you want the 
calculation result to appear.

2. In the Advanced Calculations Cell Properties box, choose 
Calculation.

3. Select an equation in the Equation list box.

The list of available equations is fixed.

4. Set Source to Samples table.

5. Select a sample measurement in the Column list box.

6. Specify the sample rows to include by entering their ID numbers in 
the Range/Reference box.

Use a colon to specify a range (e.g., 2:5 or 1:N) or commas for 
individual samples (e.g., 1,3,5).

7. To select the background color for the cell that displays the 
calculated result, click Background, choose a color and click OK.

8. To display the cell contents in bold text, click Bold Text.

9. Choose OK.

The calculated result appears in the selected cell.

Feature Description
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Related Topics

Adding Custom Calculations

Task Buttons

Action Buttons

 To define a calculation based on the calculations table

1. In the calculations table, click the cell where you want the 
calculation result to appear.

2. In the Advanced Calculations Cell Properties box, choose 
Calculation.

3. Select an equation in the Equation list box.

4. Set Source to Calculations Table.

5. Specify the table cells to include by entering their ID numbers in the 
Range/Reference box.

If Equation is set to Std. Deviation, Mean, or %RSD, use a colon to 
specify a range (e.g., A2:A5 or A1:AN) or commas for individual 
cells (e.g., A1,A3,A5).

If Equation is set to Addition, Subtraction, Multiplication or 
Division, specify one cell location in each Reference box. (e.g., A1).

If Equation is set to a Factor, use the first (Reference) box to specify 
a cell location and the second (Factor) box to enter the factor.

6. To select the background color for the cell that displays the 
calculated result, click Background, choose a color and click OK.

7. To display the cell contents in bold text, click Bold Text.

8. Choose OK.

The calculated result appears in the selected cell.

Feature Description
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Right Pane

When the Home screen is not displayed, the right pane is used for application settings, sample 
measurement results, available workbooks, and other features.

Related Topics

Data Display

Working With Labels

Navigation Pane

Menus

The right pane in Home includes:

Feature Description

Select a user group to access its applications (see 
“Application buttons” below). See Configuring the Home 
Page for information on associating applications with 
user groups.

Click a button (for example, Fixed or Scan) to open an 
application. The available applications depend on the 
selected user group (see “Group” above).

Click this button to access instrument performance tests. 
See Performance Verification.

Click this button to access Live Display mode, which 
allows quick collection of data using the Fixed or Scan 
application. The data can be collected in absorbance or 
% transmittance. The results can be displayed, printed 
and stored.

If this template list is present, you can double-click a 
template to open it and the associated application. See 
Configuring the Home Page for information on 
associating the Template list with user groups.
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Configuring the Home Page

The Home page can be configured to display the application buttons and templates you use 
most frequently. You can group and arrange application buttons to suit one or many users. 
The template list can be displayed or hidden.

 To access the features for configuring the home page

1. Click Options.

2. Click the Applications Tab.

 To add a new group

Enter the desired group name in the Groups box and click Add.

After you click Add, the new group name appears in the Group box and the available 
applications appear in the Applications box.

 To customize the current group

Drag the desired applications from the Applications box to the buttons at the right. To 
remove an application from the group, drag it from its button to the Applications box.

 To delete the current group

Click Delete Group and then click Yes when prompted.



3 INSIGHT Software
The INSIGHT Window

54 Evolution 200 Series Spectrophotometer User Guide Thermo Scientific

 To reset the application buttons for the current group

Click Clear App Buttons and then click Yes when prompted.

 To make custom templates available for groups other than Classic

Drag the List of Templates item from the Applications box to one of the top nine menu 
buttons.

Related Topics

Applications Tab

Right Pane

Data Display

For some applications, clicking the Measure task 
button provides a data display in the right pane for 
viewing sample data immediately after acquisition or 
from previous measurements.

Sample ID

X and Y values of pointer location

Click to expand vertically

Click to use view finder

Sample measurements table

Results table
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All data acquired with the current workbook are listed in the sample measurements table. To 
view data, select them in the list. To select multiple spectra (or sample points), hold down 
Shift or Ctrl. To display data from multiple samples as they are measured, select Overlay data 
in the navigation pane.

The sample IDs appear at the top of the data display, with the selected spectrum (or sample 
points) and sample ID in red. To turn off the sample IDs, right-click the data display, point to 
Sample Legend and choose OFF.

For scan data, the X and Y values of the pointer location appear below the data display. To 
enlarge a region, draw a box around it and click inside the box. Alternatively, click  (if 
available) to reveal the view finder which has additional display tools.

To expand the data display vertically, click  .

To change the appearance of the axes or data, right-click an axis and choose Display 
Attributes. View the effects on the display while adjusting the attributes. To change the color 
of the axes or their labels, click the appropriate color box. Your selections will affect the 
appearance of data on the display and in printed reports.

The Sample ID readout at the right of the display shows the name of the sample being 
measured (or to be measured). The results table below the Sample ID shows the results of 
analysis operations (Peak Pick and Value Level Crossings for Scan data) and whether sample 
points fall within specified control limits (for Fixed data).

Right-click the display to access these features (if available for the current data type):

Feature Description

Copy To Clipboard Copies the plotted data as it is currently displayed to the 
Windows® Clipboard.

Autoscale Adjusts the vertical scale of each spectrum for optimal viewing. 
Double-clicking the display has the same effect.

Set Scale For setting minimum and maximum values for the axes. To set 
them automatically, select Autoscale.

Auto Arrange Labels Positions labels for easier reading.

Sample Legend Specifies whether to display sample IDs near the upper-left corner 
of the pane.

Sample Labels Specifies whether to display spectra with annotations (see 
“Annotate” below) and labels, such as those showing absorbance 
values for specific wavelengths.

Line Type Specifies whether to display scan spectra using solid lines or 
individual data points.
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Annotate Provides features for adding annotation to displayed data. (Added 
annotation is displayed only for the selected data.) See Working 
With Labels for information about manipulating added labels. 
Right-click an edge of an added ellipse, rectangle or image to access 
ways to manipulate or delete the object. The availability of features 
depends on the current application.

More:

Attach to Curve displays the X value of the pointer location as a 
label attached to a scan spectrum by a line.

Free Standing Text adds an editable label at the pointer location. 
Its position is not affected by zooming in and out.

Ellipse draws an ellipse. To move it, drag its top edge. To resize it, 
drag a side or bottom edge. Its position, size and shape are affected 
by zooming in and out.

Rectangle draws a rectangle. To move it, drag its top edge. To 
resize it, drag a side or bottom edge or a corner. Its position, size 
and shape are affected by zooming in and out.

Image displays a dialog box for locating and selecting an image to 
add to the display. To move the image, drag its top edge. To resize 
it, drag the bottom edge or a corner. Its position and size are 
affected by zooming in and out.

Floating Image works the same as Image (see above), except the 
image position and size are not affected by zooming.

Tool Value displays the measurement made by the Peak/valley 
measurement tool or peak area tool as a label attached to the 
spectrum by a line.

Feature Description
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3D Display (Scan Rate 
only)

Shows the selected scan data in a three-dimensional surface plot 
with these axes: absorbance, wavelength and time since the start of 
the experiment (vertical axis).

You can rotate the image, zoom in or out, or drag the image within 
the pane. 

More:

Rotate. To rotate the image, drag an edge or corner as though you 
were swinging that point around the center of the image. If you 
release the mouse button while dragging the point, the image 
continues to move in an "animated rotation." To stop this 
rotation, click the image.

Zoom. To enlarge or shrink the image, hold down the right mouse 
button and drag vertically across the image. You can also enlarge 
or shrink the image by clicking it and turning the mouse wheel (if 
present).

Pan. Hold down the Shift key and drag the image in any direction 
to move it within the pane.

When you click a point in the 3-D image, the spectral display pane 
changes to show the spectrum collected at the clicked time value. 
To display multiple spectra, hold down the Shift key while clicking 
locations in the 3-D image.

To adjust the display limits of the 3-D image, draw a box around 
an area of interest in the spectral pane and click inside the box.

To redisplay the full data range and adjust the vertical scale to fill 
the vertical axis, right-click the spectral display pane and choose 
Autoscale.

To remove the 3-D image from the window, right-click the spectral 
display pane and choose 3D Display to clear the check mark or 
choose View > 3D Display.

Feature Description
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Related Topics

Working With Labels

Right Pane

Measuring Samples

Measurement Results

The INSIGHT Window

More Display Options 
(Fixed only)

Specifies how to display fixed sample data and control limits:

Connect points (in Spectrum) draws connecting lines between 
sample points.

Show annotations displays X and Y values of sample points.

Show X grid draws light vertical lines through sample points, 
making it easier to see their X values.

Show Y grid draws light horizontal lines through sample points, 
making it easier to see their Y values.

If Use control limits is selected on the Instrument Tab for Fixed, 
Show limit lines displays the control limit lines for each measured 
wavelength.

Feature Description
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Working With Labels

Some operations place labels on the displayed data. Here is an example:

 To show or hide labels

Right-click the pane, point to Sample Labels and choose ON or OFF.

 To move a label

Drag it to the new position.

 To edit a label

Double-click it and use the dialog box that appears to change the text, its font or its color, or 
right-click the label and choose Edit, Color or Font.

 To rotate a label

Right-click it, point to Rotate and choose an orientation.

 To move a label in front of or behind annotation

Right-click it and choose Send to Front or Send to Back. Click here for information about 
adding annotation.

 To delete a label

Right-click it and choose Delete.

Related Topics

Using the Palette Tools and View Finder
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Finding Peaks in Scan Data

Finding Value Level Crossings in Scan Data

Data Display

Measuring Samples

If the current application provides a Measure button in the navigation pane, use it to access 
data acquisition features for the application. The name of the application appears on the 
button; for example:

Clicking the button displays action buttons for starting sample measurement or other data 
acquisition. The provided buttons and their availability depend on the current application 
and whether necessary operations have been performed. See Action Buttons.

Measurement results appear in the right pane.

See Setting Application Parameters for information about setting parameters that affect data 
acquisition, including those for controlling sampling accessories. For information about 
sampling accessories for the Evolution 200 Series instruments, refer to the user guide for the 
accessory or search for “Evolution 200 Series Accessories” in the INSIGHT Help system.

Related Topics

Performing Fixed Measurements

Performing Scan Measurements

Performing a Quantitative Analysis

Performing Rate Measurements

INSIGHT Bio Applications 

Measurement Results 

Below the data display in some applications is a table of sample measurement results. To 
display a spectrum, click its row in the table.

To view, copy or print information about a spectrum, including its history, right-click it in the 
table and choose Properties.

To print a report containing results information for a sample, select it in the table 
and click Print or choose File (menu) > Print Report. To preview the report, 
choose File > Print Preview. To specify the information to include, use the Print 
tab and Reportable Data tab in Reports.
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To measure a sample again, right-click its row in the sample measurements table and choose 
Remeasure (if available). (If Remeasure is not available, you can choose Options > 
Preferences and clear Prevent removal of data to enable it.) After the remeasurement, the 
previous information for the sample is either crossed out or removed from the table, 
depending on the status of Prevent removal of data on the Preferences tab in Options.

To delete a spectrum from the workbook, right-click it in the table and choose Remove (if 
available). To delete all the spectra from the workbook, right-click the table and choose 
Remove All (if available).

To append data to a workbook, click Measure.

Any Peak Pick or Value Level results appear in the results table to the right of the data display.
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Menus

The File menu, when available, includes:

Command Description

New Workbook Opens a new workbook and closes and saves the current workbook.

Merge Workbooks If available, allows you to copy data between workbooks created 
with the same application.

Instructions:

3. Open a workbook that was created using the desired application 
such as Fixed or Scan. See My Data.

4. Choose File > Merge Workbooks.

5. In Merge Workbooks, use the navigation (left) pane to locate 
the workbook that contains the data you want to copy.

A list of workbooks created using the selected application 
appears in the Workbooks pane. If the workbook contains 
sample data, the sample names are listed in the Samples pane. 
The data associated with the selected sample are displayed in the 
Data pane.

6. Select the sample measurements to import by clicking their 
names in the Samples pane. To select multiple samples, hold 
down Shift or Ctrl.

7. Click OK.

8. The sample names and other information are appended to the 
sample measurements table in the open workbook.

9. Choose Save Workbook or Save As Workbook to save the new 
data to the current or another workbook.

The merged workbook is unchanged.

Save Workbook If available, saves the current workbook using its current file name 
and location.

Save As Workbook If available, saves the current workbook with the specified file name 
and location.

Close Workbook and 
Go Home

Closes and saves the current workbook and returns to Home.

Close All Workbooks 
and Go Home

Closes all open workbooks (all applications) and returns to Home.
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The View menu includes:

The Math menu, when available, includes:

Import If available, imports an externally collected spectrum (.csv file or .tsv 
file) into the current Scan workbook.

Print Preview Shows the current report before printing, with the header and footer 
specified on the Report Master Page tab in Options.

Print Report Prints the current report to the default printer.

Use Current Settings 
as Default

Makes the current workbook settings and report configuration 
selections the default choices for a newly opened workbook for the 
application.

Save Workbook 
Settings as Template

If available, saves the current software settings as a template that can 
be used later by the specified user group.

More

To share a custom template, paste a copy of it into the desired folder, 
such as:

C:\Users\Public\Documents\Thermo\Insight\Custom 
Methods

C:\Documents and Settings\All 
Users\Documents\Thermo\Insight\Custom Methods

Note: “Shared Documents” may appear in a path instead of 
“Documents.

E-mail Current 
Workbook

Automatically attaches the current workbook to a new e-mail 
message.

Command Description

3D Display (Scan 
Rate only)

Shows scanned rate data in a three-dimensional surface plot.

Command Description

Smooth Reduces noise in wavelength scan data from Scan and Rate experiments. 
The smoothing algorithm uses the Savitzky-Golay method.

Derivative Converts scan data from Scan and Rate experiments to a derivative.

Convert Spectra Converts wavelength scan data to another Y-axis format.

Add Adds two scan spectra.

Normalize Adjusts the Y scale of scan data so that a selected data point has the 
desired Y value.

Command Description
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The Analyze menu, when available, may include:

The Help menu includes:

Related Topics

Navigation Pane

Right Pane

Instrument Status Monitors

Subtract Subtracts one scan spectrum from another.

Ratio Divides one scan spectrum by another.

Average Averages two or more scan spectra.

Factor Adds a constant to scan data, subtracts a constant, multiplies by a 
constant or divides by a constant.

Command Description

Peak Pick Finds peaks, valleys, or maximum and minimum values in a spectrum or 
region.

Value Level Finds the wavelengths where a spectrum crosses a specified ordinate value.

Modify Rate 
Curve

Perform rate calculations or modify existing rate calculations on the data in a 
plot.

Command Description

Help Displays the INSIGHT Help system, which can also be accessed from many 
software screens by pressing F1.

About Provides information about the software version and instrument type.

Command Description

Various instrument status monitors may appear above the data display. 
They show information such as the current wavelength or readouts from 
installed accessories. You can double-click some status monitors to set 
operation parameters such as channel assignment. For more information,  
refer to the user guide for the accessory or search for “Evolution 200 
Series Accessories” in the INSIGHT Help system.

To specify the items to monitor, click this icon.
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Related Topics

Evolution 200 Series Accessories

Accessories Tab for Fixed

Accessories Tab for Scan

Accessories Tab for Quant

Accessories Tab for Rate

Thermo Software IQ
Thermo Software IQ performs Installation Qualification (IQ) for the software. IQ verifies 
that the correct software files were installed and can also be used to verify that these files have 
not been changed, deleted, or overwritten since they were installed. (For more information, 
see the Thermo Software IQ user guide available through the Help menu of the software.)

 To start Thermo Software IQ

1. Click Start on the Windows taskbar.

2. Choose All Programs (or Programs) > Thermo > Thermo Software IQ.

Contact Information

For help with questions or problems with the software, use the information at the beginning 
of this document to contact us.

If the system is operating normally, a green check mark appears on the Instrument 
Status icon at the bottom of the INSIGHT window.

A yellow exclamation mark appears briefly on the icon when the system is busy 
performing an operation.

If a system problem occurs, a red X may appear on the icon. Click it to see 
information about the problem.
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Operation

Acquiring Data using Live Display

The Live Display button appears on the Home page in both views (Classic and 
Bio Applications). Use Live Display for quick measurements and simplified data collections in 
Fixed or Scan mode. The data can be displayed in absorbance or % transmittance units. The 
results can be stored in a temporary location and printed on demand.

These features are available in Live Display:

Contents

• Acquiring Data using Live Display

• Performing Fixed Measurements

• Performing Scan Measurements

• Performing a Quantitative Analysis

• Performing a Rate Measurement

• Adding Custom Calculations

• Using the Palette Tools and View Finder

• Setting Application Parameters

• Configuring a Report

• Exporting Data

• Managing Data

• Math and Analysis Operations

Feature Description

Selects the absorbance display mode.

Data currently displayed in % transmittance are changed to absorbance.

Selects the % transmittance display mode.

Data currently displayed in % transmittance are changed to absorbance.
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Selects the single wavelength data acquisition mode for the next 
measurement.

Use the right and left arrows in the left pane to select the wavelength. The 
measurement results appear in the right pane.

Selects the full scan data acquisition mode for the next measurement.

Use the top set of right and left arrows in the left pane to select the 
starting wavelength for the scan; use the bottom set of arrows to select the 
ending wavelength.

Records the currently displayed measurement in the computer’s internal 
memory. Data from subsequent measurements are appended. To save the 
data, choose Print. The memory location is cleared automatically when 
you exit Live Display (or choose Clear).

Pressing Store while in Fixed mode stores the measurement result along 
with the wavelength used and the display mode settings (Abs or %T).

Pressing Store while in Scan mode stores a snapshot of the spectrum. If 
the spectral cursor tool is selected, it also stores the current X and Y 
coordinates of the cross hair. 

Clears all information from Live Display’s associated memory location for 
storing analysis results. See Store.

Starts sample data acquisition with Live Display. Available only after a 
blank measurement.

Pressing Measure while in Fixed mode collects the data at the selected 
wavelength using a bandwidth of 1 nm and an integration time of 
0.5 sec. After you press Measure, the Measure button is disabled and the 
software automatically takes a measurement every 2 seconds until you 
press Stop or Scan or exit Live Display (or after 5 minutes of inactivity).

Pressing Measure while in Scan mode collects data at all wavelengths 
between the designated starting and ending wavelength using a 
bandwidth of 1 nm, an integration time of 0.05 sec, and a data interval of 
1.00 nm. The selection and spectral cursor tools are available in Scan 
mode.

Measures the blank for the selected application (Fixed or Scan).

Feature Description
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Performing Fixed Measurements

Fixed measurements are based on the selected workbook. Measurements can be appended to 
an opened workbook or saved in a new workbook.

Stops data acquisition.

Prints a copy of the information from Live Display’s associated temporary 
results file using the default printer. Available whenever stored 
measurements exist. See Store.

The selection tool is available in Scan mode only. Use it to zoom in the 
spectrum. To zoom in, draw a box and click inside it. (Double-click 
anywhere in the data display to zoom out.)

The spectral cursor tool is available in Scan mode only. Use it to view 
the X and Y values of a point in a spectrum.

To view the X and Y values of a point, select the spectral cursor tool and 
click the data display. Cross hairs appear. The X and Y coordinates of 
their intersection with the spectrum appear below the data pane. To move 
the cross hairs, drag across the pane or use the left and right arrow keys on 
the keyboard.

Feature Description

Click Fixed in the right pane in Home to set up and 
perform a measurement at one or more specified 
wavelengths using the currently selected workbook or 
template. The tasks buttons below become available.

To set data acquisition parameters for the current Fixed 
workbook, click Settings.

To access features for performing the measurement, 
click Measure Fixed.

To select a different workbook or create a new one for 
the Fixed application, click My Data or choose 
File < New Workbook.
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Related Topics

Fixed

Performing a Fixed Measurement

Performing a Fixed Measurement 

 To perform a fixed measurement

1. Select or create a workbook.

• To append new data to an existing workbook, from the Home screen click My Data, 
click the Workbooks tab and double-click the workbook file.

• To create a new workbook using the current template, from the Home screen click 
Fixed and then choose File (menu) > New Workbook.

• To create a new workbook using a different template, from the Home screen click 
My Data, click the Templates tab and double-click a Fixed template file.

1. Click Settings.

2. Click the tabs in order to view or change the Fixed settings.

3. Click Measure Fixed.

4. Load the sample to use to measure the zero or blank.

5. Click Zero.

Note  Change Fixed workbook settings as desired before making sample measurements. 
All Fixed measurements are saved in a workbook that includes the data acquisition 
settings. See Setting Application Parameters for information about unlocking settings.

Note  If you opened an existing workbook in step 1 above, the settings will be 
unavailable unless you unlock them. See Setting Application Parameters for 
information about unlocking settings.
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6. Click Measure.

7. Follow the instructions that appear.

8. When samples information appears, modify it if desired.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

9. If only one sample will be measured, install it.

10. Click Continue.

11. Follow any instructions that appear, such as to install a specified sample.

The Data Display shows the acquired data (a fixed data point) for the sample selected in 
the table. (Right-click the data to access commands for customizing the display, including 
adding annotation.)

The table contains the columns of information specified on the Reportable Data tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their average values.

To measure a sample again, right-click its row in the sample measurements table and 
choose Remeasure (if available). (If Remeasure is not available, you can choose Options 
> Preferences and clear Prevent removal of data to enable it.) After the remeasurement, 
the previous information for the sample is either crossed out or removed from the table, 
depending on the status of Prevent removal of data on the Preferences tab in Options.

Related Topics

Fixed

Performing Fixed Measurements

Data Display
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Performing Scan Measurements

Scan measurements can be appended to an opened workbook or saved in a new workbook.

Related Topics

Scan

Performing a Scan Measurement

Performing a Scan Measurement

 To perform a scan measurement

1. From the Home screen, click Scan > Settings.

2. Click the tabs in order to view or change the Scan settings.

3. Click Measure Scan.

4. Load the sample to use to measure the baseline.

Click Scan in the right pane in Home to set up and 
perform a measurement over a range of wavelengths. 
The tasks buttons below become available.

To set data acquisition parameters for the next Scan 
measurement, click Settings.

To access features for performing the measurement, 
click Measure Scan.

To select a different workbook or create a new one for 
the Scan application, click My Data or choose 
File (menu) < New Workbook.

Note  If you need to select a new workbook or template, click My Data, double-click 
a workbook or template, and then click Settings.
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5. Click Baseline.

6. Click Measure.

7. Follow the instructions that appear.

8. When samples information appears, modify it if desired.

More:

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

9. If only one sample will be measured, install it.

10. Click Continue.

11. Follow any instructions that appear, such as to install a specified sample.

The Data Display shows the acquired data (a scan spectrum) for the sample selected in 
the table. (Right-click the data to access commands for customizing the display, including 
adding annotation.)

The table contains the columns of information specified on the Reportable Data tab in 
Reports. Examples include sample identification, user name, date and time, and 
integration time.

To measure a sample again, right-click its row in the sample measurements table and 
choose Remeasure (if available). (If Remeasure is not available, you can choose Options 
> Preferences and clear Prevent removal of data to enable it.) After the remeasurement, 
the previous information for the sample is either crossed out or removed from the table, 
depending on the status of Prevent removal of data on the Preferences tab in Options.

Related Topics

Scan

Performing Scan Measurements

Data Display
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Performing a Quantitative Analysis

Related Topics

Settings for Quant Applications

Performing Quantitative Measurements

Formulas and Units Tab

Performing Quantitative Measurements

Related Topics

Performing a Quantitative Analysis

Data Display

Quantifying Samples Without Using Standards

 To quantify samples without using standards

1. Click Measure Quant in Quant.

Click Quant in the right pane in Home to set up and 
perform quantitative analyses of sample data. The tasks 
buttons below become available.

To set Quant parameters, click Settings.

To access features for quantifying sample data, click 
Measure Quant.

To specify the predefined formulas, units and advanced 
equations to be available, click Options and use the 
Formulas & Units tab.

Contents

• Quantifying Samples Without Using Standards

• Quantifying Samples Using Standards

Note  Select Manually entered factor on the Type tab before using this procedure.
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2. Load the sample to use to measure the blank.

3. Click Blank.

4. Click Measure.

5. Follow the instructions that appear.

6. When samples information appears, modify it if desired.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

7. If only one sample will be measured, install it.

8. Click Continue.

9. Follow any instructions that appear, such as to install a specified sample.

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use control limits was selected on the Samples tab, horizontal limit lines 
show whether the concentrations are within the specified limits:

To copy this plot, right-click it and choose Copy to Clipboard.

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.
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The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation.) See Data Display for more information.

The table contains the columns of information specified on the Reportable Data tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

To measure a sample again, right-click its row in the sample measurements table and 
choose Remeasure (if available). (If Remeasure is not available, you can choose Options 
> Preferences and clear Prevent removal of data to enable it.) After the remeasurement, 
the previous information for the sample is either crossed out or removed from the table, 
depending on the status of Prevent removal of data on the Preferences tab in Options.

Related Topics

Quantifying Samples Using Standards

Performing a Quantitative Analysis

Data Display

Settings for Quant Applications

Formulas and Units Tab

Quantifying Samples Using Standards

 To quantify samples using standards

1. Click Measure Quant in Quant.

2. If standards need to be acquired, click Measure. If standards have already been acquired, 
skip to step 7 to acquire sample data.

3. Follow the instructions that appear. The instructions that appear are dependant on the 
current settings for the features on the Standards tab in Settings.

Note  Select Measure single standard, Standard curve, Standard curve with two 
wavelengths or Advanced standard curve on the Type tab before using this procedure.

Note  To start an analysis immediately after viewing or changing the template settings, 
start with the next step.
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4. When standards information appears, modify it if desired.

More:

If Standard averaging on the Standards tab in Settings was set to Duplicate, “D” at the 
end of a standard name in the Confirm Standards List box indicates the second 
measurement to be made of the standard. If Sample averaging was set to Triplicate, “D” 
and “T” at the end of standard names indicate the second and third measurements to be 
made, respectively.

To enter previously saved standards information, use Import Standards.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each standard in the table.

To remove a standard from the list, select it, right-click the table and choose Clear 
Standard. To remove all the standards, choose Clear Table.

To save standards information for later use, use Export Standards.

5. Click Continue.

6. Follow the instructions that appear, installing the specified standards.

The Standard Curve(s) tab displays the resulting standard curve (or curves). Specify the 
standards to use for the curve (or curves) by selecting Yes or No in the Use column in the 
table. These selections can always be changed. After each change, the standard curve is 
updated automatically.

More:

The table contains the columns of information specified on the Reportable Data tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

To permanently remove an acquired standard from the analysis, right-click it and choose 
Remove. Its information is crossed out but not removed from the table.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
standard selected in the table. To access commands for customizing the display, including 
adding annotation, right-click the data. See Data Display for more information.

If a standard curve is not calibrated, try...

• Selecting a different curve fit type.

• Remeasuring a standard using the correct standard material (select 
the listed standard, right-click the table and choose Remeasure).

• Changing the setting of Minimum r2 on the Standards tab and 
acquire the standards again in a new workbook.
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7. Click Measure.

8. Follow the instructions that appear. The instructions that appear are dependant on the 
current settings for the features on the Samples tab in Settings.

9. When samples information appears, modify it if desired.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end 
of a sample name in the Confirm Sample List box indicates the second measurement to 
be made of the sample. If Sample averaging was set to Triplicate, “D” and “T” at the end 
of sample names indicate the second and third measurements to be made, respectively.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

10. If only one sample will be measured, install it.

11. Click Continue.

12. Follow any instructions that appear, such as to install a specified sample.

The sample measurements table contains the columns of information specified on the 
Reportable Data tab in Reports. If Sample averaging was set to Duplicate, “D” at the end 
of a sample name indicates the second measurement. If Sample averaging was set to 
Triplicate, “D” and “T” indicate the second and third measurements, respectively.

The Standard Curve(s) tab shows graphically the relationship between the standard curve, 
measured spectral intensity and calculated concentration for the selected sample: A 
horizontal line connects the sample spectral intensity value on the Y-axis to the standard 

Note  After a calibration curve is used to measure a sample, the curve can no longer be 
edited. However, you can open a new workbook based on the existing calibration data 
and then edit the curve before you begin acquiring new sample data.
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curve. A vertical line connects that point to the sample concentration value on the X-axis. 
The information at the top shows the measured wavelength, the equation for the standard 
curve and the calculated r2 value, which indicates how well the standard curve fits the 
standard data points (1.0 is a perfect fit).

The Run Chart tab plots the concentration of the measured component versus sample 
number. (If there are two analysis wavelengths, the concentration value is the average of 
the values for those wavelengths.) If Use control limits was selected on the Samples tab, 
horizontal limit lines show whether the concentrations are within the specified limits:

To measure a sample again, right-click its row in the sample measurements table and 
choose Remeasure (if available). (If Remeasure is not available, you can choose Options 
> Preferences and clear Prevent removal of data to enable it.) After the remeasurement, 
the previous information for the sample is either crossed out or removed from the table, 
depending on the status of Prevent removal of data on the Preferences tab in Options.

To copy the data on the Standard Curve(s) tab or Run Chart tab, right-click the plot and 
choose Copy to Clipboard.

Note  If there are two analysis wavelengths, the lines appear for each of the two 
standard curves.
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Related Topics

Quantifying Samples Without Using Standards

Performing a Quantitative Analysis

Data Display

Settings for Quant Applications

Formulas and Units Tab

Performing a Rate Measurement

Performing Rate Measurements 

Related Topics

Performing a Fixed Rate Measurement

Performing a Scanning Rate Measurement

Modifying a Rate Curve

Data Display

Performing a Fixed Rate Measurement 

Rate measurements can be made at one wavelength or at up to 40 wavelengths in the same 
experiment. This includes multicell measurements, which allows running a fixed-wavelength 
measurement on several samples simultaneously using a sample changer. 

Click Rate in the right pane in Home to set up and 
perform a kinetics measurement. The tasks buttons below 
become available.

To set Rate parameters, click Settings.

To access features for performing the measurement, 
click Measure Rate.

Contents

• Performing a Fixed Rate Measurement

• Performing a Scanning Rate Measurement
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Measurements are taken at specified intervals of time. Temperature-based measurements also 
record temperature and control the temperature setting and ramp rate for the duration of the 
experiment. Multiple stages can be programmed for time and temperature-based 
measurements.

The Time Status icon automatically appears above the data display during rate measurements.

 To perform a fixed rate measurement

1. Make sure Single wavelength or Multiple wavelength is selected on the Type tab in 
Settings in Rate.

2. Click Measure Rate.

3. Load the sample to use to measure the zero or blank.

4. Click Zero.

5. Click Measure.

If necessary, the Zero action button can be used to remeasure the zero sample.

6. When samples information appears, modify it if desired.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

Enter values in any special columns that were specified on the Samples tab in Settings. 
These values may appear in the rate data report.

7. Click Continue.
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8. Follow the instructions that appear.

Each row in the sample measurements table on the Data tab shows the measurement 
results for one sample measured at a specified wavelength. Each plot on the tab shows a 
sample’s spectral intensity measured at a particular wavelength over time.

To extend the collection time for the current sample measurement (without interrupting 
the data collection), click Extend Time and enter the amount of time to extend the 
measurement. If you are collecting data in multiple stages, only the current stage is 
affected.

Scroll bars are provided if plots are out of view.

Right-click the Data tab to access features for changing the scale or adding annotation. 
See Data Display for more information.

The sample measurements table contains the columns of information specified in the 
Reported Columns pane of the Reportable Data tab in Reports.

9. To perform rate calculations or modify existing rate calculations on the data in a plot, 
double-click it or select Analyze (menu) < Modify Rate Curve.

Note  The features to set up rate calculations are available for time-based single and 
multiple wavelength rate measurements only. To calculate rate curves for 
temperature-based data (temperature and time are recorded), display the data with 
time on the X-axis and then double-click the data display or select Analyze (menu) 
< Modifying a Rate Curve.
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Modifying a Rate Curve 

Time-based single and multiple wavelength rate measurements can include a rate curve. To 
specify rate calculations, set up a fixed rate experiment and then select the Rate Calculations 
tab in Settings.

If Calculate rate constants automatically at end of data acquisition is selected on the Rate 
Calculations tab, after data collection completes, the rate calculations will appear in the 
sample measurements table along with the other sample data. To perform rate calculations or 
modify existing rate calculations on the data in a plot, double-click it or select Analyze (menu) 
> Modify Rate Curve. A window displays the plot and a table containing the default rate 
calculation values based on the Rate Calculations tab.

These operations are available from the Modify Rate Curve window.

• If desired, add or change sets of rate calculation values for the displayed data. Each set 
represents a curve that describes the rate behavior over the specified time period.

To delete a row from the table, right-click it and choose Delete Selected Row. To delete 
all the information from the table, right-click it and choose Clear Table.

• If desired, use the vertical markers on the rate curve to adjust the data range used for rate 
calculations.

• Click Update to generate kinetic rate models, each of which appears as a line across the 
data.

Note  To calculate rate curves for temperature-based data (temperature and time are 
recorded), display the data with time on the X-axis and then double-click the data 
display or select Analyze (menu) < Modifying a Rate Curve.



 3 INSIGHT Software
Operation

Thermo Scientific Evolution 200 Series Spectrophotometer User Guide 83

Specify how to apply the lines and then click Accept.

The window closes, the lines appear across the specified plots, and the sample 
measurements table is updated with information about the model lines.

Related Topics

Settings for Rate Applications

Data Display

Performing a Scanning Rate Measurement

Performing a Scanning Rate Measurement

Rate measurements can be made on several samples simultaneously using a sample changer or 
run in a sequential, manual mode.

 To perform a scanning Rate measurement

1. Make sure Scan data acquisition is selected on the Type tab in Settings in Rate.

2. Click Measure Rate.

3. Load the sample to use to measure the zero.

4. Click Zero.

5. Click Measure.

If necessary, the Zero action button can be used to remeasure the zero sample.

6. When samples information appears, modify it if desired.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

This option... Applies the lines to...

Selected plot only The selected data only.

All plots with this wavelength only All plots for the current wavelength.

All plots All plots.
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Enter values in any special columns that were specified on the Samples tab in Settings. 
These values may appear in the rate data report.

7. Click Continue.

8. Follow the instructions that appear.

Each grid on the Data tab displays all the spectra acquired for a particular sample.

A scroll bar is provided if spectra are out of view.

Right-click the Data tab to access features for changing the scale or adding annotation. 
See Data Display for more information.

A sample measurements table appears below the spectra.

Related Topics

Settings for Rate Applications

Data Display

Performing a Fixed Rate Measurement



 3 INSIGHT Software
Operation

Thermo Scientific Evolution 200 Series Spectrophotometer User Guide 85

Adding Custom Calculations

Calculations can be applied to the results from individual samples or standards, results from a 
group of samples, or between two or more sample results. Depending on your needs, use this 
table as a guide to the appropriate feature for adding custom calculations.

This feature... Located here... Allows you to...

Use sample 
correction factor

Samples tab Specify a multiplication factor for each sample 
result. Can be used to correct for sample properties 
and preparation steps such as a sample dilution that 
affects the measured result.

The correction factors and corrected results are 
displayed in the sample measurements table. If a 
report is generated that includes the samples table, 
the report will also include the correction factors and 
corrected results.

Use correction 
factor

Standards tab Specify a multiplication factor for each standard. 
The corrected concentration values are used to create 
the calibration curve. Can be used to correct for 
standard properties (percent purity, water content, 
etc.) or preparation steps that affect the measured 
result such as a dilution. Available for Standard 
Curve, Standard Curve With Two Wavelengths, and 
Advanced Standard Curve Quant types only.

The correction factors and corrected concentration 
values are displayed in the standards table. If a report 
is generated that includes information about the 
standards, the report will also include the correction 
factors and corrected concentrations.
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Related Topics

Use sample correction factor

Use (standards) correction factor

Calculate Additional Results

Advanced Calculations

Operations and Functions

The tables below describe the operations and functions usable in equations specified on the 
Measurement tab for Fixed, Scan and Quant. Arithmetic operations (including functions) are 
performed first, followed by comparison operations, and finally logical operations.

Calculate 
additional results

Measurement 
tab

Apply pre- or user-defined formulas to all sample 
measurements taken with the workbook or 
template. Available for Fixed, Scan and Quant 
applications only. For descriptions of the operations 
and functions usable in user-defined equations, see 
Operations and Functions.

After the measurement, the calculated values and 
their labels are displayed in the sample 
measurements table below the data display. If a 
report is generated that includes the samples table, 
the report will also include the calculated values and 
labels.

Advanced 
Calculations

Navigation 
pane during a 
measurement

Apply predefined formulas to any measurement 
result or results for any sample or to other 
calculation results. Predefined formulas include 
basic math and statistics. Available for all 
applications except Rate.

The calculated values and any labels that are entered 
are displayed in the calculations table which appears 
below the sample measurements table in the right 
pane. If a report is generated that includes the 
calculations table, the report will also include the 
calculated values and labels.

This feature... Located here... Allows you to...

Note  The operators, arguments and functions are not case-sensitive.
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Arithmetic Operations

Comparison Operations

Logical Operations

The following equation functions produce a value based on one or more arguments you 
supply.

Operator Description Example Returned by Example Operation

+ Addition 2 + 6 + 4 12

- Subtraction 25 - 4 21

* Multiplication 25 * 4 100

/ Division 25 / 4 6.25

- Negation -4 + 25 21

mod Modulo division (returns 
remainder)

16 mod 5 1

& Text addition “abc” & “def” “abcdef”

Operator Description Example Result

>= Greater than or equal (3 + 2) >= 4 true

<= Less than or equal (3 + 2) <= 5 true

=, == Equals (2 + 2) = 4 true

!=, <> Does not equal (2 + 2) != 5 true

< Less than 5 < 4 false

> Greater than 5 > 4 true

true The value “true” (5 > 4) = true true

false The value “false” (5 > 4) = false false

Operator Description Example Result

AND If both sides of the AND are true, result is true 5 > 4 AND 2 = 3 false

OR If either side of the OR is true, result is true 5 > 4 OR 2 = 3 true
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Example Function Arguments

Arithmetic Functions

Logarithmic Functions

Argument Description

<number>, <angle>, <length>, 
<value>, <power>, <start>, <len>

An expression that yields a number.

<list> Any expression that yields a list of numbers.

<text>, <sub> An expression that yields a text.

Function Returned or Performed by Function

abs(<number>) Absolute value of a number.

ceiling(<number>) Smallest integer greater than or equal to <number>. 
Example:

Ceiling(2.2) is 3.0

floor(<number>) Largest integer less than or equal to <number>.
Example:

Floor(2.7) is 2.0

random() Random fractional number between 0 and 1.

round(<number>) Rounds a double value to the nearest integer value.

sqrt(<number>) Square root of a number.

truncate(<number>) Truncated number. Everything to the right of the decimal point 
is removed, leaving only the integer portion of the number. The 
returned value is not rounded.

Function Returned by Function

exp(<number>) Result of the constant e (2.7182818) raised to the power of the 
specified number (e^<number>).

ln(<number>) Natural logarithm (base e logarithm) of a number.

log10(<number>)

log(<number>)

Base 10 logarithm of a specified number.

pow(<value>, <power>) Value raised to the power. Example:

pow(2,3) is 8.0
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Trigonometric Functions

Statistical Functions

Note  For functions acos and asin, <number> is an expression that yields a number in the 
range -1 to 1.

Note  The formula for converting degrees to radians is radians = degrees * (pi/180).

Function Returned by Function

acos(<number>) Arccosine of a number in radians.

asin(<number>) Arcsine of a number in radians.

atan(<number>) Arctangent of a number in radians.

atan2(<number1>,<number2>) Arctangent of <number1> divided by <number2> in 
radians. The signs of both arguments are used to 
determine the quadrant of the returned value.

cos(<angle>) Cosine of an angle measured in radians.

cosh(<angle>) Hyperbolic cosine of an angle measured in radians.

pi() Ratio of the circumference of a circle to its diameter.

sin(<angle>) Sine of an angle measured in radians.

sinh(<angle>) Hyperbolic sine of an angle measured in radians.

tan(<angle>) Tangent of an angle measured in radians.

tanh(<angle>) Hyperbolic tangent of an angle measured in radians.

Function Returned by Function

average(<list>) Average of a list of numbers (sum divided by the number of items).

max(<list>) Highest value from two or more numbers.

min(<list>) Lowest value from two or more numbers.

sum(<list>) Sum of a list of numbers.

Std. Dev. Square root of variance, which is determined by taking the average of the 
squared differences of the values from their average value.

% RSD Absolute value of the coefficient of variation expressed as a percentage 
(100*((standard deviation of array X)/(average of array X))).
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Text Functions

Measurement Functions

Function Returned by Function

FindTextIndex(<search>, 
<text>)

Index of the first occurrence of the <search> text in the 
specified text. If the text is not found, a -1 is returned.

Lowercase(<text>) Copy of the text converted to lower case using the casing rules 
of the current culture.

PassFail(<expression>) “Pass” in the language of the current culture if the expression 
evaluates to true; otherwise, “Fail”.

Quote Text containing the quote (“) character.

Return Text containing a carriage return.

TextLength(<text>) Number of characters, including spaces, in the specified text. 
A CRLF is counted as two characters.

ExtractText(<text>, <start>, 
<len>)

Portion of the specified text. The extracted text starts at the 
specified <start> index and has a specified length.

Tab Text containing the tab character.

ToNumber(<text>) Numeric representation of the text.

ToText(<number>) Text representation of the number.

Function Returned or Performed by Function

Y(location) Y-axis value at the given location.

Y(location, baseline) Y-axis value at the given location with a one-point baseline.

Y(location, baseline1, 
baseline2)

Y-axis value at the given location with a two-point baseline.

Area(start, end) Area between two spectral limits.

Area(start, end, baseline) Area between two spectral limits using a one-point baseline.

Area(start, end, 
baseline1, baseline2)

Area between two spectral limits using a two-point baseline.

PMin(start, end) Minimum Y-axis value between two spectral limits.

PMax(start, end) Maximum Y-axis value between two spectral limits.

PMax(start, end, 
baseline)

Corrects the spectrum with a one-point baseline and then report 
the maximum Y-axis value between two spectral limits.

PMax(start, end, 
baseline1, baseline2)

Corrects the spectrum with a two-point baseline and then report 
the maximum Y-axis value between two spectral limits.

PLoc(start, end) Location (X-axis value) at which the maximum Y-axis value 
occurs between two spectral limits.
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Related Topics

Measurement Tab for Fixed

Measurement Tab for Scan

Measurement Tab for Quant

Formulas and Units Tab

PLoc(start, end, 
baseline)

Corrects the spectrum with a one-point baseline and then report 
the location (X-axis value) at which the maximum Y-axis value 
occurs between two spectral limits.

PLoc(start, end, 
baseline1, baseline2)

Corrects the spectrum with a two-point baseline and then report 
the location (X-axis value) at which the maximum Y-axis value 
occurs between two spectral limits.

PWidth(start, end, 
percent)

Determines the peak width between two spectral limits. Report 
the width at which the peak reaches a specified percentage of the 
peak maximum.

Pavg(start, end) Determines the average value of the spectrum between two 
spectral limits.

Pcut(start, end, percent) Determines the location (X-axis value) of the cut-on or cut-off 
point in the specified spectral region. For example, for a region 
with increasing Y value, a cut-on point occurs where the increase 
reaches the specified percentage of total increase across the 
region. Here is an example showing a cut-on point with 
“percent” set to 60:

Function Returned or Performed by Function
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Using the Palette Tools and View Finder

Using the Selection Tool

Use the selection tool (if present) to zoom in or move the spectrum.

To zoom in, draw a box and click inside it. To move the spectrum, drag it up or down.

Related Topics

Using the Spectral Cursor Tool

Using the Peak/Valley Measurement Tool

Using the Peak Area Tool

Using the Region-Threshold Tool

Using the View Finder

Using the Spectral Cursor Tool

Use the spectral cursor tool (if present) to view the X and Y values of a point in a spectrum.

 To view the X and Y values of a point

1. Select the spectral cursor tool.

2. Click the data display.

Contents

• Using the Selection Tool

• Using the Spectral Cursor Tool

• Using the Peak/Valley Measurement Tool

• Using the Peak Area Tool

• Using the Region-Threshold Tool

• Using the View Finder

Note  To display the palette, click .

Note  To display the palette, click .
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Cross hairs appear. The X and Y coordinates of their intersection with the spectrum 
appear below the palette.

To move the cross hairs, drag across the pane or use the left and right arrow keys on the 
keyboard.

To remove the cross hairs from the display, select another tool such as the selection tool.

Related Topics

Using the Selection Tool

Using the Peak/Valley Measurement Tool

Using the Peak Area Tool

Using the Region-Threshold Tool

Using the View Finder

Using the Peak/Valley Measurement Tool

Use the peak/valley measurement tool (if present) to measure the height of a peak or depth of 
a valley from a specified baseline.

 To measure a peak or valley

1. Select the peak/valley measurement tool.

2. Click the data display.

A vertical line appears. The X and Y coordinates of its intersection with the spectrum 
appear below the palette.

3. Drag the line by its diamond-shaped handle to the peak or valley to measure.

4. Drag the triangular baseline handles to the desired baseline endpoints.

The height or depth of the peak or valley appears below the palette.

To annotate the spectrum with the measured value, right-click the spectrum, point to 
Annotate and choose Tool Value. See Working With Labels.

To remove the vertical line and baseline from the display, select another tool such as the 
selection tool.

Note  To display the palette, click .
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Related Topics

Using the Selection Tool

Using the Spectral Cursor Tool

Using the Peak Area Tool

Using the Region-Threshold Tool

Using the View Finder

Using the Peak Area Tool

Use the peak area tool (if present) to measure the corrected area of a peak. This area is 
bordered by the spectrum, two vertical lines and a baseline.

 To measure a peak

1. Select the peak area tool.

2. Click the data display.

Two vertical lines appear (see the illustration below). Their X values define the limits of 
the region to measure and appear in the Region readout.

3. Drag the lines by their triangular handles to the desired locations.

4. Drag the triangular baseline handles (see the illustration below) to the desired baseline 
endpoints.

Note  To display the palette, click .



 3 INSIGHT Software
Operation

Thermo Scientific Evolution 200 Series Spectrophotometer User Guide 95

The X values of the endpoints appear in the Baseline readout. The defined area is shaded, 
and its measurement appears in the Corrected area readout. Here is an example showing 
the region limits and baseline endpoints adjusted to measure the corrected area of a peak:

To annotate the spectrum with the measured area, right-click the spectrum, point to 
Annotate and choose Tool Value. See Working With Labels.

To remove the vertical lines and baseline from the display, select another tool such as the 
selection tool.

Related Topics

Using the Selection Tool

Using the Spectral Cursor Tool

Using the Peak/Valley Measurement Tool

Using the Region-Threshold Tool

Using the View Finder

Using the Region-Threshold Tool

For data analysis operations such as locating peaks, use the region-threshold tool (if present) 
to limit the wavelength region.

Drag the vertical lines in the data display or drag horizontally between them to move both at 
once.

Note  To display the palette, click .
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Related Topics

Using the Selection Tool

Using the Spectral Cursor Tool

Using the Peak/Valley Measurement Tool

Using the Peak Area Tool

Using the View Finder

Using the View Finder

For data analysis operations such as locating peaks, use the view finder (if present) to adjust 
the data display.

The currently displayed region is indicated by the region markers, the bold vertical lines.

 To expand horizontally

 To expand vertically

 To expand or contract vertically while keeping the top or bottom of spectra in place

Note  To display the view finder, click .

Click the top half of the Horizontal Expand/Contract button. To contract 
horizontally, click the bottom half.

Click the left half of the Vertical Expand/Contract button. To contract vertically, 
click the right half.

To expand vertically while keeping the bottom of the spectra in place, click the 
symbol at the top of this button.

To expand vertically while keeping the top of the spectra in place, click the symbol 
at the right.

To contract vertically while keeping the bottom of the spectra in place, click the 
symbol at the bottom.

To contract vertically while keeping the top of the spectra in place, click the symbol 
at the left.
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 To display a different region of the same size

There are three ways to do this: 

• To move the spectrum to the right, click the top half of the Roll button.

To roll to the left, click the bottom half.

• Drag between the region markers.

• Click to the left of the left region marker or to the right of the right region marker.

 To change the display limits by moving the region markers

Drag a region marker left or right.

 To display the entire spectrum 

Double-click between the region markers.

Related Topics

Using the Selection Tool

Using the Spectral Cursor Tool

Using the Peak/Valley Measurement Tool

Using the Peak Area Tool

Using the Region-Threshold Tool

Setting Application Parameters

The tabs in the right pane (and their features) depend on the application.

If  appears on a tab, point to it and read the information to correct the problem.

To set parameters that determine how data will be 
acquired or quantified with the current application, click 
Settings.
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Action buttons for the current application may include:

Settings for Fixed Applications

The follow tabs of settings are available:
Measurement Tab for Fixed
Instrument Tab for Fixed
Accessories Tab for Fixed
Samples Tab for Fixed

Change Fixed workbook settings as desired before making sample measurements. All Fixed 
measurements are saved in a workbook that includes the data acquisition settings.

Measurement Tab for Fixed

These settings are available:

Button Description

Displays data acquisition features for the application and starts an acquisition.

Resets the parameters on all the tabs to their default values. For Quant and Rate, 
also steps through each tab in sequence.

Makes the parameters on all the tabs available, closes the current workbook, and 
creates a new workbook.

To set data acquisition parameters for a Fixed workbook, 
click Settings.

Click Settings in Fixed to display the Measurement tab 
in the right pane.

Feature Description

Name (if present) User group name followed by the name of the template of settings 
(entered when the template was saved using Save Workbook Settings 
as Template in the File menu).
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Related Topics

Setting Application Parameters

Description 
(optional)

Optional description of the template.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. (See “Operations and 
Functions” for definitions.) All functions are not case-sensitive. 
Spaces are not allowed between a function name and “(”. After adding 
formulas, edit their information in the formula table as desired. To 
delete a table row, right-click it and choose Delete Row. Some 
information in the table cannot be modified or deleted.

Instructions:

 To add one or more predefined formulas

1. Click Select.

2. Select the desired formulas.

Hold down the Ctrl or Shift keys on the keyboard while making 
multiple selections. The available formulas depend on the 
Formulas & Units tab settings in Options.

3. Click OK.

 To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available formulas depend on the Formulas & Units tab 
settings.

Feature Description
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Settings for Fixed Applications

Operations and Functions

Formulas and Units Tab

Instrument Tab for Fixed

These settings are available:

Click Settings in Fixed to display the Instrument tab in 
the right pane.

Feature Description

Data mode Y-axis format for acquired data. Available options include 
Absorbance and % Transmittance.

Integration time How long the system acquires and averages data at each measured 
wavelength. Increasing the integration time improves the 
signal-to-noise ratio.

Bandwidth Available options include:

• Bandwidth. A larger spectral bandwidth increases the amount 
of energy that passes through the sample. Increasing the 
bandwidth can improve the signal-to-noise ratio; however, a 
larger spectral bandwidth decreases the ability to resolve closely 
spaced spectral features.

• Materials, Fiber and Micro. These AFBG (Application 
Focused Beam Geometry) options match the optical 
configuration to the application for optimized use of 
associated accessories.

• Blocked. Blocks the beam completely. 
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Result mode Determines how results are calculated and displayed:

Normal displays the results in the units specified in the Data mode 
setting (see above).

Peak Height calculates the peak height with respect to a sloping 
baseline defined by two wavelengths adjacent to the center peak:

The lowest of the three measured wavelengths defines the start of 
the sloping baseline, the middle wavelength defines the peak 
location, and the highest wavelength defines the end point of the 
sloping baseline.

Wavelength 1 + Wavelength 2 adds the Y values at the two 
measured wavelengths.

Wavelength 1 - Wavelength 2 subtracts the Y value at the second 
measured wavelength from the Y value at the first.

Wavelength 1 * Wavelength 2 multiplies the Y value at the second 
measured wavelength times the Y value at the first.

Wavelength 1 / Wavelength 2 divides the Y value at the first 
measured wavelength by the Y value at the second.

Reference wavelength 
correction

If available and selected, subtracts the background intensity at the 
specified reference wavelength from the sample intensity at all 
measured wavelengths. The reference wavelength value appears in 
red in the Wavelength Summary table.

Feature Description
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Related Topics

Setting Application Parameters

Settings for Fixed Applications

Accessories Tab for Fixed

The status of accessories can be monitored during measurements.

Related Topics

Setting Application Parameters

Settings for Fixed Applications

Instrument Status Monitors

Samples Tab for Fixed

Use control limits If available and selected, specifies control limits for each 
wavelength in the table. Enter the desired upper and lower limits 
for each wavelength in the table, using the appropriate unit for the 
selected data mode.

When the measurement is completed, the limits are listed in the 
table to the right of the display. Limit lines can also be added to the 
data display by right-click in the display area, choosing More 
Display Options, and selecting Show Limit Lines. The lines 
indicate whether each measured data point is within specifications.

Wavelength Summary Wavelengths at which measurements will be made, plus the 
corresponding control limits if specified (see above). The number 
of required wavelengths depends on the setting of Result mode (see 
above). To enter or change the value in a table cell, click it and 
type. To order the list by wavelength, lower control limit or upper 
control limit, click the appropriate column heading.

Click Settings in Fixed to display the Accessories tab in 
the right pane. The available parameters depend on the 
installed accessories. For more information,  refer to the 
user guide for the accessory or search for “Evolution 200 
Series Accessories” in the INSIGHT Help system.

Click Settings in Fixed to display the Samples tab in the 
right pane.

Feature Description
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These settings are available:

Related Topics

Setting Application Parameters

Settings for Fixed Applications

Feature Description

Number of samples Number of samples for the experiment.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample 
spectra using the base name “dye” would be dye1, dye2 and 
dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select 
Replicate and set Number of replicates to the total number of 
measurements. To average values from two or three different 
samples, select Duplicate or Triplicate, respectively.

Use sample correction 
factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the 
measured result. Enter the desired factor for each sample in the 
table.

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table on the 
Samples tab.

Save Samples Saves the contents of the samples table in a .tsv (tab separated 
values) file or .csv (comma separated values) file in a specified 
location.

Samples table Lists samples by their names and descriptions, up to a maximum 
of 1000. To change a sample name, click its cell and edit the text. 
To enter or change text in a table cell, click it and type. To order 
the list by sample name or description, click the appropriate 
column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.
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Settings for Scan Applications

The follow tabs of settings are available:
Measurement Tab for Scan
Instrument Tab for Scan
Accessories Tab for Scan
Samples Tab for Scan
Peak Pick Tab for Scan

Measurement Tab for Scan

These settings are available:

To set data acquisition parameters for a Scan workbook, 
click Settings.

Click Settings in Scan to display the Measurement tab 
in the right pane.

Feature Description

Name (if present) User group name followed by the name of the template of settings 
(entered when the template was saved using Save Workbook Settings 
as Template in the File menu).

Description 
(optional)

Optional description of the template.
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Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. (See “Operations and 
Functions” for definitions.) All functions are not case-sensitive. 
Spaces are not allowed between a function name and “(”. After adding 
formulas, edit their information in the formula table as desired. To 
delete a table row, right-click it and choose Delete Row. Some 
information in the table cannot be modified or deleted.

Instructions:

 To add one or more predefined formulas

1. Click Select.

2. Select the desired formulas.

Hold down the Ctrl or Shift keys on the keyboard while making 
multiple selections. The available formulas depend on the 
Formulas & Units tab settings in Options.

3. Click OK.

 To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available formulas depend on the Formulas & Units tab 
settings.

Feature Description
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Baseline Correction 
Type

For defining a baseline correction for the raw data. These options are 
available:

• 100%T baseline. Standard baseline correction. The data may be 
acquired using an empty holder or using solvent.

• 0%T or 0%R baseline. Corrects for any inherent variations in 
the electronic zero line of the instrument.

More:

This can be more of a factor at lower light energy levels present in a 
DRA (Diffuse Reflectance Accessory) and when working at high 
absorbance levels.

For more information, see ASTM method E903. The calculation in 
transmission performed in the instrument is:

 or 

Requires a previously acquired 100%T baseline.

• Standard reference correction with 0%R or 0%T baseline. 
Applies a 100%T baseline correction and a zero line correction 
(0%R baseline) to a sample measured with a reflectance accessory 
that is not absolute (for example, a Diffuse Reflectance 
Accessory). Displays a table for entering a correction value for 
each measured wavelength.

More:

The software multiplies the scan result at each data point by the 
corresponding value in the table (explained below). To delete the 
information from the table, click Clear Table.

The calculation in reflectance performed in the instrument is:

Requires a previously acquired 100%T baseline.

Correct single beam 
substitution error

Allows the ratioed spectrum acquired with the single-beam sphere to 
be corrected as if it were acquired with a double-beam instrument 
(where the baseline is collected in the integrating sphere). Requires 
that Data mode on the Instrument tab be set to Absorbance, 
% Transmittance, % Reflectance or Log(1/R).

Feature Description

S - 0%T
100%T - 0%T
---------------------------------- S - 0%R

100%R - 0%R
-----------------------------------

S - 0%R
100%T - 0%R
---------------------------------- Std. Ref.
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Select Standard reference correction with 0%R or 0%T baseline to display additional 
features:

Related Topics

Setting Application Parameters

Settings for Scan Applications

Operations and Functions

Formulas and Units Tab

Instrument Tab for Scan

These settings are available:

Feature Description

Clear Table Deletes all entries from the table.

Load Table Fills the table with wavelength and intensity values from a .tsv (tab 
separated values) file or .csv (comma separated values) file containing X 
delimiter Y pairs.

Save Table Saves in a .tsv file, .csv file, or .xml (extensible markup language) file the 
wavelength and intensity values in the table.

Click Settings in Scan to display the Instrument tab in 
the right pane.

Feature Description

Data mode Y-axis format for acquired data. Available options include Absorbance 
and % Transmittance.

For Abs*Factor, set Factor to a value by which to multiply measured 
absorbance values.

Smooth Select the desired degree of smoothing (if available for the selected 
data mode and Derivative setting). Smoothing reduces noise in the 
data but can also remove some spectral features such as small peaks, 
valleys and shoulders. For more information, see About Smoothing.

Derivative Select the desired derivative order for acquired data (if available for 
the selected data mode).

Start wavelength 
and End wavelength

Starting and ending values of the wavelength range for acquiring data.
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Related Topics

Setting Application Parameters

Settings for Scan Applications

Accessories Tab for Scan

The status of accessories can be monitored during measurements.

Related Topics

Setting Application Parameters

Settings for Scan Applications

Instrument Status Monitors

Samples Tab for Scan

These settings are available:

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can improve the 
signal-to-noise ratio; however, a larger spectral bandwidth decreases 
the ability to resolve closely spaced spectral features, especially in 
scanning measurements.

Integration time How long the system acquires and averages data at each data interval. 
Increasing the integration time improves the signal-to-noise ratio but 
reduces the scan speed.

Data interval Difference in wavelength between two consecutive data points.

Scan speed Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time Estimated duration of data acquisition. Increases as integration time 
increases and as the data interval decreases. Varies inversely with scan 
speed.

Click Settings in Scan to display the Accessories tab in 
the right pane. The available parameters depend on the 
installed accessories. For more information,  refer to the 
user guide for the accessory or search for “Evolution 200 
Series Accessories” in the INSIGHT Help system.

Click Settings in Scan to display the Samples tab in the 
right pane.

Feature Description
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Related Topics

Setting Application Parameters

Settings for Scan Applications

Peak Pick Tab for Scan

These settings are available:

Feature Description

Number of samples Number of samples for the experiment.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample 
spectra using the base name “dye” would be dye1, dye2 and 
dye3.

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table on the 
Samples tab.

Save Samples Saves the contents of the samples table in a .tsv (tab separated 
values) file or .csv (comma separated values) file in a specified 
location.

Samples table Lists samples by their names and descriptions, up to a maximum 
of 1000. To change a sample name, click its cell and edit the text. 
To enter or change text in a table cell, click it and type. To order 
the list by sample name or description, click the appropriate 
column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

When setting up a Scan workbook, click Settings to 
display the Peak Pick tab in the right pane.

Feature Description

Result Data analysis operation to perform automatically after sample measurement.

Select Off to not perform any operation.

The parameters for a selected operation appear to the right. See Finding Peaks in 
Scan Data or Finding Value Level Crossings in Scan Data for information on 
setting them and how results are displayed.
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Related Topics

Setting Application Parameters

Settings for Scan Applications

Settings for Quant Applications

The follow tabs of settings are available:
Type Tab for Quant
Measurement Tab for Quant
Instrument Tab for Quant
Accessories Tab for Quant
Standards Tab for Quant
Samples Tab for Quant

Related Topics

Formulas and Units Tab

Performing a Quantitative Analysis

Type Tab for Quant

These settings are available:

To set parameters that define a Quant template, click 
Settings.

Note  Change Quant settings only before sample measurements. All Quant measurements 
saved in a workbook must be made with the same settings. See Setting Application 
Parameters for information about unlocking settings.

Click Settings in Quant to display the Type tab in the 
right pane.

Feature Description

Name (if present) User group name followed by the name of the template of settings 
(entered when the template was saved using Save Workbook Settings as 
Template in the File menu).

Description 
(optional)

Optional description of the template.

Quant Type Type of quantitative analysis (see the table below). An image 
representing the selected type appears to the right. The required tabs also 
appear (click the Reset action button to step through them).

Pathlength Distance the light travels through the sample.
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Related Topics

Settings for Quant Applications

Formulas and Units Tab

Performing a Quantitative Analysis

Measurement Tab for Quant

These settings are available:

Manually entered factor

Quant Type How the Type Calculates Sample Concentration

Manually entered 
factor

Uses the equation C = K * A, where C is the concentration of the 
analyte in the selected units, K is the entered factor, and A is the 
absorbance.

Measure single 
standard

Divides the sample absorbance value by the average absorbance value 
of a single standard. This is in effect a “Standard curve” quantification 
(see below) with just one standard.

Standard curve Uses a simple standard curve based on the absorbance of a set of 
standards at a specified wavelength.

Standard curve with 
two wavelengths

Takes the average of values determined by each of two standard curves 
associated with the specified wavelengths.

Advanced standard 
curve

Uses a standard curve generated from a specified equation.

Click Settings in Quant to display the Measurement tab 
in the right pane. The available features depend on the 
Quant Type setting on the Type tab. The features for 
each type are described in tables below.
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Feature Description

Analysis wavelength(s) Wavelength(s) to use for the quantitative analysis.

Correction Baseline correction to apply to raw data. Available options:

• Single point. Enter a wavelength value to define the 
endpoint for the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the 
specified baseline point and calculating the absorbance 
value on the drawn baseline at the specified analytical 
wavelength. The software subtracts the calculated baseline 
absorbance value from the measured absorbance value and 
reports the corrected absorbance.

• Sloping baseline. Enter two wavelength values to define 
the endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value 
from the measured absorbance value and reports the 
corrected absorbance.

• None Uses uncorrected data.

Component name Component to quantify.

Unit Component concentration unit. The available units depend on 
the Formulas & Units tab settings in Options.

Use user-defined factor Calculates component concentration using the entered factor 
(K in the equation C = K *A), with the selected unit.

Use extinction coefficient Calculates component concentration with absorbance (A) equal 
to

where  is the entered extinction coefficient (a constant 
dependent on the component and wavelength), c is 
concentration in the selected unit, and  is 1 cm (the 
pathlength).

c
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Molecular weight Molecular weight of the component. Available only if the units 
specified on this tab are different and require this value for a 
conversion.

Calculate additional 
results

For selecting or defining formulas for additional data 
processing, with the results appearing in the analysis report. The 
formulas are written in a form similar to that used in a 
command script language, with constants, mathematical 
functions, etc. (See “Operations and Functions” for definitions.) 
All functions are not case-sensitive. Spaces are not allowed 
between a function name and “(”. After adding formulas, edit 
their information in the formula table as desired. To delete a 
table row, right-click it and choose Delete Row. Some 
information in the table cannot be modified or deleted.

Instructions:

 To add one or more predefined formulas

1. Click Select.

2. Select the desired formulas.

Hold down the Ctrl or Shift keys on the keyboard while 
making multiple selections. The available formulas depend 
on the Formulas & Units tab settings in Options.

3. Click OK.

 To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, 
select it and enter values for the variables.

The available formulas depend on the Formulas & Units 
tab settings in Options.

3. Click OK.

4. For selected provided formulas, enter a name and 
concentration unit in the table.

The available formulas depend on the Formulas & Units 
tab settings.

Feature Description
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Measure single standard

Standard curve

Standard curve with two wavelengths

Feature Description

Analysis wavelength(s) Wavelength(s) to use for the quantitative analysis.

Correction See Correction above.

Component name Component to quantify.

Unit Component concentration unit. The available units depend on 
the Formulas & Units tab settings in Options.

Standard concentration Concentration of the single standard.

Std averaging Whether and how to average concentration values from multiple 
measurements of the same standard or from multiple standards 
prepared under the same conditions. To average multiple 
measurements of the same standard, select Replicate and set 
Number of replicates to the total number of measurements. To 
average values from two or three similar standards, select 
Duplicate or Triplicate, respectively.

Calculate additional 
results

See Calculate additional results above.

Feature Description

Analysis wavelength(s) Wavelength(s) to use for the quantitative analysis.

Correction See Correction above.

Component name Component to quantify.

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

See Calculate additional results above.

Feature Description

Analysis wavelengths Wavelengths to use for the quantitative analysis.

Correction See Correction above.

Component name Component to quantify.

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings.

Calculate additional 
results

See Calculate additional results above.
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Advanced standard curve

Related Topics

Operations and Functions

Formulas and Units Tab

Settings for Quant Applications

Feature Description

Standard Curve Equation Equation used to quantify samples, written in a form similar to 
that used in a command script language, with constants, 
mathematical functions, etc. (See Operations and Functions for 
definitions of operations and functions.) All functions are not 
case-sensitive. Spaces are not allowed between a function name 
and “(”.

For this Quant type the equation defines the value for the Y-axis 
of the calibration curve.

Instructions:

 To use a predefined equation

1. Click Select.

2. Select the desired equation and click OK.

The available equations depend on the Formulas & Units 
tab settings in Options.

 To define an equation

1. Click Build.

2. To enter an equation in its entirety, set Equation type to 
User defined and type the equation. To use a provided 
equation, select it and enter values for the variables.

The available equations depend on the Formulas & Units 
tab settings.

3. Click OK.

Component name Component to quantify.

Unit Component concentration unit. The available units depend on 
the Formulas & Units tab settings in Options.

Calculate additional 
results

See Calculate additional results above.
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Performing a Quantitative Analysis

Instrument Tab for Quant

These settings are available:

Click Settings in Quant to display the Instrument tab in 
the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data. Available options include 
Absorbance and % Transmittance.

For Abs*Factor (Scan only), set Factor to a value by which to 
multiply measured absorbance values.

Smooth (Scan only) Select the desired degree of smoothing (if available for the 
selected data mode and Derivative setting). Smoothing reduces 
noise in the data but can also remove some spectral features 
such as small peaks, valleys and shoulders. See About 
Smoothing.

Derivative (Scan only) Select the desired derivative order for acquired data (if available 
for the selected data mode).

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for 
acquiring data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for Scan) or at each measured wavelength (for Fixed). 
Increasing the integration time improves the signal-to-noise 
ratio but reduces the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Wavelength Summary 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Related Topics

Settings for Quant Applications

Formulas and Units Tab

Performing a Quantitative Analysis

Accessories Tab for Quant

The status of accessories can be monitored during measurements.

Related Topics

Settings for Quant Applications

Instrument Status Monitors

Formulas and Units Tab

Performing a Quantitative Analysis

Standards Tab for Quant

These settings are available:

Click Settings in Quant to display the Accessories tab in 
the right pane. The available parameters depend on the 
installed accessories. For more information,  refer to the 
user guide for the accessory or search for “Evolution 200 
Series Accessories” in the INSIGHT Help system.

To display the Standards tab in the right pane, click 
Settings in Quant and then set Quant Type to Standard 
curve, Standard curve with two wavelengths, or 
Advanced standard curve.

Feature Description

Curve fit type Type of equation used to create the standard curve from standard 
concentration values.

Standard averaging Whether and how to average concentration values from multiple 
measurements of the same standard or from multiple standards 
prepared under the same conditions. To average multiple 
measurements of the same standard, select Replicate and set Number 
of replicates to the total number of measurements. To average values 
from two or three similar standards, select Duplicate or Triplicate, 
respectively.
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Related Topics

Settings for Quant Applications

Formulas and Units Tab

Performing a Quantitative Analysis

Samples Tab for Quant

Minimum r2 The r2 value indicates how well the standard curve fits the standard 
data points, with 1.0 a perfect fit. If Minimum r2 is selected, samples 
can be quantified only after that value is achieved for the standard 
curve.

Calculate from 
weight/volume

If available for the current unit, calculates concentration when the 
weight and volume of material used to prepare each standard is 
known. Enter the weight and volume for each standard in the 
appropriate table cells, or enter it later as part of running an analysis.

Use correction 
factor

If available and selected, specifies a multiplication factor for each 
standard. Can be used to correct for standard properties (percent 
purity, water content, etc.) or preparation steps that affect the 
measured result such as a dilution.

When this option is selected, two columns are added to the standards 
table: Correction Factor and Corrected Concentration. In the 
Correction Factor column, enter the desired factor for each standard 
in the table. The values in the Corrected Concentration column are 
used to create the calibration curve. If a report is generated that 
includes information about the standards, the report will also include 
the correction factors and corrected concentrations.

Standards Table Contains concentration and other information about the standards. 
To add information from a .csv (comma separated values) file or .tsv 
(tab separated values) file, click Import Standards. To save the 
information in a .csv file or .tsv file, click Export Standards.

Click Settings in Quant to display the Samples tab in 
the right pane.

Feature Description
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These settings are available:

Related Topics

Settings for Quant Applications

Formulas and Units Tab

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use sample 
correction factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table.

Use weight/volume 
correction

If available for the current unit, corrects sample concentrations using 
the entered target weight and volume:

corrected concentration = measured concentration * (actual weight / 
target weight) * (target volume / actual volume)

Use control limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table.

Save Samples Saves the contents of the samples table in a .tsv (tab separated values) 
file or .csv (comma separated values) file in a specified location.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.
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Performing a Quantitative Analysis

Settings for Rate Applications

The follow tabs of settings are available:
Type Tab for Rate
Measurement Tab for Rate
Instrument Tab for Rate
Accessories Tab for Rate
Samples Tab for Rate
Rate Calculations Tab for Rate

Related Topics

Rate

Performing a Rate Measurement

Type Tab for Rate

These settings are available:

To set parameters for the current Rate workbook, click 
Settings.

Click Settings in Rate to display the Type tab in the 
right pane.

Feature Description

Name (if 
present)

User group name followed by the name of the template of settings (entered 
when the template was saved using Save Workbook Settings as Template in 
the File menu).

Description Description of the template.

Rate Type Type of rate measurement to perform (see the table below). An image 
representing the selected type appears to the right. The required tabs also 
appear (click the Reset action button to step through them).

Mode These options are available:

Time. Performs rate measurements based on elapsed time.

Temperature. Performs rate measurements based on elapsed time and also 
records temperature settings. Available for fixed rate experiments only.
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Related Topics

Settings for Rate Applications

Performing a Rate Measurement

Modifying a Rate Curve

Measurement Tab for Rate

Rate Type How the Type Collects Data

Single wavelength For each sample, measures a specified wavelength at specified intervals 
of time.

Multiple 
wavelengths

For each sample, measures multiple specified wavelengths at specified 
intervals of time.

Scan data 
acquisition

For each sample, measures a range of wavelengths at specified 
intervals of time.

Click Settings in Rate to display the Measurement tab in 
the right pane.
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These settings are available:

Feature Description

Integration time How long the system acquires and averages data to obtain each data 
point at each measured wavelength. Available for single and multicell 
experiments only. (To set integration time for scan rate experiments, 
see Instrument Tab for Rate.)

Dwell time How long the sample remains in the light beam. Available for single 
and multicell experiments only.

Use this setting to vary the number of data points collected per cell 
per cycle. Dwell time is always a multiple of integration time (see 
above). Dwell time can be very useful when performing multicell 
rate measurements. This is because the cell changer accessory will 
position a cell in the light beam for a specified period of time (dwell 
time), rather than moving back and forth between cells and 
increasing the time between measurements (when no sample is in 
the light beam).

For example, if the integration time is 0.1 second and dwell time is 
0.5 second, five data points will be recorded for each cell before the 
cell changer moves to the next cell. For fairly fast reactions, multiple 
samples can be measured, with over ten times as many data points 
acquired within a short time. This can improve the accuracy of rate 
calculations for faster multicell rate measurements.

Number of stages Defines the number of measurement stages over which the frequency 
of data acquisition can be determined. For example, if a reaction has 
two components, the first component could be fast and require a 
high data density. The second component could be much slower and 
longer lived, therefore requiring a lower data density. Defining 
multiple stages enables the use of the proper data density over a 
given period of time.

Available for single and multiple wavelength experiments only.

Temp unit Determines the temperature unit used in the stages table (see below).

Time unit Determines the time unit used in the stages table (see below).
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Stages table Available for single and multiple wavelength experiments only.

For time-based experiments:

Defines for each stage the start time, end time and interval (how 
frequently a measurement is made). For example, using an interval 
of 10 seconds would measure the sample every 10 seconds from the 
start time to the end time. In a multicell experiment the interval 
setting is the measurement interval for each sample.

For temperature-based experiments:

Defines for each stage the end temperature, ramp rate, hold type, 
hold time, interval and whether data collection will occur.

Target Temp. Enter a target temperature between 0.00 °C (32.00 °F 
or 273.15 °K) and 110.00 °C (230.00 °F or 383.15 °K).

Ramp Rate. Enter a ramp rate from 0.40 to 20.00 °C/min 
(0.72 to 36.00 °F/min or 0.40 to 20.00 °K/min) up or down.

Hold Type. Specify a hold time at the target temperature before 
continuing to the next stage. Time holds for a specified time (see 
Hold Time below). Prompt holds until the operator responds to a 
message in the software. Trigger waits for an external trigger. 
Choosing Start in the trigger prompt will override the trigger.

Hold Time. When Hold Type is set to Time, enter the length of 
time to hold at the target temperature before continuing to the next 
stage.

Interval. Specifies how frequently a measurement is made. Must be 
equal to or greater than the specified Integration Time and less than 
the stage duration. Disabled when Collect Data (see below) is set to 
No.

Collect Data. Specifies whether to collect data during each stage.

Cycle time (Scan 
only)

Time between each measurement cycle. Available for scan 
experiments only.

Number of cycles 
(Scan only)

Number of measurement cycles. Available for scan experiments only.

Duration (Scan only) Length of the experiment, calculated by multiplying the cycle time 
by the number of cycles (see above). Available for scan experiments 
only.

Feature Description
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Related Topics

Settings for Rate Applications

Performing a Rate Measurement

Modifying a Rate Curve

Instrument Tab for Rate

These settings are available:

Click Settings in Rate to display the Instrument tab in 
the right pane.

Feature Description

Data mode Y-axis format for acquired data. Available options include Absorbance 
and % Transmittance.

For Abs*Factor (Scan only), set Factor to a value by which to 
multiply measured absorbance values.

Smooth (Scan only) Select the desired degree of smoothing. Smoothing reduces noise in 
the data but can also remove some spectral features such as small 
peaks, valleys and shoulders. For more information, see About 
Smoothing. Available for scan experiments only.

Derivative (Scan 
only)

Select the desired derivative order for acquired data. Available for 
scan experiments only.

Start wavelength 
and End wavelength 
(Scan only)

Starting and ending values of the wavelength range for acquiring 
data. Available for scan experiments only.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can improve the 
signal-to-noise ratio; however, a larger spectral bandwidth decreases 
the ability to resolve closely spaced spectral features, especially in 
scanning measurements.

Integration time 
(Scan only)

How long the system acquires and averages data at each data interval. 
Increasing the integration time improves the signal-to-noise ratio but 
reduces the scan speed. Available for scan experiments only.

Data interval (Scan 
only)

Difference in wavelength between two consecutive data points. 
Available for scan experiments only.

Scan speed (Scan 
only)

Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases. Available for 
scan experiments only.
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Related Topics

Settings for Rate Applications

Performing a Rate Measurement

Modifying a Rate Curve

Accessories Tab for Rate

The status of accessories can be monitored during measurements.

Related Topics

Instrument Status Monitors

Settings for Rate Applications

Performing a Rate Measurement

Modifying a Rate Curve

Estimated time 
(Scan only)

Estimated duration of data acquisition. Increases as integration time 
increases and as the data interval decreases. Varies inversely with scan 
speed. Available for scan experiments only.

Reference 
wavelength 
correction

When selected, automatically acquires a reference measurement at a 
specified wavelength each time a sample measurement is taken. The 
reference measurement is then subtracted from the corresponding 
sample measurement to produce a corrected measurement result. 
Only the corrected results are reported.

Use the Reference wavelength box to specify a wavelength for the 
reference measurement.

Available for single and multiple wavelength experiments only.

Wavelength 
Summary

Wavelengths to monitor during the reaction. Available for single and 
multiple wavelength experiments only.

Click Settings in Rate to display the Accessories tab in 
the right pane. The available parameters depend on the 
installed accessories. For more information,  refer to the 
user guide for the accessory or search for “Evolution 200 
Series Accessories” in the INSIGHT Help system.

Feature Description
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Samples Tab for Rate

These settings are available:

Related Topics

Settings for Rate Applications

Performing a Rate Measurement

Modifying a Rate Curve

Click Settings in Rate to display the Samples tab in the 
right pane.

Feature Description

Number of samples Number of samples for the experiment.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Set up sample table 
columns

Specifies the columns of sample information to be entered during the 
experiment. To add a column, type the desired name in an empty cell 
and press the Tab key. To delete a column (except the Sample Title 
column), right-click it and choose Delete Column. To delete all the 
columns (except the Sample Title column), right-click the table and 
choose Delete All Columns.

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table on the Samples 
tab.

Save Samples Saves the contents of the samples table in a .tsv (tab separated values) 
file or .csv (comma separated values) file in a specified location.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. Additional columns are defined by the Set up sample table 
columns option (see above).

To change a sample name, click its cell and edit the text. To enter or 
change text in a table cell, click it and type. To order the list by 
sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.
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Rate Calculations Tab for Rate

These settings are available:

Related Topics

Settings for Rate Applications

Performing a Rate Measurement

Modifying a Rate Curve

Click Settings in Rate to display the Rate Calculations 
tab in the right pane (for time-based single and multiple 
wavelength experiments only).

Feature Description

Calculate rate constants 
automatically at end of 
data acquisition

Calculates rate constants automatically at the end of the 
experiment. When this option is selected, the rate curve appears in 
the data display and the rate settings and calculations appear in 
the sample measurements table after the measurement is 
completed. To modify the rate curve, double-click the data 
display or choose Analyze (menu) > Modify Rate Curve.

When this option is cleared and rate calculations have been 
entered, use the Modify Rate Curve window to view, modify, 
update and accept the rate calculations settings. After you accept 
the settings, the window closes and the rate curve appears in the 
data display and the rate settings and calculations appear in the 
sample measurements table. See Performing Rate Measurements 
for more information.

Calculate Rate For each measurement stage, enter the starting and ending times 
of the rate vector, the rate scaling factor, and the order of the 
reaction. The factor is a constant that is multiplied by a calculated 
kinetics parameter to give physical significance to the 
measurement.

To enter different settings for individual wavelengths, select 
Specify settings for individual wavelengths (available only if 
Rate Type on the Type tab is set to Multiple wavelengths). In the 
Wavelength column, select or type the desired wavelength for each 
row of settings. The available wavelengths are those entered on the 
Instrument tab.

To delete a row of information from the table, right-click the row 
and choose Delete Selected Row. To delete all the information 
from the table, right-click it and choose Clear Table.
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Configuring a Report

A report contains a table of sample data and other specified information. Reports can be saved 
and printed or the sample data can be exported.

 To configure a report

1. Open a workbook or measure a sample.

2. Click Reports.

The sample data that were measured and archived in the opened workbook are displayed 
on the Samples tab.

3. Select the sample results to include by clicking a row in the table.

Use “Shift + click” or “Ctrl + Click” to select additional rows.

4. To specify the columns to include and their order, click the Reportable Data tab.

5. To specify the items to include in printed reports for this workbook, click the Layout tab.

6. To preview all the pages in the report, click the Preview action button.

7. To print the report, click the Print action button.

Related Topics

Report Master Page Tab

Reports

Note  See the Report Master Page tab in Options to define global settings for all reports 
including headers and footers and a logo or other image.

Note  To specify that all items in printed reports span the full width of each page, 
select Fit To Width in the navigation pane. See Layout tab for more information 
about formatting options for printed report.
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Exporting Data

You can export acquired data and associated measurement results from any opened report or 
configure INSIGHT to export all data and results automatically.

Exporting Data from a Report

Acquired data and associated measurement results can be manually saved in a specified format 
and location.

 To export acquired data and measurement results

1. Open a workbook or measure a sample.

2. Click Reports.

3. Select the sample data to be exported by clicking a row in the table.

Use Shift + Click or Ctrl + Click to select additional rows.

4. Click the Export action button.

5. Select a location for the exported file.

6. Type a file name for the exported data in the File name box.

7. Set Save as type to the desired file format (several formats for exporting reports and 
spectra are available).

8. Click Save.

The information is saved in a file in the specified format, file name and location.

Related Topics

Exporting Data

Reports

Contents

• Exporting Data from a Report

• Exporting Data Automatically
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Exporting Data Automatically

INSIGHT software can be configured to automatically save all acquired data in a specified 
format and location.

 To configure INSIGHT to export all acquired data

1. From any screen, click Options.

2. Click the Data Store tab.

3. In the Convert Data group, select Auto export data.

4. Select an available format.

5. To select the location for the exported data, type a new path or use Browse.

The results for each measured sample are saved in a separate file in the specified format 
and location. The filename includes the sample and workbook name and the date and 
time.

Related Topics

Exporting Data

Reports

Managing Data

My Data 

Contents

• My Data

• Reports

Use My Data to access saved workbooks, templates and 
Performance Verification (PV) result reports. Drag the 
borders of the panes to change their size and shape.
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Use these tabs to select items to open or delete:

Use the links below the buttons to display archived workbooks. Click Active workbook 
library to view the directory where a workbook was last saved. To change the path to the 
default workbook, right-click My favorite workbook library and choose Edit Link.

Related Topics

Managing Data

Reports 

A report contains a table of sample data and other specified information.

Tab Description

Workbooks Select a folder in the tree to list its workbooks. Select a listed workbook to see 
its spectra. To zoom in on the displayed spectra, draw a box and click inside it 
or use the view finder. To view the full data range, double-click the spectral 
display.

Templates Select a group folder in the tree to list its templates.

PV Reports Select the listed result reports of interest. To select multiple reports, hold 
down Shift or Ctrl. (One window will display all the opened results.)

Click Open to open the selected workbook or 
template (and associated application) or the 
selected PV reports. Alternatively, double-click the 
item to open it. Additional measurements can be 
appended to an opened workbook. Opened PV 
results can be printed and copied from the report 
window.

Click Delete to delete the selected workbook or 
template.

To configure or view the report after opening a 
workbook or measuring a sample, click Reports.
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These action buttons appear in Reports:

The export formats include:

Button Description

Shows the current report before printing, with the header and footer specified 
on the Report Master Page tab in Options.

Prints the current report on the specified printer.

Saves the specified spectral data or sample measurement results in the specified 
format (see the table below).

Format Description

Report, Excel XML 
Spreadsheet (*.xml)

Can be opened in Excel®. Only the columns selected on the 
Reportable Data tab are saved and only for the rows selected on 
the Samples tab. Configure those tabs to include the desired 
information before exporting.

For Rate applications, the data is displayed with one column per 
spectrum, and one sample per sheet. 

Report, Tab Separated 
Values (*.tsv)

Can be opened in Notepad or Excel. Only the columns selected 
on the Reportable Data tab are saved and only for the rows 
selected on the Samples tab. Configure those tabs to include the 
desired information before exporting.

Report, Comma 
Separated Values (*.csv)

Can be opened in Notepad or Excel. Only the columns selected 
on the Reportable Data tab are saved and only for the rows 
selected on the Samples tab. Configure those tabs to include the 
desired information before exporting.

Spectrum, Excel XML 
Spreadsheet (*.xml)

Can be opened in Excel. Saves absorbance values along with the 
corresponding wavelengths only for the rows selected on the 
Samples tab. If multiple sample rows are selected, the 
corresponding absorbance values for each wavelength are saved 
onto separate worksheets within one Excel file.

Spectrum, Tab Separated 
Values (*.tsv)

Saves absorbance values along with the corresponding 
wavelengths for the rows selected on the Samples tab in a format 
that can be opened in Notepad or Excel. If multiple sample rows 
are selected, the corresponding absorbance values for each 
wavelength are saved sequentially in one column.
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If the computer is not mapped to recognize that .xml files should be opened with Excel, open 
the exported file from within Excel.

Spectrum, Comma 
Separated Values (*.csv)

Saves absorbance values along with the corresponding 
wavelengths for the rows selected on the Samples tab in a format 
that can be opened in Notepad or Excel. If multiple sample rows 
are selected, the corresponding absorbance values for each 
wavelength are saved sequentially in one column.

Spectra, New Workbook 
(*iwbk)

Saves the settings and information about any samples, standards 
and advanced calculations for the selected application to a new 
INSIGHT workbook.

Spectrum 3D, Excel 
XML Spreadsheet (*.xml)

Saves absorbance values along with the corresponding time and 
wavelengths for the rows selected on the samples tab in a format 
that can be opened in Excel. Only available in Scan Rate 
applications.

Format Description
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These tabs appear in the Reports right pane:

The Layout tab includes:

Tab Description

Samples Displays the sample data archived in the opened workbook. To sort the 
information in the table, click the desired column heading.

To view particular data, select it in the table. For most applications this 
displays a sample spectrum. For fixed Rate data, this displays spectral data 
points for the indicated wavelength and the line resulting from the rate 
calculations, if specified. For scan Rate data, all of the sample’s spectra 
appear.

See Data Display for information on using features made available by 
right-clicking the displayed data.

To view, print or copy data acquisition and other information about data, 
right-click it in the list and choose Properties.

To change a sample ID, click its cell and type a new ID. (If sample IDs are 
not editable, choose Options > Preferences and clear Prevent removal of 
data.)

Reportable 
Data

Specifies the report columns to include and their order. The available 
columns depend on the current application and workbook settings.

To include a column, select it in the Available Columns list and click 
.

To remove an included column, select it in the Reported Columns list and 
click .

To move an included column up, select it and click .

To move an included column down, select it and click .

To restore the most recent configuration, click .

Only the information associated with selected columns will be included in 
exported files. See the information on exporting reports above.

Layout Specifies the items to include in printed reports (see the table below).

Feature Description

Header/Footer Includes a header and footer in the printout.

Header Items Title and subtitle to appear in the header. Use the Font buttons to specify 
their fonts.
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Settings info Includes a table of workbook settings in printed reports including the 
name, serial number and settings for any accessories that were used. Use the 
Font button to specify the font for the information.

Samples table Includes a table of sample measurement information for the rows selected 
on the Reports > Samples tab in printed reports. Use the Font button to 
specify the font for the information.

Results/ 
Calculations 
table

This option adds the following if available to printed reports:

• Results table, which appears to the right of the data display below the 
Sample ID readout. The results table shows the results of analysis 
operations and whether sample points fall within specified control 
limits.

• Calculations table, which appears below the sample measurements 
table when Advanced Calculations is selected in the navigation pane 
(available for all applications except Rate and DNA Melting).

Use the Font button to specify the font for the information.

Standards For Quant applications that include standards, includes a table and graph 
of information for the standards in printed reports. Use the Font button to 
specify the font for the information.

X-Y pairs For Rate applications, includes a table of x-y data for each sample row 
selected on the Samples tab in printed reports. For each sample, one X-Y 
pair is logged for each wavelength, sampling interval and stage. Use the 
Font button to specify the font for the information.

Graphs Includes sample spectra and other data plots in printed reports. Data can 
be placed in individual graphs or overlaid on one graph.

• Select Overlay to print data plots overlaid. (Note that this is the only 
setting that allows tables and graphs to be printed on the same page.)

• Select Separate to print each data plot in a separate graph, with the 
specified number of graphs on a page.

Report notes Includes a Report Notes box in printed reports. To add text to the Report 
Notes box, click Edit. Use the Font button to specify the font for the 
information.

Page Setup Specifies the paper size, orientation and other printing attributes.

Fit to page 
width

Changes the layout of all included items so they fill the page width. 
(Column headings may be truncated.)

Note  We recommend first defining a master page on the Report Master Page tab in 
Options.

Feature Description
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Related Topics

Configuring a Report

Managing Data

Math and Analysis Operations

Smoothing Scan Data

Use Smooth in the Math menu to reduce noise in wavelength scan data. This feature is 
available in Scan and Scan Rate applications.

The smoothing algorithm uses the Savitzky-Golay method. For more information, see About 
Smoothing.

 To smooth data

1. Choose Math (menu) > Smooth.

The selected spectrum appears in the Operands pane.

The workbook spectra are listed at the left. To add others:

a. Click Browse.

b. Select a folder in the left pane (use the features above it to navigate), a workbook in 
the middle pane, and spectra in the upper-right pane. To select multiple spectra, hold 
down Shift or Ctrl. Selected spectra appear in the lower-right pane.

Contents

• Smoothing Scan Data

• Converting Scan Data to a Derivative

• Converting Scan Data to Other Units

• Adding Two Scan Spectra

• Normalizing Scan Data

• Subtracting a Scan Spectrum

• Ratioing Two Scan Spectra

• Averaging Scan Spectra

• Adding, Subtracting, Multiplying or Dividing Scan Data by a Factor

• Finding Peaks in Scan Data

• Finding Value Level Crossings in Scan Data
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c. Click OK. Each added spectrum is listed with asterisks at the beginning of its name 
to indicate the data is not in the current workbook.

2. Select any other listed spectra to smooth and click Add.

To remove a spectrum from the Operands pane, click it and click Remove. To remove all 
the spectra, click Clear All.

3. Select the polynomial order.

4. Specify the degree of smoothing (number of points in the smoothing formula) by 
dragging the slider:

5. To perform a math operation on the smoothed result, click Operate on Result and 
choose an operation. Otherwise, go to the next step.

Perform the operation as explained in the appropriate related topic below.

To return to the previous window, click Back.

To perform additional math operations, repeat this step.

6. To save the result in the current workbook, click Workbook and name the spectrum or 
spectra when prompted.

The data is added to the list and is available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate the data is not saved.

7. Click Close to close each displayed math window.

Related Topics

About Smoothing

Math and Analysis Operations

Note  To use the result in another Smooth operation, use Workbook or Temporary 
to add it to the list (see step 6), click Add to make it an operand, and continue with 
step 2.



3 INSIGHT Software
Operation

138 Evolution 200 Series Spectrophotometer User Guide Thermo Scientific

About Smoothing

The smoothing feature of INSIGHT software uses a Savitzky-Golay algorithm modified to 
reduce high frequency breakthrough; that is, to reduce noise in the spectrum. The algorithm 
is based on performing a least-squares linear regression fit of a polynomial of order k over at 
least k+1 data points around each point in the spectrum.

Converting Scan Data to a Derivative

Use Derivative in the Math menu to convert scan data to the first, second, third or fourth 
derivative. This feature is available in Scan and Scan Rate applications.

 To convert scan data to a derivative

1. Choose Math (menu) > Derivative.

The selected spectrum appears in the Operands pane.

The workbook spectra are listed at the left. To add others:

a. Click Browse.

b. Select a folder in the left pane (use the features above it to navigate), a workbook in 
the middle pane, and spectra in the upper-right pane. To select multiple spectra, hold 
down Shift or Ctrl. Selected spectra appear in the lower-right pane.

c. Click OK. Each added spectrum is listed with asterisks at the beginning of its name 
to indicate the data is not in the current workbook.

2. Select any other listed spectra to convert and click Add.

To remove a spectrum from the Operands pane, click it and click Remove. To remove all 
the spectra, click Clear All.

3. Select the derivative order.

4. Select the polynomial order of the derivative formula.

5. Specify the number of points in the derivative formula by dragging the slider:

6. To perform a math operation on the converted result, click Operate on Result and 
choose an operation. Otherwise, go to the next step.

Note  To use the result in another Derivative operation, use Workbook or 
Temporary to add it to the list (see step 7), click Add to make it an operand, and 
continue with step 2.
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Perform the operation as explained in the appropriate related topic below.

To return to the previous window, click Back.

To perform additional math operations, repeat this step.

7. To save the result in the current workbook, click Workbook and name the spectrum or 
spectra when prompted.

The data is added to the list and is available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate the data is not saved.

8. Click Close to close each displayed math window.

Related Topics

Math and Analysis Operations

Converting Scan Data to Other Units

Use Convert Spectra in the Math menu to convert scan data to another Y-axis format.

 To convert scan data to another format

1. Choose Math (menu) > Convert Spectra.

The selected spectrum appears in the Operands pane.

The workbook spectra are listed at the left. To add others:

a. Click Browse.

b. Select a folder in the left pane (use the features above it to navigate), a workbook in 
the middle pane, and spectra in the upper-right pane. To select multiple spectra, hold 
down Shift or Ctrl. Selected spectra appear in the lower-right pane.

c. Click OK. Each added spectrum is listed with asterisks at the beginning of its name 
to indicate the data is not in the current workbook.

2. Select any other listed spectra to convert and click Add.

To remove a spectrum from the Operands pane, click it and click Remove. To remove all 
the spectra, click Clear All.

3. Select the desired Y-axis format.

4. To perform a math operation on the converted result, click Operate on Result and 
choose an operation. Otherwise, go to the next step.
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Perform the operation as explained in the appropriate related topic below.

To return to the previous window, click Back.

To perform additional math operations, repeat this step.

5. To save the result in the current workbook, click Workbook and name the spectrum or 
spectra when prompted.

The data is added to the list and is available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate the data is not saved.

6. Click Close to close each displayed math window.

Related Topics

Math and Analysis Operations

Adding Two Scan Spectra

Use Add in the Math menu to add two scan spectra.

 To add two scan spectra

1. Choose Math (menu) > Add.

The selected spectrum appears in the Operand 1 pane. To use a different listed spectrum, 
select it and click Add in the Operand 1 box.

The list includes only current workbook spectra. To add others:

a. Click Browse.

b. Select a folder in the left pane (use the features above it to navigate), a workbook in 
the middle pane, and spectra in the upper-right pane. To select multiple spectra, hold 
down Shift or Ctrl. Selected spectra appear in the lower-right pane.

c. Click OK. Each added spectrum is listed with asterisks at the beginning of its name 
to indicate the data is not in the current workbook.

2. Select the second spectrum to add and click Add in the Operand 2 box.

3. To multiply the second spectrum by a factor other than 1, drag the slider or use Factor.

Note  To use the result in another Convert Spectra operation, use Workbook or 
Temporary to add it to the list (see step 5), click Add to make it an operand, and 
continue with step 2.
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Type a value in the Factor text box or use its up and down arrow buttons. Use Increment 
to set the amount of change these buttons make to the factor when clicked. For example, 
with Factor set to 1.000 and Increment set to 0.500, clicking the Factor up arrow button 
changes the factor to 1.500. 

4. To perform a math operation on the addition result, click Operate on Result and choose 
an operation. Otherwise, go to the next step.

Perform the operation as explained in the appropriate related topic below.

To return to the previous window, click Back.

To perform additional math operations, repeat this step.

5. To save the result in the current workbook, click Workbook and name the spectrum 
when prompted.

The data is added to the list and is available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate the data is not saved.

6. Click Close to close each displayed math window.

Related Topics

Math and Analysis Operations

Normalizing Scan Data

Use Normalize in the Math menu to adjust the Y scale of a scan spectrum so that a selected 
data point has the desired Y value.

 To normalize scan data

1. Choose Math (menu) > Normalize.

The selected spectrum appears in the Operands pane.

The workbook spectra are listed at the left. To add others:

a. Click Browse.

b. Select a folder in the left pane (use the features above it to navigate), a workbook in 
the middle pane, and spectra in the upper-right pane. To select multiple spectra, hold 
down Shift or Ctrl. Selected spectra appear in the lower-right pane.

Note  To use the result in another Add operation, use Workbook or Temporary to 
add it to the list (see step 5), click Add in the Operand 1 box, and continue with step 
2.
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c. Click OK. Each added spectrum is listed with asterisks at the beginning of its name 
to indicate the data is not in the current workbook.

2. Select any other listed spectra to normalize and click Add.

To remove a spectrum from the Operands pane, click it and click Remove. To remove all 
the spectra, click Clear All.

3. Select the desired Y value for the data point specified in the next step.

4. Select the wavelength of the data point.

5. To perform a math operation on the normalized result, click Operate on Result and 
choose an operation. Otherwise, go to the next step.

Perform the operation as explained in the appropriate related topic below.

To return to the previous window, click Back.

To perform additional math operations, repeat this step.

6. To save the result in the current workbook, click Workbook and name the spectrum or 
spectra when prompted.

The data is added to the list and is available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate the data is not saved.

7. Click Close to close each displayed math window.

Related Topics

Math and Analysis Operations

Subtracting a Scan Spectrum

Use Subtract in the Math menu to subtract a scan spectrum from another.

 To subtract a scan spectrum

1. Choose Math (menu) > Subtract.

The selected spectrum appears in the Operand 1 pane. To use a different listed spectrum, 
select it and click Add in the Operand 1 box.

The list includes only current workbook spectra. To add others:

Note  To use the result in another Normalize operation, use Workbook or 
Temporary to add it to the list (see step 6), click Add to make it an operand, and 
continue with step 2.
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a. Click Browse.

b. Select a folder in the left pane (use the features above it to navigate), a workbook in 
the middle pane, and spectra in the upper-right pane. To select multiple spectra, hold 
down Shift or Ctrl. Selected spectra appear in the lower-right pane.

c. Click OK. Each added spectrum is listed with asterisks at the beginning of its name 
to indicate the data is not in the current workbook.

2. Select the spectrum to subtract and click Add in the Operand 2 box.

3. To multiply the second spectrum by a factor other than 1, drag the slider or use Factor.

Type a value in the Factor text box or use its up and down arrow buttons. Use Increment 
to set the amount of change these buttons make to the factor when clicked. For example, 
with Factor set to 1.000 and Increment set to 0.500, clicking the Factor up arrow button 
changes the factor to 1.500.

4. To perform a math operation on the subtraction result, click Operate on Result and 
choose an operation. Otherwise, go to the next step.

Perform the operation as explained in the appropriate related topic below.

To return to the previous window, click Back.

To perform additional math operations, repeat this step.

5. To save the result in the current workbook, click Workbook and name the spectrum 
when prompted.

The data is added to the list and is available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate the data is not saved.

6. Click Close to close each displayed math window.

Related Topics

Math and Analysis Operations

Note  To use the result in another Subtract operation, use Workbook or Temporary 
to add it to the list (see step 5), click Add in the Operand 1 box, and continue with 
step 2.
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Ratioing Two Scan Spectra

Use Ratio in the Math menu to divide a scan spectrum by another.

 To ratio two scan spectra

1. Choose Math (menu) > Ratio.

The selected spectrum appears in the Operand 1 pane. To use a different listed spectrum, 
select it and click Add in the Operand 1 box.

The list includes only current workbook spectra. To add others:

a. Click Browse.

b. Select a folder in the left pane (use the features above it to navigate), a workbook in 
the middle pane, and spectra in the upper-right pane. To select multiple spectra, hold 
down Shift or Ctrl. Selected spectra appear in the lower-right pane.

c. Click OK. Each added spectrum is listed with asterisks at the beginning of its name 
to indicate the data is not in the current workbook.

2. Select the spectrum by which to divide the first and click Add in the Operand 2 box.

3. To multiply the second spectrum by a factor other than 1, drag the slider or use Factor.

Type a value in the Factor text box or use its up and down arrow buttons. Use Increment 
to set the amount of change these buttons make to the factor when clicked. For example, 
with Factor set to 1.000 and Increment set to 0.500, clicking the Factor up arrow button 
changes the factor to 1.500.

4. To perform a math operation on the division result, click Operate on Result and choose 
an operation. Otherwise, go to the next step.

Perform the operation as explained in the appropriate related topic below.

To return to the previous window, click Back.

To perform additional math operations, repeat this step.

5. To save the result in the current workbook, click Workbook and name the spectrum 
when prompted.

The data is added to the list and is available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate the data is not saved.

Note  To use the result in another Ratio operation, use Workbook or Temporary to 
add it to the list (see step 5), click Add in the Operand 1 box, and continue with step 
2.
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6. Click Close to close each displayed math window.

Related Topics

Math and Analysis Operations

Averaging Scan Spectra

Use Average in the Math menu to find the average of two or more scan spectra.

 To use Average

1. Choose Math (menu) > Average.

The selected spectrum appears in the Operands pane.

The workbook spectra are listed at the left. To add others:

a. Click Browse.

b. Select a folder in the left pane (use the features above it to navigate), a workbook in 
the middle pane, and spectra in the upper-right pane. To select multiple spectra, hold 
down Shift or Ctrl. Selected spectra appear in the lower-right pane.

c. Click OK. Each added spectrum is listed with asterisks at the beginning of its name 
to indicate the data is not in the current workbook.

2. Select any other listed spectra to average and click Add.

To remove a spectrum from the Operands pane, click it and click Remove. To remove all 
the spectra, click Clear All.

3. To perform a math operation on the result, click Operate on Result and choose an 
operation. Otherwise, go to the next step.

Perform the operation as explained in the appropriate related topic below.

To return to the previous window, click Back.

To perform additional math operations, repeat this step.

4. To save the result in the current workbook, click Workbook and name the spectrum 
when prompted.

Note  A spectrum appears in the Result pane only if two or more spectra are in the 
Operands pane.

Note  To use the result in another Average operation, use Workbook or Temporary 
to add it to the list (see step 4), click Add to make it an operand, and continue with 
step 2.
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The data is added to the list and is available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate the data is not saved.

5. Click Close to close each displayed math window.

Related Topics

Math and Analysis Operations

Adding, Subtracting, Multiplying or Dividing Scan Data by a Factor

Use Factor in the Math menu to add a constant to the Y value of scan data, subtract a 
constant, multiply by a constant or divide by a constant.

 To use Factor

1. Choose Math (menu) > Factor.

The selected spectrum appears in the Operands pane.

The workbook spectra are listed at the left. To add others:

a. Click Browse.

b. Select a folder in the left pane (use the features above it to navigate), a workbook in 
the middle pane, and spectra in the upper-right pane. To select multiple spectra, hold 
down Shift or Ctrl. Selected spectra appear in the lower-right pane.

c. Click OK. Each added spectrum is listed with asterisks at the beginning of its name 
to indicate the data is not in the current workbook.

2. Select any other listed spectra to operate on and click Add.

To remove a spectrum from the Operands pane, click it and click Remove. To remove all 
the spectra, click Clear All.

3. Select the arithmetic operation to perform on the Y value of every data point.

4. Specify the factor: type a value, click the up and down arrow buttons, or drag the slider.
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5. To perform a math operation on the result, click Operate on Result and choose an 
operation. Otherwise, go to the next step.

Perform the operation as explained in the appropriate related topic below.

To return to the previous window, click Back.

To perform additional math operations, repeat this step.

6. To save the result in the current workbook, click Workbook and name the spectrum or 
spectra when prompted.

The data is added to the list and is available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate the data is not saved.

7. Click Close to close each displayed math window.

Related Topics

Math and Analysis Operations

Finding Peaks in Scan Data

Use Peak Pick in the Analyze menu to find peaks, valleys, zero crossings, or maximum and 
minimum values in a spectrum or region.

 To locate peaks

1. Choose Analyze (menu) > Peak Pick.

2. Set the parameters and adjust the data display as desired.

Note  To use the result in another Factor operation, use Workbook or Temporary to 
add it to the list (see step 6), click Add to make it an operand, and continue with step 
2.

Note  Peaks can be found automatically after data acquisition. See Measurement Tab for 
Scan.

Parameter Description

Find Specifies whether to find peaks, valleys, both peaks and 
valleys, or maximum and minimum Y values.

Max number of peaks (or 
valleys, or peaks and valleys)

Maximum number of items to find.
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To adjust the data display, use the view finder. To zoom in or move the spectrum, use the 
selection tool:

Sort peaks (or valleys, or 
peaks and valleys) by

Order for labeling and listing found items in the Peak 
Pick results table.

Sensitivity How readily small peaks or valleys are found. To 
optimize the sensitivity, select Auto. To set it manually, 
deselect Auto and drag the slider.

Wavelength Range Wavelength range in which to find items. To use the 
entire range, select Full. To limit the range, deselect Full 
and type the desired limits or use the region-threshold 
tool:

Use threshold Specifies whether to find only those peaks whose Y values 
are greater than or equal to a specified value, the 
threshold. (For % transmittance, the software finds 
valleys less than or equal to the threshold.) To optimize 
the threshold value, select Auto. To set it manually, 
deselect Auto and set Threshold by typing a value or 
dragging the horizontal line in the data display.

Smooth spectrum Specifies whether or not to smooth the data before 
finding peaks or valleys. This tends to reduce the number 
of small peaks, valleys and shoulders. (For more 
information, see About Smoothing.) The (blue) 
smoothed spectrum is overlaid on the original. To 
optimize the degree of smoothing, select Auto. To adjust 
it manually, deselect Auto and drag the slider.

Parameter Description
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The results appear in the data display pane and the table below it:

3. Click OK.

The found peaks have labels, and the peak results are listed at the right.

The settings are saved in the workbook and will be used for measuring samples with 
Result on the Peak Pick tab set to Peak Pick.

Related Topics

Math and Analysis Operations

Finding Value Level Crossings in Scan Data

Use Value Level Crossing in the Analyze menu to find the wavelengths where a spectrum 
crosses a specified ordinate value.

 To locate value level crossings

1. Choose Analyze (menu) > Value Level Crossing.

2. Set the parameters and adjust the data display as desired.

Peak Pick results table Peak label

Note  Crossings can be found automatically after data acquisition. See Measurement Tab 
for Scan.

Parameter Description

Level for crossing Specifies the ordinate (Y) value. One can also drag the horizontal 
line in the data display.

Sort crossings by Order for listing crossings in the value level crossings results table.
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To adjust the data display, use the view finder. To zoom in or move the spectrum, use the 
selection tool:

The results appear in the data display pane and the table below it:

3. Click OK.

The found crossings have labels, and the crossing results are listed at the right.

The settings are saved in the workbook and will be used for measuring samples with 
Result on the Peak Pick tab set to Value Level.

Wavelength Range Wavelength range in which to find crossings. To use the entire 
range, select Full. To limit the range, deselect Full and type the 
desired limits or use the region-threshold tool:

Sensitivity How readily small-amplitude crossings are detected. To optimize 
the sensitivity, select Auto. To set it manually, deselect Auto and 
drag the slider. A high sensitivity finds locations where the 
spectrum crosses the horizontal line only a short distance.

Parameter Description

Value level crossing results table Crossing label



 3 INSIGHT Software
Options

Thermo Scientific Evolution 200 Series Spectrophotometer User Guide 151

Related Topics

Math and Analysis Operations

Options

Applications Tab
Report Master Page Tab
Preferences Tab
Data Store Tab
Formulas and Units Tab

Applications Tab

 To add a new group

Enter the desired group name in the Groups box and click Add.

 To customize the current group

Drag the desired applications from the Applications list to the buttons at the right. To 
remove an application from the group, drag it from its button to the Applications list.

 To delete the current group

Click Delete Group and then click Yes when prompted.

 To reset the application buttons for the current group

Click Clear App Buttons and then click Yes when prompted.

 To make custom templates available for groups other than Classic

Drag the List of Templates application to one of the top nine menu buttons.

The following tabs are available in Options:

Click Options to display the Applications tab in the 
right pane. Use it to configure the home page by adding 
new user groups and giving them access to particular 
applications. The Group drop-down list box shows the 
name of the current group.
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Report Master Page Tab

Related Topics

Configuring a Report

Reports

Preferences Tab

Click Options to display the Report Master Page tab in 
the right pane. Use it to define the appearance of all 
printed reports.

Feature Description

Company name Enter a company name and press Enter. Select an orientation for the 
name, and use Font to specify the font.

Date Date of the report creation. Use Font to specify the font for Date and 
Time.

Time Time of the report creation. Use Font to specify the font for Time and 
Date.

Logo Select an orientation for the logo, and use Browse to locate and select a 
logo image file.

Footer text Text at the bottom of the report. Use Font to specify the font for the 
footer.

Page number Format for page numbers. Select None to not include page numbers.

Click Options to display the Preferences tab in the right 
pane.

Feature Description

Data Value Digits Specify the number of digits to the right of the decimal point to use 
for X and Y values for spectral data.

Triggering Starting data acquisition normally requires a response to a prompt 
(displayed by Measure or another action button). To start acquisition 
automatically a specified number of minutes after the prompt 
appears, select Enable auto input trigger and enter the number of 
minutes for the delay.

Use Output trigger to specify whether and when to produce a signal 
that triggers an installed accessory to begin an operation.
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Data Store Tab

Prevent removal of 
data

Prevents the removal of acquired data. When this option is selected, 
the following conditions are true:

• Remeasure right-click option in the sample measurements table 
is enabled (if available). After a remeasurement, the previous 
information for the sample is crossed out.

• Remove and Remove all (available for Scan applications only) 
are disabled.

• Sample IDs cannot be edited in the sample measurements table 
below the data display and on the Samples tab in Reports.

Directories The paths used for saving template files, Performance Verification 
reports, and workbooks. Type a path for each or click the button to 
specify a path.

Feature Description

Click Options to display the Data Store tab in the right 
pane. Use it to specify how to save workbooks, export 
data and e-mail results.

Feature Description

Workbook Save Options To be prompted to save data before acquiring it, select Data 
saved on each measure. Save Workbook and Save As Workbook 
will not be available in the File menu.

To save acquired data only by using Save Workbook or Save As 
Workbook, select Data saved only by Save Workbook in File 
menu. (A prompt to save appears when INSIGHT software is 
closed if the current workbook has not been saved.)

Convert Data Select Auto export data to automatically save acquired data 
using the selected format in the specified location. To change the 
location, type a new path or use Browse.

E-mail Select Auto e-mail result (workbook) to automatically e-mail 
the current workbook. Enter the desired recipient address, 
subject and message.
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Formulas and Units Tab

In the appropriate table, select in the Show column the items to be available.

To add an item, enter it (or the appropriate information) in the row that starts with a plus (+) 
sign.

To delete an item, right-click it and choose Delete Row. Items with a lock icon cannot be 
edited or deleted.

To return to the default selections, click Reset.

These formulas and units lists can be customized:

Related Topics

Settings for Quant Applications

Performing a Quantitative Analysis

System Settings

Alignment Tab
Calibrations Tab
Lamp Tab
System Tab
Diagnostics tab (for our use only)

Click Options to display the Formulas and Units tab in 
the right pane. Use it to specify the default formulas, 
units and advanced equations for setting up quantitative 
analyses.

Feature Description

Default formulas These formulas appear when you click Select on the 
Measurement tab in Quant Settings.

Default units These units appear in the Unit list box on the Measurement tab 
in Quant Settings.

Advanced user-defined 
calibration equations

These formulas appear when you click Build on the 
Measurement tab in Quant Settings.

These are available in System Settings:
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Alignment Tab 

 To perform an alignment

1. To measure intensities using a green light (510 nm), select Green. To use no filter, select 
White.

The correct setting depends on the installed accessory. For more information,  refer to the 
user guide for the accessory or search for “Evolution 200 Series Accessories” in the 
INSIGHT Help system.

2. Set Bandwidth as desired.

The available settings depend on the instrument.

3. Click Start.

Every half second the sample and reference detector intensities are plotted and displayed 
by the Sample beam and Reference readouts.

To overlay the plots instead of stacking them, deselect Stack.

The Time readout shows the elapsed time. Intensities can be measured and plotted for up 
to 15 minutes without restarting the process.

Click System Settings to display the Alignment tab in 
the right pane. Use it to view sample and reference 
detector intensities while aligning an accessory.

Note  If the instrument has variable slit wheels, the start of intensity measurement is 
delayed while they move to their 2 nm position.
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If the plot of sample detector intensity is not at the desired position for viewing, adjust 
the detector gain by dragging the Gain slider up or down.

To adjust the display, use the view finder. To zoom in, draw a box and click inside it. To 
return to full display, double-click the pane.

4. Align the accessory to achieve the desired sample detector intensity. For more 
information,  refer to the user guide for the accessory or search for “Evolution 200 Series 
Accessories” in the INSIGHT Help system.

5. When finished, click Stop.

Related Topics

System Settings

Calibrations Tab

To calibrate using a particular lamp, click its Calibrate button and follow the instructions that 
appear. See Mercury Lamp for instructions for using a mercury lamp safely.

Related Topics

System Settings

Lamp Tab

Related Topics

System Settings

System Tab

Click System Settings to display the Calibrations tab in 
the right pane. Use it to calibrate the instrument 
wavelength or accessories.

Click System Settings to display the Lamp tab in the 
right pane. Use it to display status information about 
the xenon lamp.

Click System Settings to display the System tab in the 
right pane. Use it to switch the instrument between 
local and computer control and to update firmware.
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Related Topics

System Settings

Keyboard Shortcuts
These are available in INSIGHT software:

Feature Description

Instrument Control Switches instrument control between the Local Control option and 
INSIGHT software running on an external computer. Select the 
desired setting and respond appropriately to the message that appears.

Firmware Update Click Load Update to install the selected instrument firmware. 
Follow the instructions that appear.

Instrument Boot 
Record

Click Display to view the instrument’s power-up boot record, which 
can be saved or copied.

Keyboard Shortcut Description

Alt+F4 Exits INSIGHT software.

Ctrl+F (from Home) Displays Fixed.

Ctrl+Q (from Home) Displays Quant.

Ctrl+R (from Home) Displays Rate.

F1 Displays Help.

F2 Displays Home.

F4 Displays the Measure screen for the current application.

F5 Acquires zero or baseline data.

F6 Chooses the Measure button.

F7 Prints the Measure screen.

F8 Prints the report.

F9 Displays My Data.

F10 Creates a new workbook.

F11 (from Home) Displays Performance Verification.

F12 Chooses the Stop button.
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4

INSIGHT Bio Applications 

About the Bio Applications
The Bio applications provide methods for measuring biological macromolecules including 
nucleic acids and proteins. The application type, settings and report layout for each Bio 
application are pre-configured but customizable. If you customize one of these applications, 
you can save the current settings as the default settings or save them in a workbook.

Nucleic Acid Assays

The nucleic acid assay methods include:

• Nucleic Acid

• Nucleic Acid Labels

• DNA Melting

Contents

• About the Bio Applications

• Nucleic Acid

• Nucleic Acid Labels

• DNA Melting

• Protein A280

• Proteins and Labels

• Pierce BCA

• Protein Bradford

• Pierce Modified Lowry

• Pierce 660 nm Protein Assay

• Protein Biuret
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Below are the default values for the nucleic acid methods. Wavelengths are in nanometers.

Protein Assays

There are two types of protein assay methods included, direct UV and colorimetric assays. 
The colorimetric assays include several assays that are similar. Likewise, the direct protein 
methods are also very similar. Use the table below to find the appropriate assay procedure. 
Click the links to access complete information about the assays.

Below are the default values for the protein methods. Wavelengths are in nanometers.

Method
Analytical 
Wavelength 
(Quant)

Reference 
Wavelength

Start 
(Scan)

Stop 
(Scan)

Bandwidth 
(nm)

Integration 
Time (sec) 
(Fixed, Scan)

Data 
Interval 
(Scan)

Scan 
Speed 
(nm/min)

Nucleic Acid 260 340 220 350 1.0 1.0, 0.08 0.50 375

Nucleic Acid 
Labels

260 340 220 850 1.0 1.0, 0.16 1.00 375

DNA Melting 260 340 n/a n/a 1.0 1.0 n/a n/a

Direct UV Assays Colorimetric Assays

Protein A280 Protein A280

Proteins and Labels Protein Bradford

Pierce BCA

Pierce Modified Lowry

Pierce 660 nm Protein Assay

Protein Biuret

Method
Analytical 
Wavelength 
(Quant)

Reference 
Wavelength

Start 
(Scan)

Stop 
(Scan) Bandwidth

Integration 
Time (sec) 
(Fixed, Scan)

Data 
Interval 
(Scan)

Scan 
Speed 
(nm/min)

Protein A280 340 220 850 1.0 1.0, 0.08 0.5 375

Proteins & Labels 340 220 850 1.0 1.0, 0.16 1.0 375

Pierce BCA 562 340 750 450 1.0 1.0, 0.12 1.00 500

Protein Bradford 595 340 750 450 1.0 1.0, 0.12 1.00 500

Pierce Modified 
Lowry

750 405 900 600 1.0 1.5, 0.12 1.00 500

Pierce 660 nm 
Protein Assay

660 340 850 550 1.0 1.5, 0.12 1.00 500

Protein Biuret 550 340 750 450 1.0 1.0, 0.12 1.00 500
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Nucleic Acid

Overview

See Unique Screen Features for information about the results the application calculates. See 
Nucleic Acid Concentration Calculations for information about the calculations.

Related Topics

Nucleic Acid Concentration Calculations

Application Settings

Data Display

Unique Screen Features

Making Nucleic Acid Measurements

Oligo Calculator

Nucleic Acid Concentration Calculations

The Nucleic Acid application is used for determining the concentration and purity of nucleic 
acid samples. The nucleic acid concentration is determined by multiplying the absorbance at 
260 nm by a factor (default, 50). This factor is essentially the extinction coefficient in units of 
ng-cm/ml. Using this coefficient gives the manipulated equation

Contents

• Overview

• Nucleic Acid Concentration Calculations

• Application Settings

• Unique Screen Features

• Making Nucleic Acid Measurements

• Oligo Calculator

Use the Nucleic Acid application to measure nucleic acid 
samples for concentration and purity.

)/ *(A = c 



4 INSIGHT Bio Applications
Nucleic Acid

162 Evolution 200 Series Spectrophotometer User Guide Thermo Scientific

where c is the nucleic acid concentration in ng/microliter, A is the absorbance in AU,  is the 
wavelength-dependent extinction coefficient in ng-cm/microliter, and  is the pathlength in 
centimeters. 

The generally accepted extinction coefficients for nucleic acids are:

Related Topics

Overview

Application Settings

Data Display

Unique Screen Features

Making Nucleic Acid Measurements

Oligo Calculator

Nucleic Acid Purity Measurements

The 260/280 nm ratio assay determines the purity of nucleic acids based on the 260/280 
ratio.

The 260/230 ratio assay determines the purity of nucleic acids in the presence of phenol, 
which absorbs strongly at 230 nm.

A ratio of approximately 1.8 is generally accepted as “pure” for DNA, approximately 2.0 for 
RNA. If either ratio is appreciably lower, protein, phenol or other contaminants that absorb 
strongly near 280 nm may be present.

The 260/230 values for a “pure” nucleic acid are often higher than the respective 260/280 
values and are commonly in the range 1.8 to 2.2. If the ratio is appreciably lower, co-purified 
contaminants may be present.

Application Settings

Coefficient Value

Double-stranded DNA 50 ng-cm/?l

Single-stranded DNA 33 ng-cm/?l

RNA 40 ng-cm/?l

To set data acquisition parameters for a Nucleic Acid 
workbook, click Settings.
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The follow tabs of settings are available:
Type Tab for Nucleic Acid
Measurement Tab for Nucleic Acid
Instrument Tab for Nucleic Acid
Accessories Tab for Nucleic Acid
Samples Tab for Nucleic Acid

Related Topics

Overview

Nucleic Acid Concentration Calculations

Data Display

Unique Screen Features

Making Nucleic Acid Measurements

Oligo Calculator

Type Tab for Nucleic Acid

These settings are available:

Related Topics

Measurement Tab for Nucleic Acid

Click Settings in Nucleic Acid to display the Type tab in 
the right pane.

Feature Description

Name Application name.

Description (optional) Description of the template.

Nucleic Acid Type Type of analysis to perform.

ssDNA is for single-stranded DNA.

Oligo DNA and Oligo RNA use the appropriate extinction 
coefficient based on entered DNA or RNA base sequence. The 
entry will appear on the Oligo Calculator tab.

For Custom, enter a factor (extinction coefficient) by which to 
multiply the measured absorbance. The factor used for other types 
cannot be changed.

Pathlength Distance the light travels through the sample.
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Instrument Tab for Nucleic Acid

Accessories Tab for Nucleic Acid

Samples Tab for Nucleic Acid

Measurement Tab for Nucleic Acid

These settings are available:

Click Settings in Nucleic Acid to display the 
Measurement tab in the right pane.

Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

• Single point. Enter a wavelength value to define the endpoint for 
the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the specified 
baseline point and calculating the absorbance value on the drawn 
baseline at the specified analytical wavelength. The software 
subtracts the calculated baseline absorbance value from the 
measured absorbance value and reports the corrected absorbance

• Sloping baseline. Enter two wavelength values to define the 
endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value from 
the measured absorbance value and reports the corrected 
absorbance.

• None. Uses uncorrected data. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, 
the calculated protein concentration may be higher than the true 
value.

Component name Component to quantify.
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Related Topics

Type Tab for Nucleic Acid

Instrument Tab for Nucleic Acid

Accessories Tab for Nucleic Acid

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

 To add one or more predefined formulas

1. Click Select.

2. For each desired formula, select it in the list and click Add.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click Close.

 To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available units depend on the Formulas & Units tab settings.

Feature Description
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Samples Tab for Nucleic Acid

Instrument Tab for Nucleic Acid

These settings are available:

Related Topics

Type Tab for Nucleic Acid

Measurement Tab for Nucleic Acid

Accessories Tab for Nucleic Acid

Samples Tab for Nucleic Acid

Click Settings in Nucleic Acid to display the Instrument 
tab in the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Accessories Tab for Nucleic Acid

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Related Topics

Type Tab for Nucleic Acid

Measurement Tab for Nucleic Acid

Instrument Tab for Nucleic Acid

Samples Tab for Nucleic Acid

Samples Tab for Nucleic Acid

These settings are available:

Click Settings in Nucleic Acid to display the Accessories 
tab in the right pane. The available parameters depend 
on the installed accessories. For more information,  refer 
to the user guide for the accessory or search for 
“Evolution 200 Series Accessories” in the INSIGHT 
Help system.

Click Settings in Nucleic Acid to display the Samples 
tab in the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use sample 
correction factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table.
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Related Topics

Type Tab for Nucleic Acid

Measurement Tab for Nucleic Acid

Instrument Tab for Nucleic Acid

Accessories Tab for Nucleic Acid

Unique Screen Features

Use control limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table.

Save Samples Saves the contents of the samples table in a .tsv (tab separated values) 
file or .csv (comma separated values) file in a specified location.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Feature Description

The right pane in Measure Nucleic Acid displays 
workbook parameters specific to the application. Task 
buttons in the left pane are described in Task Buttons.
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The spectral display shows data for the current sample. 

These features are to the right of the spectral display:

Feature Description

Type Type of analysis to perform. To the right is the factor value from the 
Type tab.

Conc. Concentration determined by multiplying the absorbance at 260 nm 
by a factor (default, 50) after correction is applied. Beer’s law is used to 
calculate the nucleic acid concentration (see Nucleic Acid 
Concentration Calculations).

A260 Absorbance at 260 nm.

A280 Absorbance at 280 nm.
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These features are to the left of the spectral display:

Advanced calculations

For selecting predefined formulas for additional data processing, with the results appearing in 
a calculations table at the bottom of the right pane. Options include basic math and statistics. 
The formulas can be applied to specific samples and columns of data in the sample 
measurements table or to selected rows and columns in the calculations table for the current 
workbook or template. Calculations are applied to all subsequently acquired data. Custom 
calculations are saved with the workbook or template. Available for all applications except 
Rate.

To delete the contents of a cell in the calculations table, right-click the cell and choose Delete.

 To add column and row headings to the calculations table

1. Double-click a cell that needs a heading or other label.

2. In the Cell Properties box, choose Text.

3. Type the heading or label text.

4. To select the background color for the text displayed in the calculations table, click 
Background, choose a color and click OK.

5. To display the cell contents in bold text, click Bold Text.

6. Click OK.

 To define calculations based on the samples table

1. In the calculations table, double-click the cell where you want the calculation result to 
appear.

2. In the Cell Properties box, choose Calculation.

3. Select an Equation in the list.

The available equations are fixed.

260/280 Ratio of sample absorbance at 260 nm and 280 nm, used to assess the 
purity of DNA and RNA. A ratio of about 1.8 is generally accepted as 
“pure” for DNA, about 2.0 for RNA. If either ratio is appreciably 
lower, protein, phenol or other contaminants that absorb strongly 
near 280 nm may be present. See Nucleic Acid Purity Measurements 
for more information.

260/230 Ratio of absorbance at 260 nm and 230 nm, a secondary measure of 
nucleic acid purity.

Feature Description
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4. Set Source to Samples table.

5. Select a sample measurement in the Measurements list.

6. Specify the sample rows to include by entering their ID numbers in the Range/Reference 
box.

Use a colon to specify a range (e.g., 2:5 or 1:N) or commas for individual samples (e.g., 
1,3,5).

7. To select the background color for the cell that displays the calculated result, click 
Background, choose a color and click OK.

8. To display the cell contents in bold text, click Bold Text.

9. Choose OK.

The calculated result appears in the selected cell.

 To define a calculation based on the calculations table

1. In the calculations table, double-click the cell where you want the calculation result to 
appear.

2. In the Cell Properties box, choose Calculation.

3. Select an Equation in the list.

4. Set Source to Calculations Table.

5. Specify the table cells to include by entering their IDs in the Range/Reference box.

If Equation is set to Std. Deviation, Mean, or %RSD, use a colon to specify a range (e.g., 
A2:A5 or A1:AN) or commas for individual cells (e.g., A1,A3,A5).

If Equation is set to Addition, Subtraction, Multiplication, or Division, specify one cell 
location in each Reference box. (e.g., A1).

If Equation is set to a Factor, use the first (Reference) box to specify a cell location and 
the second (Factor) box to enter the factor.

6. To select the background color for the cell that displays the calculated result, click 
Background, choose a color and click OK.

7. To display the cell contents in bold text, click Bold Text.

8. Choose OK.

The calculated result appears in the selected cell.

Related Topics

Overview

Nucleic Acid Concentration Calculations



4 INSIGHT Bio Applications
Nucleic Acid

172 Evolution 200 Series Spectrophotometer User Guide Thermo Scientific

Application Settings

Making Nucleic Acid Measurements

Oligo Calculator

Data Display

Making Nucleic Acid Measurements

While performing this procedure, click here for information about features to the right of the 
spectral display.

 To measure nucleic acids

1. Click Measure Nucleic Acid in Nucleic Acid.

2. Click Measure.

3. Follow the instructions that appear.

Use the appropriate buffer for the blank, generally the same buffer used to prepare or 
dissolve the sample. The buffer should be the same pH and of a similar ionic strength as 
the sample solution.

4. When samples information appears, modify it if desired.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

5. If only one sample will be measured, insert it.

6. Click Continue.

7. Follow any instructions that appear, such as to install a specified sample.

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.
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The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:

To copy this plot, right-click it and choose Copy to Clipboard.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation. See Data Display for more information.)

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

Related Topics

Overview

Nucleic Acid Concentration Calculations

Application Settings

Data Display

Unique Screen Features

Oligo Calculator
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Oligo Calculator

 To use Oligo Calculator 

1. Enter a base sequence on the Oligo Calculator tab.

More:

Use:

• The buttons below the Base Sequence box.

• The A, C, G, T and U keys on the keyboard.

• Copy and paste a base sequence (A, C, G, T and U only) from another application.

To clear the sequence, click Clear. Individual bases can be deleted only manually.

2. Select the nucleic acid type to analyze.

3. Select the degree of phosphorylation if applicable: mono-phosphate for DNA; mono- or 
tri-phosphate for RNA.

4. Select Double-stranded if applicable. The complementary base sequence will be 
included in the analysis.

5. Enter the molecular weights of any additions to the base sequence in the Modification 
box.

The calculated results appear:

Use Oligo Calculator to calculate molecular weight, 
extinction coefficients, concentration factors and 
melting points for specific nucleic acid sequences. 
Clicking this task button displays:

Tab Description

Oligo Calculator For entering sequences of interest and selecting appropriate sample type 
variables.

Melting Displays the calculated melting points of a DNA strand. Available only 
for DNA sequences.

Result Description

Molecular weight Calculated base sequence molecular weight.

Molar extinction 
coefficient

Calculated 260 nm extinction coefficient in ng-cm/microliter.

Concentration factor Factor, based on the extinction coefficient, used to calculate the 
concentration of the base sequence.
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 To calculate the melting point of a DNA sequence

1. Enter the base sequence on the Oligo Calculator tab.

2. Enter appropriate values on the Melting tab:

The calculated results appear:

Related Topics

Overview

Nucleic Acid Concentration Calculations

Application Settings

Data Display

Unique Screen Features

Making Nucleic Acid Measurements

Nucleic Acid Labels

Number of bases Number of bases in the entered sequence.

% GC Percentage of the total number of bases made up by guanine 
and cytosine.

Parameter Description

Oligo molarity Concentration of the Oligo in molar units.

Cation molarity Concentration of cations in the sample.

% Formamide Percentage concentration of formamide in the sample.

Result Description

Salt-adjusted Calculated melting point of the base sequence, corrected for the 
concentration of cation in the sample. This method does not 
account for the effect of interaction between neighboring bases.

Nearest-neighbor Melting point of the base sequence when the effect of interaction 
between neighboring bases is taken into account.

Result Description

Contents
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Overview

Related Topics

Dye/Chromophore Editor

Application Settings

Data Display

Unique Screen Features

Making Nucleic Acid Labels Measurements

Oligo Calculator

Dye/Chromophore Editor

To enter a new dye, type its information in the appropriate cells of the bottom row of the table 
and select a unit. Refer to the dye manufacturer for appropriate correction factors. The 
260 nm corrections will be used for nucleic acid sample concentration calculations. Entered 
information is saved automatically.

To delete a user-defined dye, right-click its row and choose Delete Row. Predefined dyes, 
identified by the lock icon, cannot be edited or deleted.

• Overview

• Dye/Chromophore Editor

• Application Settings

• Unique Screen Features

• Making Nucleic Acid Labels Measurements

• Oligo Calculator

Use the Nucleic Acid Labels application to measure 
nucleic acid samples for concentration and purity.

Use the Dye Chromophore Editor to select predefined 
dyes, modify existing dyes for protocols, or enter new 
dyes.
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Related Topics

Overview

Application Settings

Data Display

Unique Screen Features

Making Nucleic Acid Labels Measurements

Oligo Calculator

Application Settings

The follow tabs of settings are available:
Type Tab for Nucleic Acid Labels
Measurement Tab for Nucleic Acid Labels
Instrument Tab for Nucleic Acid Labels
Accessories Tab for Nucleic Acid Labels
Samples Tab for Nucleic Acid Labels

Related Topics

Overview

Dye/Chromophore Editor

Data Display

Unique Screen Features

Making Nucleic Acid Labels Measurements

Oligo Calculator

Type Tab for Nucleic Acid Labels

To set data acquisition parameters for a Nucleic Acid 
Labels workbook, click Settings.

Click Settings in Nucleic Acid Labels to display the Type 
tab in the right pane.
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These settings are available:

Related Topics

Measurement Tab for Nucleic Acid Labels

Instrument Tab for Nucleic Acid Labels

Accessories Tab for Nucleic Acid Labels

Samples Tab for Nucleic Acid Labels

Measurement Tab for Nucleic Acid Labels

Feature Description

Name Application name.

Description (optional) Description of the template.

Nucleic Acid Type Type of analysis to perform.

ssDNA is for single-stranded DNA.

Oligo DNA and Oligo RNA use the appropriate extinction 
coefficient based on the entered DNA or RNA base sequence. The 
entry will appear on the Oligo Calculator tab.

For Custom, enter a factor (extinction coefficient) by which to 
multiply the measured absorbance. The factor used for other types 
cannot be changed.

Set Dye 1 and Dye 2 to the fluorescent dyes whose absorbance will 
be used in concentration correction calculations.

Pathlength Distance the light travels through the sample.

Click Settings in Nucleic Acid Labels to display the 
Measurement tab in the right pane.
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These settings are available:

Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

• Single point. Enter a wavelength value to define the endpoint for 
the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the specified 
baseline point and calculating the absorbance value on the drawn 
baseline at the specified analytical wavelength. The software 
subtracts the calculated baseline absorbance value from the 
measured absorbance value and reports the corrected absorbance

• Sloping baseline. Enter two wavelength values to define the 
endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value from 
the measured absorbance value and reports the corrected 
absorbance.

• None. Uses uncorrected data. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, 
the calculated protein concentration may be higher than the true 
value.

Component name Component to quantify.
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Related Topics

Type Tab for Nucleic Acid Labels

Instrument Tab for Nucleic Acid Labels

Accessories Tab for Nucleic Acid Labels

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

 To add one or more predefined formulas

1. Click Select.

2. For each desired formula, select it in the list and click Add.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click Close.

 To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available units depend on the Formulas & Units tab settings.

Feature Description
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Samples Tab for Nucleic Acid Labels

Instrument Tab for Nucleic Acid Labels

These settings are available:

Related Topics

Type Tab for Nucleic Acid Labels

Measurement Tab for Nucleic Acid Labels

Accessories Tab for Nucleic Acid Labels

Samples Tab for Nucleic Acid Labels

Click Settings in Nucleic Acid Labels to display the 
Instrument tab in the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Accessories Tab for Nucleic Acid Labels

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Related Topics

Type Tab for Nucleic Acid Labels

Measurement Tab for Nucleic Acid Labels

Instrument Tab for Nucleic Acid Labels

Samples Tab for Nucleic Acid Labels

Samples Tab for Nucleic Acid Labels

These settings are available:

Click Settings in Nucleic Acid Labels to display the 
Accessories tab in the right pane. The available 
parameters depend on the installed accessories. For more 
information,  refer to the user guide for the accessory or 
search for “Evolution 200 Series Accessories” in the 
INSIGHT Help system.

Click Settings in Nucleic Acid Labels to display the 
Samples tab in the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use sample 
correction factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table.

Use control limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.
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Related Topics

Type Tab for Nucleic Acid Labels

Measurement Tab for Nucleic Acid Labels

Instrument Tab for Nucleic Acid Labels

Accessories Tab for Nucleic Acid Labels

Unique Screen Features

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table.

Save Samples Saves the contents of the samples table in a .tsv (tab separated values) 
file or .csv (comma separated values) file in a specified location.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Feature Description

The right pane in Measure Nucleic Acid Labels 
includes: 

Feature Description

Type Type of analysis to perform. To the right is the factor value from the 
Type tab.

Conc. Concentration based on absorbance at 260 nm, the default or 
user-defined extinction coefficient, and the specified pathlength. (The 
extinction coefficient is reported for a 10 mm pathlength.) Beer’s law 
is used to calculate the nucleic acid concentration (see Nucleic Acid 
Concentration Calculations).

The displayed A260 value is baseline corrected. The A260 value 
actually used to calculate the concentration takes into account the 
appropriate dye correction factors and any absorbance correction due 
to the selected analysis correction wavelength.
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These features are to the left of the spectral display:

Advanced calculations

For selecting predefined formulas for additional data processing, with the results appearing in 
a calculations table at the bottom of the right pane. Options include basic math and statistics. 
The formulas can be applied to specific samples and columns of data in the sample 
measurements table or to selected rows and columns in the calculations table for the current 
workbook or template. Calculations are applied to all subsequently acquired data. Custom 
calculations are saved with the workbook or template. Available for all applications except 
Rate.

To delete the contents of a cell in the calculations table, right-click the cell and choose Delete.

 To add column and row headings to the calculations table

1. Double-click a cell that needs a heading or other label.

2. In the Cell Properties box, choose Text.

3. Type the heading or label text.

4. To select the background color for the text displayed in the calculations table, click 
Background, choose a color and click OK.

5. To display the cell contents in bold text, click Bold Text.

6. Click OK.

 To define calculations based on the samples table

1. In the calculations table, double-click the cell where you want the calculation result to 
appear.

A260 Absorbance at 260 nm.

260/280 Ratio of sample absorbance at 260 nm and 280 nm, used to assess the 
purity of DNA and RNA. A ratio of ~1.8 is generally accepted as 
“pure” for DNA, ~2.0 for RNA. If either ratio is appreciably lower, 
protein, phenol or other contaminants that absorb strongly near 
280 nm may be present. See Nucleic Acid Purity Measurements for 
more information.

Dye(s) Conc. Concentration of the user-selected dye(s).

The software automatically subtracts the value of a sloping baseline 
from 400 to 750 nm from the absorbance at the Dye wavelength. 
Only the corrected absorbance of the dye peak(s) and dye 
concentration(s) are reported.

Feature Description
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2. In the Cell Properties box, choose Calculation.

3. Select an Equation in the list.

The available equations are fixed.

4. Set Source to Samples table.

5. Select a sample measurement in the Measurements list.

6. Specify the sample rows to include by entering their ID numbers in the Range/Reference 
box.

Use a colon to specify a range (e.g., 2:5 or 1:N) or commas for individual samples (e.g., 
1,3,5).

7. To select the background color for the cell that displays the calculated result, click 
Background, choose a color and click OK.

8. To display the cell contents in bold text, click Bold Text.

9. Choose OK.

The calculated result appears in the selected cell.

 To define a calculation based on the calculations table

1. In the calculations table, double-click the cell where you want the calculation result to 
appear.

2. In the Cell Properties box, choose Calculation.

3. Select an Equation in the list.

4. Set Source to Calculations Table.

5. Specify the table cells to include by entering their IDs in the Range/Reference box.

If Equation is set to Std. Deviation, Mean, or %RSD, use a colon to specify a range (e.g., 
A2:A5 or A1:AN) or commas for individual cells (e.g., A1,A3,A5).

If Equation is set to Addition, Subtraction, Multiplication, or Division, specify one cell 
location in each Reference box. (e.g., A1).

If Equation is set to a Factor, use the first (Reference) box to specify a cell location and 
the second (Factor) box to enter the factor.

6. To select the background color for the cell that displays the calculated result, click 
Background, choose a color and click OK.

7. To display the cell contents in bold text, click Bold Text.

8. Choose OK.

The calculated result appears in the selected cell.
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Related Topics

Overview

Dye/Chromophore Editor

Application Settings

Data Display

Making Nucleic Acid Labels Measurements

Oligo Calculator

Making Nucleic Acid Labels Measurements

While performing this procedure, click here for information about features to the right of the 
spectral display.

 To make a Nucleic Acid Labels measurement

1. Click Measure Nucleic Acid Labels in Nucleic Acid Labels.

2. Click Measure.

3. Follow the instructions that appear.

Use the appropriate buffer for the blank, generally the same buffer used to prepare or 
dissolve the sample. The buffer should be the same pH and of a similar ionic strength as 
the sample solution.

4. When samples information appears, modify it if desired.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.
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5. If only one sample will be measured, insert it.

6. Click Continue.

7. Follow any instructions that appear, such as to install a specified sample.

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:

To copy this plot, right-click it and choose Copy to Clipboard.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation. See Data Display for more information.)

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

Related Topics

Overview

Dye/Chromophore Editor

Application Settings

Data Display

Note  Use a fresh aliquot of sample for each measurement.
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Unique Screen Features

Oligo Calculator

After the Measurement

• When using the cuvette option, remove the cuvette, rinse thoroughly and dry between 
samples.

Oligo Calculator

 To use Oligo Calculator 

1. Enter a base sequence on the Oligo Calculator tab.

More:

Use:

• The buttons below the Base Sequence box.

• The A, C, G, T and U keys on the keyboard.

• Copy and paste a base sequence (A, C, G, T and U only) from another application.

To clear the sequence, click Clear. Individual bases can be deleted only manually.

2. Select the nucleic acid type to analyze.

3. Select the degree of phosphorylation if applicable: mono-phosphate for DNA; mono- or 
tri-phosphate for RNA.

4. Select Double-stranded if applicable. The complementary base sequence will be 
included in the analysis.

5. Enter the molecular weights of any additions to the base sequence in the Modification 
box.

Use Oligo Calculator to calculate molecular weight, 
extinction coefficients, concentration factors and 
melting points for specific nucleic acid sequences. 
Clicking this task button displays:

Tab Description

Oligo Calculator For entering sequences of interest and selecting appropriate sample type 
variables.

Melting Displays the calculated melting points of a DNA strand. Available only 
for DNA sequences.
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The calculated results appear:

 To calculate the melting point of a DNA sequence

1. Enter the base sequence on the Oligo Calculator tab.

2. Enter appropriate values on the Melting tab:

The calculated results appear:

Related Topics

Overview

Dye/Chromophore Editor

Application Settings

Data Display

Unique Screen Features

Making Nucleic Acid Labels Measurements

Result Description

Molecular weight Calculated base sequence molecular weight.

Molar extinction 
coefficient

Calculated 260 nm extinction coefficient in ng-cm/microliter.

Concentration factor Factor, based on the extinction coefficient, used to calculate the 
concentration of the base sequence.

Number of bases Number of bases in the entered sequence.

% GC Percentage of the total number of bases made up by guanine 
and cytosine.

Parameter Description

Oligo molarity Concentration of the Oligo in molar units.

Cation molarity Concentration of cations in the sample.

% Formamide Percentage concentration of formamide in the sample.

Result Description

Salt-adjusted Calculated melting point of the base sequence, corrected for the 
concentration of cation in the sample. This method does not 
account for the effect of interaction between neighboring bases.

Nearest-neighbor Melting point of the base sequence when the effect of interaction 
between neighboring bases is taken into account.
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DNA Melting

Overview

As the temperature is increased, the electronic interactions between the DNA bases are 
modified and the entire absorption spectrum increases in intensity. This phenomenon is 
called the hyperchromic effect and the increase in absorption due to the abrupt change in 
structure is usually around 30–40%.

See Unique Screen Features for information about the DNA Melting data acquisition results. 
For information about the calculations, see DNA Melting Point Calculations.

DNA Melting Point Calculations

The melting of DNA occurs over a narrow temperature range. The midpoint of this transition 
is called the melting temperature or Tm. The melting temperature depends strongly on the 
percentage of the stronger hydrogen bonding G-C (guanine-cytosine) base pairs present in the 
DNA sequence. The Tm value for a particular DNA molecule will be reproducible as long as 
the pH, ionic strength, and buffer conditions do not change. Subtle changes to any of these 
solution conditions can alter the Tm value.

The Tm value of a DNA molecule can be calculated three ways:

• Horizontal Intercept. Useful when absorbance does not vary with temperature outside 
the melting range. Requires two temperature values (t1 and t3).

T1 is a stable temperature value in °C that occurs below the temperature range in which 
the DNA melting point occurs. A1 is the absorbance at T1.

T3 is a stable temperature value in °C that occurs above the DNA melting range. A3 is the 
absorbance at T3.

Am is a calculated absorbance that is midway between A1 and A3.

Contents

• Overview

• DNA Melting Point Calculations

• Application Settings

• Unique Screen Features

• Making DNA Melting Measurements

Use the DNA Melting application to determine the 
temperature at which a DNA sample denatures based on 
the change in absorbance as the temperature is increased.
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Tm is the temperature at Am.

• Sloping Intercept. Used when the absorbance varies with temperature inside and outside 
the melting range. Requires three temperature values (t1, t2 and t3).

T1 is a temperature value in °C that occurs below the temperature range in which the 
DNA melting point occurs. 

T3 is a temperature value in °C that occurs above the DNA melting range.

T2 is an intermediate temperature value in °C.

The software constructs a best fit line between the point at T2 and the point at the other 
temperature that is closest to it. A second line is drawn through the third point and 
parallel with the first line. Am (the absorbance at Tm) is midway between the points where 
the two parallel lines intercept the Y-axis.

A third line parallel to the others is drawn from Am to the Absorbance vs Temperature 
curve, and a perpendicular line is dropped from that intersection to the X-axis. Tm is the 
temperature at which the perpendicular line intercepts the X-axis.

• Inflection. Calculates the first derivative of the Absorbance vs Temperature curve. Tm is 
the temperature at which the first derivative curve has its maximum value (i.e., the slope). 
Requires two temperature values (t1 and t3), which define the range over which to 
perform the fit.
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Related Topics

Overview

Application Settings

Unique Screen Features

Making DNA Melting Measurements

Application Settings

The follow tabs of settings are available:
Type Tab for DNA Melting
Measurement Tab for DNA Melting
Instrument Tab for DNA Melting
Accessories Tab for DNA Melting
Samples Tab for DNA Melting
Tm Calculations Tab for DNA Melting

Related Topics

Overview

DNA Melting Point Calculations

Unique Screen Features

Making DNA Melting Measurements

Type Tab for DNA Melting

These settings are available:

To set data acquisition parameters for a DNA Melting 
workbook, click Settings.

Click Settings in DNA Melting to display the Type tab 
in the right pane.

Feature Description

Name (if 
present)

User group name followed by the name of the template of settings (entered 
when the template was saved using Save Workbook Settings as Template in 
the File menu).

Description Description of the template.
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Related Topics

Overview

DNA Melting Point Calculations

Unique Screen Features

Making DNA Melting Measurements

Measurement Tab for DNA Melting

Rate Type Type of rate measurement to perform (see the table below). An image 
representing the selected type appears to the right. The required tabs also 
appear (click the Reset action button to step through them). These options 
are available:

• Single wavelength. For each sample, measures a specified wavelength at 
specified intervals of time.

• Multiple wavelengths. For each sample, measures multiple specified 
wavelengths at specified intervals of time. Up to 40 wavelengths can be 
specified.

Mode Temperature is the only available option for the DNA Melting application. It 
performs rate measurements based on elapsed time and also records 
temperature settings.

Feature Description

Click Settings in DNA Melting to display the 
Measurement tab in the right pane.
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These settings are available:

Feature Description

Integration time How long the system acquires and averages data to obtain each data 
point at each measured wavelength for single and multicell 
experiments.

Dwell time How long the sample remains in the light beam. Available for single 
and multicell experiments.

Use this setting to vary the number of data points collected per cell 
per cycle. Dwell time is always a multiple of integration time (see 
above). Dwell time can be very useful when performing multicell 
rate measurements. This is because the cell changer accessory will 
position a cell in the light beam for a specified period of time (dwell 
time), rather than moving back and forth between cells and 
increasing the time between measurements (when no sample is in 
the light beam).

For example, if the integration time is 0.1 second and dwell time is 
0.5 second, five data points will be recorded for each cell before the 
cell changer moves to the next cell. For fairly fast reactions, multiple 
samples can be measured, with over ten times as many data points 
acquired within a short time. This can improve the accuracy of rate 
calculations for faster multicell rate measurements.

Number of stages Defines the number of measurement cycles over which the frequency 
of data acquisition can be determined. For example, if a reaction has 
two components, the first component could be fast and require a 
high data density. The second component could be much slower and 
longer lived, therefore requiring a lower data density. Defining 
multiple stages enables the use of the proper data density over a 
given period of time.

Temp unit Determines the temperature unit used in the stages table (see below).
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Related Topics

Overview

DNA Melting Point Calculations

Unique Screen Features

Making DNA Melting Measurements

Instrument Tab for DNA Melting

Time unit Determines the time unit used in the stages table (see below).

Stages table Defines data acquisition for each stage of an experiment including 
the target temperature, ramp rate, hold type, hold time, interval and 
whether data collection will occur.

Note that the temperature in the final stage can be set to a value 
around 10 °C to simulate storage in a refrigerator. This feature 
allows proper storage conditions for the sample if DNA melting 
experiments will be completed when the instrument is unattended.

Target Temp. Enter a target temperature between 0.00 °C (32.00 °F 
or 273.15 °K) and 110.00 °C (230.00 °F or 383.15 °K).

Ramp Rate. Enter a ramp rate from 0.40 to 20.00 °C/min 
(0.72 to 36.00 °F/min or 0.40 to 20.00 °K/min) up or down.

Hold Type. Specify a pause at the target temperature before 
continuing to the next stage. Time holds for a specified time (see 
Hold Time below). Prompt holds until the operator responds to a 
message in the software. Trigger waits for an external trigger. 
Choosing Start in the trigger prompt will override the trigger.

Hold Time. When Hold Type is set to Time, enter the length of 
time to hold at the target temperature before continuing to the next 
stage.

Interval. Specifies how frequently a measurement is made. Must be 
equal to or greater than the specified Integration Time and less than 
the stage duration. Disabled when Collect Data (see below) is set to 
No.

Collect Data. Specifies whether to collect data during each stage.

Feature Description

Click Settings in DNA Melting to display the 
Instrument tab in the right pane.
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These settings are available:

Related Topics

Overview

DNA Melting Point Calculations

Unique Screen Features

Making DNA Melting Measurements

Accessories Tab for DNA Melting

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Feature Description

Data mode Y-axis format for acquired data. Absorbance is the only available 
option for the DNA Melting application.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can improve the 
signal-to-noise ratio; however, a larger spectral bandwidth decreases 
the ability to resolve closely spaced spectral features.

Reference 
wavelength 
correction

When selected, automatically acquires a reference measurement at a 
specified wavelength each time a sample measurement is taken. The 
reference measurement is then subtracted from the corresponding 
sample measurement to produce a corrected measurement result. 
Only the corrected result is reported.

Use the Reference wavelength box to specify a wavelength for the 
reference measurement.

Wavelength 
Summary

Wavelengths to monitor during the reaction.

DNA Melting is typically performed at 260 nm for single wavelength 
measurements and at 260 nm and 280 nm for multi-wavelength 
experiments.

Click Settings in DNA Melting to display the 
Accessories tab in the right pane. The available 
parameters depend on the installed accessories. For more 
information,  refer to the user guide for the accessory or 
search for “Evolution 200 Series Accessories” in the 
INSIGHT Help system.
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Related Topics

Evolution 200 Series Accessories

Instrument Status Monitors

Overview

DNA Melting Point Calculations

Unique Screen Features

Making DNA Melting Measurements

Samples Tab for DNA Melting

These settings are available:

Click Settings in DNA Melting to display the Samples 
tab in the right pane.

Feature Description

Number of samples Number of samples for the experiment.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Set up sample table 
columns

Specifies the columns of sample information to be entered during the 
experiment. To add a column, type the desired name in an empty cell 
and press the Tab key. To delete a column (except the Sample ID 
column), right-click it and choose Delete Column. To delete all the 
columns (except the Sample ID column), right-click the table and 
choose Delete All Columns.

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table on the Samples 
tab.
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Related Topics

Overview

DNA Melting Point Calculations

Unique Screen Features

Making DNA Melting Measurements

Tm Calculations Tab for DNA Melting

Save Samples Saves the contents of the samples table in a .tsv (tab separated values) 
file or .csv (comma separated values) file in a specified location.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. Additional columns are defined by the Set up sample table 
columns option (see above).

To change a sample name, click its cell and edit the text. To enter or 
change text in a table cell, click it and type. To order the list by 
sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Feature Description

Click Settings in DNA Melting to display the 
Tm Calculations tab in the right pane.
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These settings are available:

Feature Description

Calculate Tm values 
automatically at end of 
data acquisition

Calculates DNA melting point temperature (Tm) values 
automatically at the end of the experiment. When this option is 
selected, the entered temperature values are marked in the data 
display and the calculated Tm values appear in the sample 
measurements table after the measurement is completed. To 
modify the Tm settings, double-click the data display or choose 
Analyze (menu) > Tm Calculations.

When this option is cleared and Tm calculations have been 
entered, use the Modify Tm Calculations window to view, modify, 
update and accept the Tm calculation settings. After you accept the 
settings, the window closes and the temperature values are marked 
in the data display and the Tm values appear in the sample 
measurements table. See Making DNA Melting Measurements for 
more information.
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Tm Calculation Select a method for calculating DNA melting point temperature 
values. These options are available:

• Horizontal Intercept. Uses the absorbance at two specified 
temperature values and their horizontal intercepts to calculate 
Tm. Useful when absorbance does not vary with temperature 
outside the melting range.

• Sloping Intercept. Uses the absorbance at three specified 
temperature values and their sloped intercepts to calculate Tm. 
Select this option when the absorbance varies with 
temperature inside and outside the melting range.

• Inflection. Calculates the first derivative of the Absorbance vs 
Temperature curve. Tm is the temperature at which the first 
derivative curve has its maximum value (i.e., the slope).

For more information, see DNA Melting Point Calculations.

Temperature 1, 2, 3 Enter the temperatures required by the calculation method.

• Horizontal Intercept. In the Temperature 1 box, enter a 
temperature value in °C from a horizontal section of the graph 
that occurs below the temperature range in which the DNA 
melting point occurs.

In the Temperature 3 box, enter a temperature value in °C 
from a horizontal section of the graph that occurs above the 
DNA melting range.

• Sloping Intercept. In the Temperature 1 box, enter a 
temperature value in °C that occurs below the temperature 
range in which the DNA melting point occurs. (Choose a 
point where the slope is typical.)

In the Temperature 3 box, enter a temperature value in °C 
that occurs above the DNA melting range. (Again, choose a 
point where the slope is typical.)

In the Temperature 2 box, enter an intermediate temperature 
value in °C. (Choose a point that is close to t1 or t3).

• Inflection. In the Temperature 1 box, enter a temperature 
value in °C that defines the start of the range used to calculate 
the derivative curve.

In the Temperature 3 box, enter the temperature value in °C 
that defines the end of the calculation range.

Feature Description
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Related Topics

Overview

DNA Melting Point Calculations

Unique Screen Features

Making DNA Melting Measurements

Unique Screen Features

These features are to the left of the spectral display:

Related Topics

Overview

DNA Melting Point Calculations

Application Settings

Unique Screen Features

Making DNA Melting Measurements

Data Display

Making DNA Melting Measurements

DNA Melting measurements can be made at one wavelength or at up to 40 wavelengths in 
the same experiment. This includes multicell measurements, which allows running a 
fixed-wavelength measurement on several samples simultaneously using a sample changer.

Measurements are taken at specified intervals of time for each stage defined on the 
Measurements tab in Settings. Temperature settings and ramp rate are controlled and 
recorded for the duration of the experiment.

Task buttons in the left pane are described in Task 
Buttons. The right pane in DNA Melting is described 
in Data Display.

Feature Description

Extend Time To extend the collection time for the current sample measurement 
(without interrupting the data collection), click Extend Time and 
enter the amount of time to extend the measurement. If you are 
collecting data in multiple stages, only the current stage is affected.
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It may be helpful to display the following status monitors during your DNA Melting 
experiments:

• Cell Changer status

• Temperature Controller status

• Time status

• Temperature probe status

To display status monitors, click the Configure Instrument Status icon above the data 
display.

In the Configure Instrument Status box, select the status monitors to display and click OK.

 To measure the melting point of a DNA sample

1. Configure the DNA Melting settings as desired.

2. Click Measure.

3. Follow the instructions that appear.

4. When samples information appears, modify it if desired.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

Enter values in any special columns that were specified on the Samples tab in Settings. 
These values may appear in the DNA Melting data report.

5. Click Continue.

6. Follow the instructions that appear.

For each measured sample, the Data Display shows an absorption spectrum with the 
Y-axis in absorbance and the X-axis in temperature. Each plot shows a sample’s spectral 
intensity measured at a particular wavelength over time. Scroll bars are provided if plots 
are out of view.

Note  To configure the software to display status monitors automatically, display the status 
monitors and then save the workbook as a template.
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Each row in the sample measurements table below the plots shows the measurement 
results for one sample at a specified wavelength. The table contains information specified 
on the Reportable Data tab in Reports, plus the Tm value if Calculate Tm values 
automatically at end of data acquisition is selected on the Settings > Tm Calculations 
tab.

To extend the collection time for the current sample measurement (without interrupting 
the data collection), click Extend Time in the navigation pane and enter the amount of 
time to extend the measurement. If you are collecting data in multiple stages, only the 
current stage is affected.

Right-click the Data tab to access features for changing the scale or adding annotation. 
See Data Display for more information.

To measure a sample again, right-click its row in the sample measurements table and 
choose Remeasure (if available). (If Remeasure is not available, you can choose Options 
> Preferences and clear Prevent removal of data to enable it.) After the remeasurement, 
the previous information for the sample is either crossed out or removed from the table, 
depending on the status of Prevent removal of data on the Preferences tab in Options.

To copy the data, right-click the plot and choose Copy to Clipboard.

7. To calculate or modify the DNA melting temperature (Tm) calculations on the data in a 
plot, double-click the plot or select Analyze (menu) > Tm Calculations.

Related Topics

Overview

DNA Melting Point Calculations

Application Settings

Unique Screen Features

Modifying Tm Calculations
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Data Display

Modifying Tm Calculations 

DNA melting measurements must define how the DNA melting point will be measured. This 
is done on the Tm Calculations tab in Settings.

If Calculate Tm values automatically at end of data acquisition is selected on the 
Tm Calculations tab, after data collection completes, the calculated Tm values will appear in 
the sample measurements table along with the other sample data. To perform Tm calculations 
or modify existing Tm calculations on the data in a plot, double-click the plot or select 
Analyze (menu) > Tm Calculations. A window displays the plot and a table containing the 
current Tm  calculation values (based on the Tm Calculations tab in Settings).

These operations are available from the Tm Calculations window:

• If desired, change the Tm Calculation setting to best fit the shape of the DNA melting 
point curve. If you select a different calculation method, add or change the required 
temperature values as needed. For more information, see DNA Melting Point 
Calculations.

• Click Update to recalculate Tm values based on the selected calculation method.

• Specify how to apply the calculations and then click Accept.
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After you click Accept, the window closes and the sample measurements table is updated with 
the new Tm values.

Related Topics

Overview

DNA Melting Point Calculations

Application Settings

Unique Screen Features

Making DNA Melting Measurements

Protein A280

Overview

Tyrosine, tryptophan, phenylalanine and to a small extent lysine and Cys-Cys disulphide 
bonds have an absorbance peak around 280 nm. This method does not require generation of 
a standard curve and is ready for protein sample quantitation at software startup. Colorimetric 
assays such as Pierce BCA, Pierce 660 nm, Bradford and Lowry are more commonly used for 
uncharacterized protein solutions and cell lysates.

This option... Applies the calculations to...

Selected plot only The selected data only.

All plots with this wavelength only All plots for the current wavelength.

All plots All plots.

Contents

• Overview

• Application Settings

• Unique Screen Features

• Making Protein A280 Measurements

The Protein A280 method is used to quantify proteins on 
the basis of their absorbance at 280 nm.
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The Protein A280 application displays the UV spectrum, measures the protein’s absorbance at 
280 nm (A280), and calculates the concentration (mg/ml).

Related Topics

Application Settings

Data Display

Unique Screen Features

Making Protein A280 Measurements

Application Settings

The follow tabs of settings are available:
Type Tab for Protein A280
Measurement Tab for Protein A280
Instrument Tab for Protein A280
Accessories Tab for Protein A280
Samples Tab for Protein A280

Related Topics

Overview

Data Display

Unique Screen Features

Making Protein A280 Measurements

Type Tab for Protein A280

To set data acquisition parameters for a Protein A280 
workbook, click Settings.

Click Settings in Protein A280 to display the Type tab in 
the right pane.

Feature Description

Name Application name.

Description (optional) Description of the template.
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Related Topics

Measurement Tab for Protein A280

Instrument Tab for Protein A280

Accessories Tab for Protein A280

Samples Tab for Protein A280

Measurement Tab for Protein A280

Protein A280 Type Type of analysis to perform.

1 Abs = 1 mg / mL is a general reference setting based on a 0.1% 
(1 mg/ml) protein solution. It produces an absorbance of 1.0 A at 
280 nm (where the pathlength is 10 mm, or 1 cm).

BSA is a Bovine Serum Albumin reference. Protein concentrations 
are calculated using the mass extinction coefficient of 6.7 at 
280 nm for a 1% (10 mg/ml) BSA solution.

IgG is an IgG reference. Protein concentrations are calculated using 
the mass extinction coefficient of 13.7 at 280 nm for a 1% 
(10 mg/ml) IgG solution.

For Lysozyme, protein concentrations are calculated using the mass 
extinction coefficient of 26.4 at 280 nm for a 1% (10 mg/ml) 
Lysozyme solution.

Other protein ( & MW) is the entered molar extinction 
coefficient (M-1 cm-1) and molecular weight (MW) in kilodaltons 
(kDa) for the respective protein reference. The maximum values are 
99999000 for  and 9999000 for MW.

Other protein ( 1%) is the mass extinction coefficient (l g-1 cm-1) 
for a 10 mg/ml (1%) solution of the respective reference protein. 
Enter an /1000 value.

Pathlength Distance the light travels through the sample.

Feature Description

Click Settings in Protein A280 to display the 
Measurement tab in the right pane.
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Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

• Single point. Enter a wavelength value to define the endpoint for 
the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the specified 
baseline point and calculating the absorbance value on the drawn 
baseline at the specified analytical wavelength. The software 
subtracts the calculated baseline absorbance value from the 
measured absorbance value and reports the corrected absorbance

• Sloping baseline. Enter two wavelength values to define the 
endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value from 
the measured absorbance value and reports the corrected 
absorbance.

• None. Uses uncorrected data. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, 
the calculated protein concentration may be higher than the true 
value.

Component name Component to quantify.
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Related Topics

Type Tab for Protein A280

Instrument Tab for Protein A280

Accessories Tab for Protein A280

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

 To add one or more predefined formulas

1. Click Select.

2. For each desired formula, select it in the list and click Add.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click Close.

 To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available units depend on the Formulas & Units tab settings.

Feature Description



4 INSIGHT Bio Applications
Protein A280

210 Evolution 200 Series Spectrophotometer User Guide Thermo Scientific

Samples Tab for Protein A280

Instrument Tab for Protein A280

Related Topics

Type Tab for Protein A280

Measurement Tab for Protein A280

Accessories Tab for Protein A280

Samples Tab for Protein A280

Click Settings in Protein A280 to display the Instrument 
tab in the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.



 4 INSIGHT Bio Applications
Protein A280

Thermo Scientific Evolution 200 Series Spectrophotometer User Guide 211

Accessories Tab for Protein A280

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Related Topics

Type Tab for Protein A280

Measurement Tab for Protein A280

Instrument Tab for Protein A280

Samples Tab for Protein A280

Samples Tab for Protein A280

Click Settings in Protein A280 to display the Accessories 
tab in the right pane. The available parameters depend 
on the installed accessories. For more information,  refer 
to the user guide for the accessory or search for 
“Evolution 200 Series Accessories” in the INSIGHT 
Help system.

Click Settings in Protein A280 to display the Samples 
tab in the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use sample 
correction factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table.

Use control limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.
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Related Topics

Type Tab for Protein A280

Measurement Tab for Protein A280

Instrument Tab for Protein A280

Accessories Tab for Protein A280

Unique Screen Features

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table.

Save Samples Saves the contents of the samples table in a .tsv (tab separated values) 
file or .csv (comma separated values) file in a specified location.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Feature Description

The right pane in Measure Protein A280 may include: 

Feature Description

Type Type of analysis to perform.

/1000 and Molecular 
Weight (kDa)

/1000 and molecular weight for the Other protein ( & 
MW) sample type.

Ext. Coeff, 1% (L/g-cm) Extinction coefficient and 1% for the Other protein (
1%) sample type.

Conc. Concentration based on absorbance at 280 nm, after 
correction is applied, and the selected extinction coefficient.

A280 Absorbance at 280 nm for the protein sample being 
measured.

260/280 Ratio of absorbance at 260 nm and 280 nm.
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These features are to the left of the spectral display:

Advanced calculations

For selecting predefined formulas for additional data processing, with the results appearing in 
a calculations table at the bottom of the right pane. Options include basic math and statistics. 
The formulas can be applied to specific samples and columns of data in the sample 
measurements table or to selected rows and columns in the calculations table for the current 
workbook or template. Calculations are applied to all subsequently acquired data. Custom 
calculations are saved with the workbook or template. Available for all applications except 
Rate.

To delete the contents of a cell in the calculations table, right-click the cell and choose Delete.

 To add column and row headings to the calculations table

1. Double-click a cell that needs a heading or other label.

2. In the Cell Properties box, choose Text.

3. Type the heading or label text.

4. To select the background color for the text displayed in the calculations table, click 
Background, choose a color and click OK.

5. To display the cell contents in bold text, click Bold Text.

6. Click OK.

 To define calculations based on the samples table

1. In the calculations table, double-click the cell where you want the calculation result to 
appear.

2. In the Cell Properties box, choose Calculation.

3. Select an Equation in the list.

The available equations are fixed.

4. Set Source to Samples table.

5. Select a sample measurement in the Measurements list.

6. Specify the sample rows to include by entering their ID numbers in the Range/Reference 
box.

Use a colon to specify a range (e.g., 2:5 or 1:N) or commas for individual samples (e.g., 
1,3,5).

7. To select the background color for the cell that displays the calculated result, click 
Background, choose a color and click OK.

8. To display the cell contents in bold text, click Bold Text.
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9. Choose OK.

The calculated result appears in the selected cell.

 To define a calculation based on the calculations table

1. In the calculations table, double-click the cell where you want the calculation result to 
appear.

2. In the Cell Properties box, choose Calculation.

3. Select an Equation in the list.

4. Set Source to Calculations Table.

5. Specify the table cells to include by entering their IDs in the Range/Reference box.

If Equation is set to Std. Deviation, Mean, or %RSD, use a colon to specify a range (e.g., 
A2:A5 or A1:AN) or commas for individual cells (e.g., A1,A3,A5).

If Equation is set to Addition, Subtraction, Multiplication, or Division, specify one cell 
location in each Reference box. (e.g., A1).

If Equation is set to a Factor, use the first (Reference) box to specify a cell location and 
the second (Factor) box to enter the factor.

6. To select the background color for the cell that displays the calculated result, click 
Background, choose a color and click OK.

7. To display the cell contents in bold text, click Bold Text.

8. Choose OK.

The calculated result appears in the selected cell.

Related Topics

Overview

Application Settings

Data Display

Making Protein A280 Measurements

Making Protein A280 Measurements

While performing this procedure, click here for information about features to the right of the 
spectral display.

 To make a Protein A280 measurement

1. Click Measure Protein A280 in Protein A280.
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2. Click Measure.

3. Follow the instructions that appear.

Use the appropriate buffer for the blank, generally the same buffer used to prepare or 
dissolve the sample. The buffer should be the same pH and of a similar ionic strength as 
the sample solution.

4. When samples information appears, modify it if desired.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

5. If only one sample will be measured, insert it.

6. Click Continue.

7. Follow any instructions that appear, such as to install a specified sample.

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.



4 INSIGHT Bio Applications
Protein A280

216 Evolution 200 Series Spectrophotometer User Guide Thermo Scientific

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:

To copy this plot, right-click it and choose Copy to Clipboard.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation. See Data Display for more information.)

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

Related Topics

Overview

Application Settings

Data Display

Unique Screen Features

Making Protein A280 Measurements
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Proteins and Labels

Overview

Related Topics

Dye/Chromophore Editor

Application Settings

Data Display

Unique Screen Features

Making Proteins and Labels Measurements

Dye/Chromophore Editor

To enter a new dye, type its information in the appropriate cells of the bottom row of the table 
and select a unit. Refer to the dye manufacturer for appropriate correction factors. The 
260 nm corrections will be used for nucleic acid sample concentration calculations. Entered 
information is saved automatically.

To delete a user-defined dye, right-click its row and choose Delete Row. Predefined dyes, 
identified by the lock icon, cannot be edited or deleted.

Contents

• Overview

• Dye/Chromophore Editor

• Application Settings

• Unique Screen Features

• Making Proteins and Labels Measurements

The Proteins & Labels application determines protein 
concentration using the protein’s intrinsic absorption at 
280 nm as well as the concentration of a fluorescent dye 
modification (protein array conjugates). It can also 
measure the purity of metalloproteins (such as 
hemoglobin) using wavelength ratios.

Use the Dye Chromophore Editor to select predefined 
dyes, modify existing dyes for protocols, or enter new 
dyes.
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Related Topics

Overview

Application Settings

Data Display

Unique Screen Features

Making Proteins and Labels Measurements

Application Settings

The follow tabs of settings are available:
Type Tab for Proteins and Labels
Measurement Tab for Proteins and Labels
Instrument Tab for Proteins and Labels
Accessories Tab for Proteins and Labels
Samples Tab for Proteins and Labels

Related Topics

Overview

Dye/Chromophore Editor

Data Display

Unique Screen Features

Making Proteins and Labels Measurements

Type Tab for Proteins and Labels

To set data acquisition parameters for a Proteins and 
Labels workbook, click Settings.

Click Settings in Proteins and Labels to display the Type 
tab in the right pane.

Feature Description

Name Application name.

Description (optional) Description of the template.
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Related Topics

Measurement Tab for Proteins and Labels

Instrument Tab for Proteins and Labels

Accessories Tab for Proteins and Labels

Samples Tab for Proteins and Labels

Measurement Tab for Proteins and Labels

Type Type of analysis to perform.

1 Abs = 1 mg / mL is a general reference setting based on a 0.1% 
(1 mg/ml) protein solution. It produces an absorbance of 1.0 A at 
280 nm (where the pathlength is 10 mm, or 1 cm).

BSA is a Bovine Serum Albumin reference. Protein concentrations 
are calculated using the mass extinction coefficient of 6.7 at 
280 nm for a 1% (10 mg/ml) BSA solution.

IgG is an IgG reference. Protein concentrations are calculated 
using the mass extinction coefficient of 13.7 at 280 nm for a 1% 
(10 mg/ml) IgG solution.

For Lysozyme, protein concentrations are calculated using the 
mass extinction coefficient of 26.4 at 280 nm for a 1% 
(10 mg/ml) Lysozyme solution.

Other protein ( & MW) is the entered molar extinction 
coefficient (M-1 cm-1) and molecular weight (MW) in kilodaltons 
(kDa) for the respective protein reference. The maximum values 
are 99999 X 1000 for  and 9999 X 1000 for MW

Other protein ( 1%) is the mass extinction coefficient 
(l g-1 cm-1) for a 10 mg/ml (1%) solution of the respective 
reference protein.

Dye 1 and Dye 2 Fluorescent dyes whose absorbance will be used in concentration 
correction calculations.

Pathlength Distance the light travels through the sample.

Feature Description

Click Settings in Proteins and Labels to display the 
Measurement tab in the right pane.
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Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

• Single point. Enter a wavelength value to define the endpoint for 
the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the specified 
baseline point and calculating the absorbance value on the drawn 
baseline at the specified analytical wavelength. The software 
subtracts the calculated baseline absorbance value from the 
measured absorbance value and reports the corrected absorbance

• Sloping baseline. Enter two wavelength values to define the 
endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value from 
the measured absorbance value and reports the corrected 
absorbance.

• None. Uses uncorrected data. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, 
the calculated protein concentration may be higher than the true 
value.

Component name Component to quantify.
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Related Topics

Type Tab for Proteins and Labels

Instrument Tab for Proteins and Labels

Accessories Tab for Proteins and Labels

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

 To add one or more predefined formulas

1. Click Select.

2. For each desired formula, select it in the list and click Add.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click Close.

 To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available units depend on the Formulas & Units tab settings.

Feature Description
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Samples Tab for Proteins and Labels

Instrument Tab for Proteins and Labels

Related Topics

Type Tab for Proteins and Labels

Measurement Tab for Proteins and Labels

Accessories Tab for Proteins and Labels

Samples Tab for Proteins and Labels

Click Settings in Proteins and Labels to display the 
Instrument tab in the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Accessories Tab for Proteins and Labels

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Related Topics

Type Tab for Proteins and Labels

Measurement Tab for Proteins and Labels

Instrument Tab for Proteins and Labels

Samples Tab for Proteins and Labels

Samples Tab for Proteins and Labels

Click Settings in Proteins and Labels to display the 
Accessories tab in the right pane. The available 
parameters depend on the installed accessories. For more 
information,  refer to the user guide for the accessory or 
search for “Evolution 200 Series Accessories” in the 
INSIGHT Help system.

Click Settings in Proteins and Labels to display the 
Samples tab in the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use sample 
correction factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table.

Use control limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.
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Related Topics

Type Tab for Proteins and Labels

Measurement Tab for Proteins and Labels

Instrument Tab for Proteins and Labels

Accessories Tab for Proteins and Labels

Unique Screen Features

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table.

Save Samples Saves the contents of the samples table in a .tsv (tab separated values) 
file or .csv (comma separated values) file in a specified location.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Feature Description

The right pane in Measure Protein & Labels includes:

Feature Description

Type Type of analysis to perform.

/1000 and Molecular Weight 
(kDa)

/1000 and molecular weight for the Other protein ( & 
MW) sample type.

Ext. Coeff, 1% (L/g-cm) Extinction coefficient and 1% for the Other protein (
1%) sample type.
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These features are to the left of the spectral display:

Advanced calculations

For selecting predefined formulas for additional data processing, with the results appearing in 
a calculations table at the bottom of the right pane. Options include basic math and statistics. 
The formulas can be applied to specific samples and columns of data in the sample 
measurements table or to selected rows and columns in the calculations table for the current 
workbook or template. Calculations are applied to all subsequently acquired data. Custom 
calculations are saved with the workbook or template. Available for all applications except 
Rate.

To delete the contents of a cell in the calculations table, right-click the cell and choose Delete.

 To add column and row headings to the calculations table

1. Double-click a cell that needs a heading or other label.

2. In the Cell Properties box, choose Text.

3. Type the heading or label text.

4. To select the background color for the text displayed in the calculations table, click 
Background, choose a color and click OK.

5. To display the cell contents in bold text, click Bold Text.

6. Click OK.

 To define calculations based on the samples table

1. In the calculations table, double-click the cell where you want the calculation result to 
appear.

2. In the Cell Properties box, choose Calculation.

3. Select an Equation in the list.

The available equations are fixed.

Conc. Concentration based on absorbance at 280 nm, after 
correction is applied, and the selected extinction 
coefficient.

Dye(s) Conc. Concentration of the user-selected dye(s).

The software automatically subtracts the value of a sloping 
baseline from 400 to 750 nm from the absorbance at the 
Dye wavelength. Only the corrected absorbance of the dye 
peak(s) and dye concentration(s) are reported.

Feature Description
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4. Set Source to Samples table.

5. Select a sample measurement in the Measurements list.

6. Specify the sample rows to include by entering their ID numbers in the Range/Reference 
box.

Use a colon to specify a range (e.g., 2:5 or 1:N) or commas for individual samples (e.g., 
1,3,5).

7. To select the background color for the cell that displays the calculated result, click 
Background, choose a color and click OK.

8. To display the cell contents in bold text, click Bold Text.

9. Choose OK.

The calculated result appears in the selected cell.

 To define a calculation based on the calculations table

1. In the calculations table, double-click the cell where you want the calculation result to 
appear.

2. In the Cell Properties box, choose Calculation.

3. Select an Equation in the list.

4. Set Source to Calculations Table.

5. Specify the table cells to include by entering their IDs in the Range/Reference box.

If Equation is set to Std. Deviation, Mean, or %RSD, use a colon to specify a range (e.g., 
A2:A5 or A1:AN) or commas for individual cells (e.g., A1,A3,A5).

If Equation is set to Addition, Subtraction, Multiplication, or Division, specify one cell 
location in each Reference box. (e.g., A1).

If Equation is set to a Factor, use the first (Reference) box to specify a cell location and 
the second (Factor) box to enter the factor.

6. To select the background color for the cell that displays the calculated result, click 
Background, choose a color and click OK.

7. To display the cell contents in bold text, click Bold Text.

8. Choose OK.

The calculated result appears in the selected cell.

Related Topics

Overview

Dye/Chromophore Editor
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Application Settings

Data Display

Making Proteins and Labels Measurements

Making Proteins and Labels Measurements

While performing this procedure, click here for information about features to the right of the 
spectral display.

 To make a Proteins and Labels measurement

1. Click Measure Proteins & Labels in Proteins and Labels.

2. Click Measure.

3. Follow the instructions that appear.

Use the appropriate buffer for the blank, generally the same buffer used to prepare or 
dissolve the sample. This solution should be the same pH and of a similar ionic strength 
as the sample solution.

4. When samples information appears, modify it if desired.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

5. If only one sample will be measured, insert it.

6. Click Continue.

7. Follow any instructions that appear, such as to install a specified sample.

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.
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The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:

To copy this plot, right-click it and choose Copy to Clipboard.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation. See Data Display for more information.)

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

The A280 value in the result table is the value using the absorbance at 750 nm as the 
baseline. The A280 value used to calculate the protein concentration takes into account 
the appropriate dye correction factors and any absorbance correction due to the selected 
analysis correction nm. Therefore, the displayed A280 value is not the value used to 
calculate the sample concentration.

To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

Related Topics

Overview

Dye/Chromophore Editor

Application Settings

Data Display
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Unique Screen Features

Data Display

Pierce BCA

Overview

BCA Kits and Protocols

Commercial BCA Protein kit manufacturers typically outline procedures for two different 
protein concentration ranges:

• A regular assay uses a 20:1 reagent/sample volume ratio.

• A mini assay uses a 1:1 reagent/sample volume ratio. To prepare sufficient volume of these 
1:1 mixtures for cuvette measurements, use a sample volume of at least 3 ml and 3 ml of 
BCA reagent. 

Follow the assay kit manufacturer’s recommendations for all standards and samples 
(unknowns). Ensure each is subjected to the same timing and temperature throughout the 
assay.

Contents

• Overview

• Application Settings

• Unique Screen Features

• Making Pierce BCA Measurements

The BCA Protein Assay, which was patented by Pierce 
Biotechnology, part of Thermo Fisher Scientific, remains a 
cornerstone for accurately measuring protein 
concentration in biological samples. The method uses 
bicinchoninic acid (BCA) as the detection reagent for 
Cu+, which is formed when Cu2+ is reduced by protein in 
an alkaline environment. A purple-colored reaction 
product is formed by the chelation of two molecules of 
BCA with one cuprous ion (Cu+). The resulting Cu-BCA 
chelate formed in the presence of protein is measured at 
562 nm. While this assay is linear over a wide 
concentration range, the calibration curves are best 
represented as second order. Preformulated reagents of 
BCA and CuSO4 are available in kit form from us.
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Protein standards (BSA) for generating a standard curve may also be provided by the 
manufacturer for the BCA assay.

Working With Standard Curves

A standard curve is required for colorimetric protein analysis. Here are tips on creating a 
standard curve:

• A standard curve can be generated using two or more standards.

• The multipoint curve capability allows multiple replicates for each standard. Standards 
can be run in any order; however, best practice dictates that the standards be measured 
from the lowest concentration to the highest.

• Determine whether or not to use a standard when analyzing samples against the standard 
curve.

• Establishing a new standard curve requires creating a new workbook.

• If a previously saved workbook is used, all concentration calculations for newly measured 
samples will be based on the standard absorbance values saved in the workbook.

Related Topics

Application Settings

Unique Screen Features

Data Display

Making Pierce BCA Measurements

Application Settings

Note  If running the assay at 60 °C, doubling the volumes may afford greater insurance 
against skewed results from evaporation/condensation within the sealed reaction tube.

Note  Each workbook will archive only one standard curve.

To set data acquisition parameters for a Pierce BCA 
workbook, click Settings.
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The follow tabs of settings are available:
Type Tab for Pierce BCA
Measurement Tab for Pierce BCA
Standards Tab for Pierce BCA
Instrument Tab for Pierce BCA
Accessories Tab for Pierce BCA
Samples Tab for Pierce BCA

Related Topics

Overview

Unique Screen Features

Data Display

Making Pierce BCA Measurements

Type Tab for Pierce BCA

Related Topics

Measurement Tab for Pierce BCA

Standards Tab for Pierce BCA

Instrument Tab for Pierce BCA

Accessories Tab for Pierce BCA

Samples Tab for Pierce BCA

Measurement Tab for Pierce BCA

Click Settings in Pierce BCA to display the Type tab in 
the right pane.

Feature Description

Name Application name.

Description (optional) Description of the template.

Standard curve Type of quantitative analysis used.

Pathlength Distance the light travels through the sample.

Click Settings in Pierce BCA to display the 
Measurement tab in the right pane.
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Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

• Single point. Enter a wavelength value to define the endpoint for 
the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the specified 
baseline point and calculating the absorbance value on the drawn 
baseline at the specified analytical wavelength. The software 
subtracts the calculated baseline absorbance value from the 
measured absorbance value and reports the corrected absorbance

• Sloping baseline. Enter two wavelength values to define the 
endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value from 
the measured absorbance value and reports the corrected 
absorbance.

• None. Uses uncorrected data. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, 
the calculated protein concentration may be higher than the true 
value.

Component name Component to quantify.
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Related Topics

Type Tab for Pierce BCA

Standards Tab for Pierce BCA

Instrument Tab for Pierce BCA

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

 To add one or more predefined formulas

1. Click Select.

2. For each desired formula, select it in the list and click Add.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click Close.

 To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available units depend on the Formulas & Units tab settings.

Feature Description
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Accessories Tab for Pierce BCA

Samples Tab for Pierce BCA

Standards Tab for Pierce BCA

Click Settings in Pierce BCA to display the Standards 
tab in the right pane.

Feature Description

Curve fit type Type of equation used to create the standard curve from standard 
concentration values.

Standard averaging Whether and how to average concentration values from multiple 
measurements of the same standard or from multiple standards 
prepared under the same conditions. To average multiple 
measurements of the same standard, select Replicate and set Number 
of replicates to the total number of measurements. To average values 
from two or three similar standards, select Duplicate or Triplicate, 
respectively.

Minimum r2 The r2 value indicates how well the standard curve fits the standard 
data points, with 1.0 a perfect fit. If Minimum r2 is selected, samples 
can be quantified only after that value is achieved for the standard 
curve.

Calculate from 
weight/volume

If available for the current unit, calculates concentration when the 
weight and volume of material used to prepare each standard is 
known. Enter the weight and volume for each standard in the 
appropriate table cells, or enter it later as part of running an analysis.

Use correction 
factor

If available and selected, specifies a multiplication factor for each 
standard. Can be used to correct for standard properties (percent 
purity, water content, etc.) or preparation steps that affect the 
measured result such as a dilution.

When this option is selected, two columns are added to the standards 
table: Correction Factor and Corrected Concentration. In the 
Correction Factor column, enter the desired factor for each standard 
in the table. The values in the Corrected Concentration column are 
used to create the calibration curve. If a report is generated that 
includes information about the standards, the report will also include 
the correction factors and corrected concentrations.

Standards Table Contains concentration and other information about the standards. 
To add information from a .csv (comma separated values) file or .tsv 
(tab separated values) file, click Import Standards. To save the 
information in a .csv file or .tsv file, click Export Standards.
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Related Topics

Working With Standard Curves

Type Tab for Pierce BCA

Measurement Tab for Pierce BCA

Instrument Tab for Pierce BCA

Accessories Tab for Pierce BCA

Samples Tab for Pierce BCA

Instrument Tab for Pierce BCA

Click Settings in Pierce BCA to display the Instrument 
tab in the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Related Topics

Type Tab for Pierce BCA

Measurement Tab for Pierce BCA

Standards Tab for Pierce BCA

Accessories Tab for Pierce BCA

Samples Tab for Pierce BCA

Accessories Tab for Pierce BCA

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Related Topics

Type Tab for Pierce BCA

Measurement Tab for Pierce BCA

Standards Tab for Pierce BCA

Instrument Tab for Pierce BCA

Samples Tab for Pierce BCA

Samples Tab for Pierce BCA

Click Settings in Pierce BCA to display the Accessories 
tab in the right pane. The available parameters depend 
on the installed accessories. For more information,  refer 
to the user guide for the accessory or search for 
“Evolution 200 Series Accessories” in the INSIGHT 
Help system.

Click Settings in Pierce BCA to display the Samples tab 
in the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.
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Related Topics

Type Tab for Pierce BCA

Measurement Tab for Pierce BCA

Standards Tab for Pierce BCA

Instrument Tab for Pierce BCA

Accessories Tab for Pierce BCA

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use sample 
correction factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table.

Use weight/volume 
correction

If available for the current unit, corrects sample concentrations using 
the entered target weight and volume:

corrected concentration = measured concentration * (actual weight / 
target weight) * (target volume / actual volume)

Use control limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table.

Save Samples Saves the contents of the samples table in a .tsv (tab separated values) 
file or .csv (comma separated values) file in a specified location.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Feature Description



4 INSIGHT Bio Applications
Pierce BCA

238 Evolution 200 Series Spectrophotometer User Guide Thermo Scientific

Unique Screen Features

Advanced calculations

For selecting predefined formulas for additional data processing, with the results appearing in 
a calculations table at the bottom of the right pane. Options include basic math and statistics. 
The formulas can be applied to specific samples and columns of data in the sample 
measurements table or to selected rows and columns in the calculations table for the current 
workbook or template. Calculations are applied to all subsequently acquired data. Custom 
calculations are saved with the workbook or template. Available for all applications except 
Rate.

To delete the contents of a cell in the calculations table, right-click the cell and choose Delete.

 To add column and row headings to the calculations table

1. Double-click a cell that needs a heading or other label.

2. In the Cell Properties box, choose Text.

3. Type the heading or label text.

4. To select the background color for the text displayed in the calculations table, click 
Background, choose a color and click OK.

5. To display the cell contents in bold text, click Bold Text.

6. Click OK.

 To define calculations based on the samples table

1. In the calculations table, double-click the cell where you want the calculation result to 
appear.

2. In the Cell Properties box, choose Calculation.

3. Select an Equation in the list.

The available equations are fixed.

4. Set Source to Samples table.

5. Select a sample measurement in the Measurements list.

6. Specify the sample rows to include by entering their ID numbers in the Range/Reference 
box.

Use a colon to specify a range (e.g., 2:5 or 1:N) or commas for individual samples (e.g., 
1,3,5).

These features are to the left of the spectral display:
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7. To select the background color for the cell that displays the calculated result, click 
Background, choose a color and click OK.

8. To display the cell contents in bold text, click Bold Text.

9. Choose OK.

The calculated result appears in the selected cell.

 To define a calculation based on the calculations table

1. In the calculations table, double-click the cell where you want the calculation result to 
appear.

2. In the Cell Properties box, choose Calculation.

3. Select an Equation in the list.

4. Set Source to Calculations Table.

5. Specify the table cells to include by entering their IDs in the Range/Reference box.

If Equation is set to Std. Deviation, Mean, or %RSD, use a colon to specify a range (e.g., 
A2:A5 or A1:AN) or commas for individual cells (e.g., A1,A3,A5).

If Equation is set to Addition, Subtraction, Multiplication, or Division, specify one cell 
location in each Reference box. (e.g., A1).

If Equation is set to a Factor, use the first (Reference) box to specify a cell location and 
the second (Factor) box to enter the factor.

6. To select the background color for the cell that displays the calculated result, click 
Background, choose a color and click OK.

7. To display the cell contents in bold text, click Bold Text.

8. Choose OK.

The calculated result appears in the selected cell.

Related Topics

Overview

Application Settings

Data Display

Making Pierce BCA Measurements
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Making Pierce BCA Measurements

Sample and Standards Preparation

• See the manufacturers’ guidelines and recommendations for standard and sample 
preparation.

• Prepare both standards and unknowns in the same manner. Use a diluent of the same pH 
and ionic strength for all blanks, standards and unknown samples.

Procedure

 To make a Pierce BCA measurement

1. Click Measure Pierce BCA in Pierce BCA.

2. If standards need to be acquired, click Measure. If standards have already been acquired, 
skip to step 7 to acquire sample data.

3. Follow the instructions that appear.

Use the appropriate buffer for the blank. See the reagent directions for details.

4. When the standards information appears, modify it if desired.

More:

If Standard averaging on the Standards tab in Settings was set to Duplicate, “D” at the 
end of a standard name indicates the second measurement to be made of the standard. If 
Sample averaging was set to Triplicate, “D” and “T” at the end of standard names indicate 
the second and third measurements to be made, respectively.

To enter previously saved standards information, use Import Standards.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each standard in the table.

Note  Standards diluted from a stock standard must cover the expected range of the 
unknown samples. Protein concentrations are not extrapolated beyond measured 
standard concentrations.

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.
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To remove a standard, select it, right-click the table and choose Clear Standard. To 
remove all the standards, choose Clear Table.

To save standards information for later use, use Export Standards.

5. Click Continue.

6. Follow the instructions that appear, installing the specified standards.

The Standard Curve(s) tab displays the resulting standard curve (or curves). Specify the 
standards to use for the curve (or curves) by selecting Yes or No in the Use column in the 
table.

More:

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

If Standard averaging was set to Duplicate, “D” at the end of a standard name indicates 
the second measurement. If Standard averaging was set to Triplicate, “D” and “T” 
indicate the second and third measurements, respectively.

To permanently remove an acquired standard from the analysis, right-click it and choose 
Remove. Its information is crossed out but not removed from the table.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
standard selected in the table. To access commands for customizing the display, including 
adding annotation, right-click the data. See Data Display for more information.

7. Click Measure.

If a standard curve is not calibrated...

• Try selecting a different curve fit type.

• Try remeasuring a standard using the correct standard material: 
select the listed standard, right-click the table and choose 
Remeasure.

• Try changing the setting of Minimum r2 on the Standards tab and 
acquire the standards again in a new workbook.

This is only an indicator that the required minimum number of points 
have been established for the selected curve fit type. It does not validate 
the integrity of the curve. For example, additional standards may be 
required to cover the expected assay concentration range.
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8. Follow the instructions that appear.

9. When samples information appears, modify it if desired.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each sample in the table.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

10. If only one sample will be measured, install it.

11. Click Continue.

12. Follow any instructions that appear, such as to install a specified sample.

The sample results table contains the columns of information specified on the 
Configuration tab in Reports. If Sample averaging was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement. If Sample averaging was set to 
Triplicate, “D” and “T” indicate the second and third measurements, respectively.

The Standard Curve(s) tab shows graphically the relationship between the standard curve, 
measured spectral intensity and calculated concentration for the selected sample: A 
horizontal line connects the sample spectral intensity value on the Y-axis to the standard 
curve. A vertical line connects that point to the sample concentration value on the X-axis:

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:
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To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

To copy the data on the Standard Curve(s) tab or Run Chart tab, right-click the plot and 
choose Copy to Clipboard.

Related Topics

Overview

Application Settings

Data Display

Unique Screen Features

Working With Standard Curves

Protein Bradford

Overview

Contents

• Overview

• Application Settings

• Unique Screen Features

• Making Protein Bradford Assay Measurements

The Protein Bradford assay measures absorbance at 
595 nm; it determines concentration for either standard or 
micro sample concentrations.
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This assay is commonly used for determining protein concentration. It is often used for more 
dilute protein solutions where lower detection sensitivity is needed and/or in the presence of 
components that also have significant UV (280 nm) absorbance. Like the other colorimetric 
assays, the Bradford assay requires generating a standard curve before measuring sample 
proteins. 

The Bradford procedure uses the protein-induced absorbance shift of Coomassie Blue dye to 
595 nm to measure protein concentration. The bound protein-dye complex is measured at 
595 nm and normalized at 750 nm. A single stabilized reagent mixture containing Coomassie 
Blue dye, alcohol, and surfactant in kit form is available from numerous manufacturers.

Bradford Reagent Kits and Protocols

Follow the assay kit manufacturer’s recommendations for all standards and samples 
(unknowns), ensuring they are subjected to the same timing and temperature throughout the 
assay.

Protein standards (BSA) for generating a standard curve may also be provided by the Bradford 
assay manufacturer.

Working With Standard Curves

A standard curve is required for colorimetric protein analysis. Here are tips on creating a 
standard curve:

• A standard curve can be generated using two or more standards.

• The multipoint curve capability allows multiple replicates for each standard. Standards 
can be run in any order; however, best practice dictates that the standards be measured 
from the lowest concentration to the highest.

• Determine whether or not to use a standard when analyzing samples against the standard 
curve.

• Establishing a new standard curve requires creating a new workbook.

• If a previously saved workbook is used, all concentration calculations for newly measured 
samples will be based on the standard absorbance values saved in the workbook.

Related Topics

Application Settings

Data Display

Unique Screen Features

Making Protein Bradford Assay Measurements

Note  Each workbook will archive only one standard curve.
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Application Settings

The follow tabs of settings are available:
Type Tab for Protein Bradford
Measurement Tab for Protein Bradford
Standards Tab for Protein Bradford
Instrument Tab for Protein Bradford
Accessories Tab for Protein Bradford
Samples Tab for Protein Bradford

Related Topics

Overview

Data Display

Unique Screen Features

Making Protein Bradford Assay Measurements

Type Tab for Protein Bradford

Related Topics

Measurement Tab for Protein Bradford

Standards Tab for Protein Bradford

Instrument Tab for Protein Bradford

Accessories Tab for Protein Bradford

Samples Tab for Protein Bradford

To set data acquisition parameters for a Protein Bradford 
workbook, click Settings.

Click Settings in Protein Bradford to display the Type 
tab in the right pane.

Feature Description

Name Application name.

Description (optional) Description of the template.

Standard curve Type of quantitative analysis used.

Pathlength Distance the light travels through the sample.
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Measurement Tab for Protein Bradford

Click Settings in Protein Bradford to display the 
Measurement tab in the right pane.

Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

• Single point. Enter a wavelength value to define the endpoint for 
the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the specified 
baseline point and calculating the absorbance value on the drawn 
baseline at the specified analytical wavelength. The software 
subtracts the calculated baseline absorbance value from the 
measured absorbance value and reports the corrected absorbance

• Sloping baseline. Enter two wavelength values to define the 
endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value from 
the measured absorbance value and reports the corrected 
absorbance.

• None. Uses uncorrected data. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, 
the calculated protein concentration may be higher than the true 
value.

Component name Component to quantify.



 4 INSIGHT Bio Applications
Protein Bradford

Thermo Scientific Evolution 200 Series Spectrophotometer User Guide 247

Related Topics

Type Tab for Protein Bradford

Standards Tab for Protein Bradford

Instrument Tab for Protein Bradford

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

 To add one or more predefined formulas

1. Click Select.

2. For each desired formula, select it in the list and click Add.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click Close.

 To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available units depend on the Formulas & Units tab settings.

Feature Description
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Accessories Tab for Protein Bradford

Samples Tab for Protein Bradford

Standards Tab for Protein Bradford

Click Settings in Protein Bradford to display the 
Standards tab in the right pane.

Feature Description

Curve fit type Type of equation used to create the standard curve from standard 
concentration values.

Standard averaging Whether and how to average concentration values from multiple 
measurements of the same standard or from multiple standards 
prepared under the same conditions. To average multiple 
measurements of the same standard, select Replicate and set Number 
of replicates to the total number of measurements. To average values 
from two or three similar standards, select Duplicate or Triplicate, 
respectively.

Minimum r2 The r2 value indicates how well the standard curve fits the standard 
data points, with 1.0 a perfect fit. If Minimum r2 is selected, samples 
can be quantified only after that value is achieved for the standard 
curve.

Calculate from 
weight/volume

If available for the current unit, calculates concentration when the 
weight and volume of material used to prepare each standard is 
known. Enter the weight and volume for each standard in the 
appropriate table cells, or enter it later as part of running an analysis.

Use correction 
factor

If available and selected, specifies a multiplication factor for each 
standard. Can be used to correct for standard properties (percent 
purity, water content, etc.) or preparation steps that affect the 
measured result such as a dilution.

When this option is selected, two columns are added to the standards 
table: Correction Factor and Corrected Concentration. In the 
Correction Factor column, enter the desired factor for each standard 
in the table. The values in the Corrected Concentration column are 
used to create the calibration curve. If a report is generated that 
includes information about the standards, the report will also include 
the correction factors and corrected concentrations.

Standards Table Contains concentration and other information about the standards. 
To add information from a .csv (comma separated values) file or .tsv 
(tab separated values) file, click Import Standards. To save the 
information in a .csv file or .tsv file, click Export Standards.



 4 INSIGHT Bio Applications
Protein Bradford

Thermo Scientific Evolution 200 Series Spectrophotometer User Guide 249

Related Topics

Working With Standard Curves

Type Tab for Protein Bradford

Measurement Tab for Protein Bradford

Instrument Tab for Protein Bradford

Accessories Tab for Protein Bradford

Samples Tab for Protein Bradford

Instrument Tab for Protein Bradford

Click Settings in Protein Bradford to display the 
Instrument tab in the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Related Topics

Type Tab for Protein Bradford

Measurement Tab for Protein Bradford

Standards Tab for Protein Bradford

Accessories Tab for Protein Bradford

Samples Tab for Protein Bradford

Accessories Tab for Protein Bradford

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Related Topics

Type Tab for Protein Bradford

Measurement Tab for Protein Bradford

Standards Tab for Protein Bradford

Instrument Tab for Protein Bradford

Samples Tab for Protein Bradford

Samples Tab for Protein Bradford

Click Settings in Protein Bradford to display the 
Accessories tab in the right pane. The available 
parameters depend on the installed accessories. For more 
information,  refer to the user guide for the accessory or 
search for “Evolution 200 Series Accessories” in the 
INSIGHT Help system.

Click Settings in Protein Bradford to display the 
Samples tab in the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.
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Related Topics

Type Tab for Protein Bradford

Measurement Tab for Protein Bradford

Standards Tab for Protein Bradford

Instrument Tab for Protein Bradford

Accessories Tab for Protein Bradford

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use sample 
correction factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table.

Use weight/volume 
correction

If available for the current unit, corrects sample concentrations using 
the entered target weight and volume:

corrected concentration = measured concentration * (actual weight / 
target weight) * (target volume / actual volume)

Use control limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table.

Save Samples Saves the contents of the samples table in a .tsv (tab separated values) 
file or .csv (comma separated values) file in a specified location.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Feature Description
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Unique Screen Features

Advanced calculations

For selecting predefined formulas for additional data processing, with the results appearing in 
a calculations table at the bottom of the right pane. Options include basic math and statistics. 
The formulas can be applied to specific samples and columns of data in the sample 
measurements table or to selected rows and columns in the calculations table for the current 
workbook or template. Calculations are applied to all subsequently acquired data. Custom 
calculations are saved with the workbook or template. Available for all applications except 
Rate.

To delete the contents of a cell in the calculations table, right-click the cell and choose Delete.

 To add column and row headings to the calculations table

1. Double-click a cell that needs a heading or other label.

2. In the Cell Properties box, choose Text.

3. Type the heading or label text.

4. To select the background color for the text displayed in the calculations table, click 
Background, choose a color and click OK.

5. To display the cell contents in bold text, click Bold Text.

6. Click OK.

 To define calculations based on the samples table

1. In the calculations table, double-click the cell where you want the calculation result to 
appear.

2. In the Cell Properties box, choose Calculation.

3. Select an Equation in the list.

The available equations are fixed.

4. Set Source to Samples table.

5. Select a sample measurement in the Measurements list.

6. Specify the sample rows to include by entering their ID numbers in the Range/Reference 
box.

Use a colon to specify a range (e.g., 2:5 or 1:N) or commas for individual samples (e.g., 
1,3,5).

These features are to the left of the spectral display:
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7. To select the background color for the cell that displays the calculated result, click 
Background, choose a color and click OK.

8. To display the cell contents in bold text, click Bold Text.

9. Choose OK.

The calculated result appears in the selected cell.

 To define a calculation based on the calculations table

1. In the calculations table, double-click the cell where you want the calculation result to 
appear.

2. In the Cell Properties box, choose Calculation.

3. Select an Equation in the list.

4. Set Source to Calculations Table.

5. Specify the table cells to include by entering their IDs in the Range/Reference box.

If Equation is set to Std. Deviation, Mean, or %RSD, use a colon to specify a range (e.g., 
A2:A5 or A1:AN) or commas for individual cells (e.g., A1,A3,A5).

If Equation is set to Addition, Subtraction, Multiplication, or Division, specify one cell 
location in each Reference box. (e.g., A1).

If Equation is set to a Factor, use the first (Reference) box to specify a cell location and 
the second (Factor) box to enter the factor.

6. To select the background color for the cell that displays the calculated result, click 
Background, choose a color and click OK.

7. To display the cell contents in bold text, click Bold Text.

8. Choose OK.

The calculated result appears in the selected cell.

Related Topics

Overview

Application Settings

Data Display

Making Protein Bradford Assay Measurements
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Making Protein Bradford Assay Measurements

See Sample and Standards Preparation for more information.

 To make Bradford assay measurements

1. Click Measure Protein Bradford in Protein Bradford.

2. If standards need to be acquired, click Measure. If standards have already been acquired, 
skip to step 7 to acquire sample data.

3. Follow the instructions that appear.

Use the appropriate buffer for the blank. See the reagent directions for details.

4. When the standards information appears, modify it if desired.

More:

If Standard averaging on the Standards tab in Settings was set to Duplicate, “D” at the 
end of a standard name indicates the second measurement to be made of the standard. If 
Sample averaging was set to Triplicate, “D” and “T” at the end of standard names indicate 
the second and third measurements to be made, respectively.

To enter previously saved standards information, use Import Standards.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each standard in the table.

To remove a standard, select it, right-click the table and choose Clear Standard. To 
remove all the standards, choose Clear Table.

To save standards information for later use, use Export Standards.

5. Click Continue.

6. Follow the instructions that appear, installing the specified standards.

The Standard Curve(s) tab displays the resulting standard curve (or curves). Specify the 
standards to use for the curve (or curves) by selecting Yes or No in the Use column in the 
table.

More:

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.
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The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

If Standard averaging was set to Duplicate, “D” at the end of a standard name indicates 
the second measurement. If Standard averaging was set to Triplicate, “D” and “T” 
indicate the second and third measurements, respectively.

To permanently remove an acquired standard from the analysis, right-click it and choose 
Remove. Its information is crossed out but not removed from the table.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
standard selected in the table. To access commands for customizing the display, including 
adding annotation, right-click the data. See Data Display for more information.

7. Click Measure.

8. Follow the instructions that appear.

9. When samples information appears, modify it if desired.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each sample in the table.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

If a standard curve is not calibrated...

• Try selecting a different curve fit type.

• Try remeasuring a standard using the correct standard material: 
select the listed standard, right-click the table and choose 
Remeasure.

• Try changing the setting of Minimum r2 on the Standards tab and 
acquire the standards again in a new workbook.

This is only an indicator that the required minimum number of points 
have been established for the selected curve fit type. It does not validate 
the integrity of the curve. For example, additional standards may be 
required to cover the expected assay concentration range.
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To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

10. If only one sample will be measured, install it.

11. Click Continue.

12. Follow any instructions that appear, such as to install a specified sample.

The sample results table contains the columns of information specified on the 
Configuration tab in Reports. If Sample averaging was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement. If Sample averaging was set to 
Triplicate, “D” and “T” indicate the second and third measurements, respectively.

The Standard Curve(s) tab shows graphically the relationship between the standard curve, 
measured spectral intensity and calculated concentration for the selected sample: A 
horizontal line connects the sample spectral intensity value on the Y-axis to the standard 
curve. A vertical line connects that point to the sample concentration value on the X-axis:

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:
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To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

To copy the data on the Standard Curve(s) tab or Run Chart tab, right-click the plot and 
choose Copy to Clipboard.

Related Topics

Overview

Application Settings

Data Display

Unique Screen Features

Working With Standard Curves

Pierce Modified Lowry

Overview

This assay is an alternative method for determining protein concentration based on the widely 
used and cited Lowry procedure for protein quantitation. Like the other colorimetric assays, 
the Lowry assay requires generating a standard curve before measuring sample proteins. 

The Pierce Modified Lowry procedure involves reaction of protein with cupric sulfate in 
alkaline solution, resulting in formation of tetradentate copper-protein complexes. The 
Folin-Ciocalteu Reagent is effectively reduced in proportion to the chelated 
copper-complexes, resulting in a water-soluble blue product that is measured at 650 nm and 
normalized at 405 nm. Preformulated reagents, used in the assay, are available in kit form 
from numerous manufacturers.

Contents

• Overview

• Application Settings

• Unique Screen Features

• Making Pierce Modified Lowry Assay Measurements

The Pierce Modified Lowry assay measures absorbance at 
750 nm to determine concentration.
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Modified Lowry Kits and Protocols

Follow the assay kit manufacturer’s recommendations for all standards and samples 
(unknowns). Ensure each is subjected to the same timing and temperature throughout the 
assay.

Protein standards (BSA) for generating a standard curve may also be provided by the 
manufacturer for the Lowry assay.

Working With Standard Curves

A standard curve is required for colorimetric protein analysis. Here are tips on creating a 
standard curve:

• A standard curve can be generated using two or more standards.

• The multipoint curve capability allows multiple replicates for each standard. Standards 
can be run in any order; however, best practice dictates that the standards be measured 
from the lowest concentration to the highest.

• Determine whether or not to use a standard when analyzing samples against the standard 
curve.

• Establishing a new standard curve requires creating a new workbook.

• If a previously saved workbook is used, all concentration calculations for newly measured 
samples will be based on the standard absorbance values saved in the workbook.

Related Topics

Application Settings

Data Display

Unique Screen Features

Making Pierce Modified Lowry Assay Measurements

Application Settings

Note  Each workbook will archive only one standard curve.

To set data acquisition parameters for a Pierce Modified 
Lowry workbook, click Settings.
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The follow tabs of settings are available:
Type Tab for Pierce Modified Lowry
Measurement Tab for Pierce Modified Lowry
Standards Tab for Pierce Modified Lowry
Instrument Tab for Pierce Modified Lowry
Accessories Tab for Pierce Modified Lowry
Samples Tab for Pierce Modified Lowry

Related Topics

Overview

Data Display

Unique Screen Features

Making Pierce Modified Lowry Assay Measurements

Type Tab for Pierce Modified Lowry

Related Topics

Measurement Tab for Pierce Modified Lowry

Standards Tab for Pierce Modified Lowry

Instrument Tab for Pierce Modified Lowry

Accessories Tab for Pierce Modified Lowry

Samples Tab for Pierce Modified Lowry

Measurement Tab for Pierce Modified Lowry

Click Settings in Pierce Modified Lowry to display the 
Type tab in the right pane.

Feature Description

Name Application name.

Description (optional) Description of the template.

Standard curve Type of quantitative analysis used.

Pathlength Distance the light travels through the sample.

Click Settings in Protein Lowry to display the 
Measurement tab in the right pane.
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Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

• Single point. Enter a wavelength value to define the endpoint for 
the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the specified 
baseline point and calculating the absorbance value on the drawn 
baseline at the specified analytical wavelength. The software 
subtracts the calculated baseline absorbance value from the 
measured absorbance value and reports the corrected absorbance

• Sloping baseline. Enter two wavelength values to define the 
endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value from 
the measured absorbance value and reports the corrected 
absorbance.

• None. Uses uncorrected data. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, 
the calculated protein concentration may be higher than the true 
value.

Component name Component to quantify.
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Related Topics

Type Tab for Pierce Modified Lowry

Standards Tab for Pierce Modified Lowry

Instrument Tab for Pierce Modified Lowry

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

 To add one or more predefined formulas

1. Click Select.

2. For each desired formula, select it in the list and click Add.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click Close.

 To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available units depend on the Formulas & Units tab settings.

Feature Description
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Accessories Tab for Pierce Modified Lowry

Samples Tab for Pierce Modified Lowry

Standards Tab for Pierce Modified Lowry

Click Settings in Pierce Modified Lowry to display the 
Standards tab in the right pane.

Feature Description

Curve fit type Type of equation used to create the standard curve from standard 
concentration values.

Standard averaging Whether and how to average concentration values from multiple 
measurements of the same standard or from multiple standards 
prepared under the same conditions. To average multiple 
measurements of the same standard, select Replicate and set Number 
of replicates to the total number of measurements. To average values 
from two or three similar standards, select Duplicate or Triplicate, 
respectively.

Minimum r2 The r2 value indicates how well the standard curve fits the standard 
data points, with 1.0 a perfect fit. If Minimum r2 is selected, samples 
can be quantified only after that value is achieved for the standard 
curve.

Calculate from 
weight/volume

If available for the current unit, calculates concentration when the 
weight and volume of material used to prepare each standard is 
known. Enter the weight and volume for each standard in the 
appropriate table cells, or enter it later as part of running an analysis.

Use correction 
factor

If available and selected, specifies a multiplication factor for each 
standard. Can be used to correct for standard properties (percent 
purity, water content, etc.) or preparation steps that affect the 
measured result such as a dilution.

When this option is selected, two columns are added to the standards 
table: Correction Factor and Corrected Concentration. In the 
Correction Factor column, enter the desired factor for each standard 
in the table. The values in the Corrected Concentration column are 
used to create the calibration curve. If a report is generated that 
includes information about the standards, the report will also include 
the correction factors and corrected concentrations.

Standards Table Contains concentration and other information about the standards. 
To add information from a .csv (comma separated values) file or .tsv 
(tab separated values) file, click Import Standards. To save the 
information in a .csv file or .tsv file, click Export Standards.
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Related Topics

Working With Standard Curves

Type Tab for Pierce Modified Lowry

Measurement Tab for Pierce Modified Lowry

Instrument Tab for Pierce Modified Lowry

Accessories Tab for Pierce Modified Lowry

Samples Tab for Pierce Modified Lowry

Instrument Tab for Pierce Modified Lowry

Click Settings in Pierce Modified Lowry to display the 
Instrument tab in the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Related Topics

Type Tab for Pierce Modified Lowry

Measurement Tab for Pierce Modified Lowry

Standards Tab for Pierce Modified Lowry

Accessories Tab for Pierce Modified Lowry

Samples Tab for Pierce Modified Lowry

Accessories Tab for Pierce Modified Lowry

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Related Topics

Type Tab for Pierce Modified Lowry

Measurement Tab for Pierce Modified Lowry

Standards Tab for Pierce Modified Lowry

Instrument Tab for Pierce Modified Lowry

Samples Tab for Pierce Modified Lowry

Samples Tab for Pierce Modified Lowry

Click Settings in Pierce Modified Lowry to display the 
Accessories tab in the right pane. The available 
parameters depend on the installed accessories. For more 
information,  refer to the user guide for the accessory or 
search for “Evolution 200 Series Accessories” in the 
INSIGHT Help system.

Click Settings in Pierce Modified Lowry to display the 
Samples tab in the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.
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Related Topics

Type Tab for Pierce Modified Lowry

Measurement Tab for Pierce Modified Lowry

Standards Tab for Pierce Modified Lowry

Instrument Tab for Pierce Modified Lowry

Accessories Tab for Pierce Modified Lowry

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use sample 
correction factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table.

Use weight/volume 
correction

If available for the current unit, corrects sample concentrations using 
the entered target weight and volume:

corrected concentration = measured concentration * (actual weight / 
target weight) * (target volume / actual volume)

Use control limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table.

Save Samples Saves the contents of the samples table in a .tsv (tab separated values) 
file or .csv (comma separated values) file in a specified location.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Feature Description
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Unique Screen Features

Advanced calculations

For selecting predefined formulas for additional data processing, with the results appearing in 
a calculations table at the bottom of the right pane. Options include basic math and statistics. 
The formulas can be applied to specific samples and columns of data in the sample 
measurements table or to selected rows and columns in the calculations table for the current 
workbook or template. Calculations are applied to all subsequently acquired data. Custom 
calculations are saved with the workbook or template. Available for all applications except 
Rate.

To delete the contents of a cell in the calculations table, right-click the cell and choose Delete.

 To add column and row headings to the calculations table

1. Double-click a cell that needs a heading or other label.

2. In the Cell Properties box, choose Text.

3. Type the heading or label text.

4. To select the background color for the text displayed in the calculations table, click 
Background, choose a color and click OK.

5. To display the cell contents in bold text, click Bold Text.

6. Click OK.

 To define calculations based on the samples table

1. In the calculations table, double-click the cell where you want the calculation result to 
appear.

2. In the Cell Properties box, choose Calculation.

3. Select an Equation in the list.

The available equations are fixed.

4. Set Source to Samples table.

5. Select a sample measurement in the Measurements list.

6. Specify the sample rows to include by entering their ID numbers in the Range/Reference 
box.

Use a colon to specify a range (e.g., 2:5 or 1:N) or commas for individual samples (e.g., 
1,3,5).

These features are to the left of the spectral display:
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7. To select the background color for the cell that displays the calculated result, click 
Background, choose a color and click OK.

8. To display the cell contents in bold text, click Bold Text.

9. Choose OK.

The calculated result appears in the selected cell.

 To define a calculation based on the calculations table

1. In the calculations table, double-click the cell where you want the calculation result to 
appear.

2. In the Cell Properties box, choose Calculation.

3. Select an Equation in the list.

4. Set Source to Calculations Table.

5. Specify the table cells to include by entering their IDs in the Range/Reference box.

If Equation is set to Std. Deviation, Mean, or %RSD, use a colon to specify a range (e.g., 
A2:A5 or A1:AN) or commas for individual cells (e.g., A1,A3,A5).

If Equation is set to Addition, Subtraction, Multiplication, or Division, specify one cell 
location in each Reference box. (e.g., A1).

If Equation is set to a Factor, use the first (Reference) box to specify a cell location and 
the second (Factor) box to enter the factor.

6. To select the background color for the cell that displays the calculated result, click 
Background, choose a color and click OK.

7. To display the cell contents in bold text, click Bold Text.

8. Choose OK.

The calculated result appears in the selected cell.

Related Topics

Overview

Application Settings

Data Display

Making Pierce Modified Lowry Assay Measurements
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Making Pierce Modified Lowry Assay Measurements

See Sample and Standards Preparation for more information.

 To make Pierce Modified Lowry Assay measurements

1. Click Measure Pierce Modified Lowry in Pierce Modified Lowry.

2. If standards need to be acquired, click Measure. If standards have already been acquired, 
skip to step 7 to acquire sample data.

3. Follow the instructions that appear.

Use the appropriate buffer for the blank. See the reagent directions for details.

4. When the standards information appears, modify it if desired.

More:

If Standard averaging on the Standards tab in Settings was set to Duplicate, “D” at the 
end of a standard name indicates the second measurement to be made of the standard. If 
Sample averaging was set to Triplicate, “D” and “T” at the end of standard names indicate 
the second and third measurements to be made, respectively.

To enter previously saved standards information, use Import Standards.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each standard in the table.

To remove a standard, select it, right-click the table and choose Clear Standard. To 
remove all the standards, choose Clear Table.

To save standards information for later use, use Export Standards.

5. Click Continue.

6. Follow the instructions that appear, installing the specified standards.

The Standard Curve(s) tab displays the resulting standard curve (or curves). Specify the 
standards to use for the curve (or curves) by selecting Yes or No in the Use column in the 
table.

More:

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.
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The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

If Standard averaging was set to Duplicate, “D” at the end of a standard name indicates 
the second measurement. If Standard averaging was set to Triplicate, “D” and “T” 
indicate the second and third measurements, respectively.

To permanently remove an acquired standard from the analysis, right-click it and choose 
Remove. Its information is crossed out but not removed from the table.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
standard selected in the table. To access commands for customizing the display, including 
adding annotation, right-click the data. See Data Display for more information.

7. Click Measure.

8. Follow the instructions that appear.

9. When samples information appears, modify it if desired.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each sample in the table.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

If a standard curve is not calibrated...

• Try selecting a different curve fit type.

• Try remeasuring a standard using the correct standard material: 
select the listed standard, right-click the table and choose 
Remeasure.

• Try changing the setting of Minimum r2 on the Standards tab and 
acquire the standards again in a new workbook.

This is only an indicator that the required minimum number of points 
have been established for the selected curve fit type. It does not validate 
the integrity of the curve. For example, additional standards may be 
required to cover the expected assay concentration range.
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To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

10. If only one sample will be measured, install it.

11. Click Continue.

12. Follow any instructions that appear, such as to install a specified sample.

The sample results table contains the columns of information specified on the 
Configuration tab in Reports. If Sample averaging was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement. If Sample averaging was set to 
Triplicate, “D” and “T” indicate the second and third measurements, respectively.

The Standard Curve(s) tab shows graphically the relationship between the standard curve, 
measured spectral intensity and calculated concentration for the selected sample: A 
horizontal line connects the sample spectral intensity value on the Y-axis to the standard 
curve. A vertical line connects that point to the sample concentration value on the X-axis:

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:
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To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

To copy the data on the Standard Curve(s) tab or Run Chart tab, right-click the plot and 
choose Copy to Clipboard.

Related Topics

Overview

Application Settings

Data Display

Unique Screen Features

Working With Standard Curves

Pierce 660 nm Protein Assay

Overview

The proprietary dye-metal complex binds to protein in acidic conditions, causing a shift in 
the dye’s absorption maximum, which is measured at 660 nm. The complex is reddish-brown 
and turns green upon protein binding. This color change is produced by deprotonation of the 
dye at low pH facilitated by interactions with positively charged amino acid groups in the 
protein. Consequently, the complex interacts primarily with basic residues in the protein, such 
as histidine, arginine and lysine, and to a lesser extent tyrosine, tryptophan and phenylalanine.

Contents

• Overview

• Application Settings

• Unique Screen Features

• Making Pierce 660 nm Protein Assay Measurements

The Thermo Scientific Pierce 660 nm Protein Assay 
reagent is a ready-to-use formulation that offers rapid, 
accurate and reproducible colorimetric detection of 
minute amounts of protein in solution. The reagent is 
ideal for measuring total protein concentration in samples 
containing reducing agents and/or detergents.
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Pierce 660 nm Reagent and Protocols

Follow the assay kit manufacturer’s recommendations for all standards and samples 
(unknowns), ensuring they are subjected to the same timing and temperature throughout the 
assay.

Protein standards (BSA) for generating a standard curve may also be provided by the Pierce 
660 nm assay manufacturer.

Working With Standard Curves

A standard curve is required for colorimetric protein analysis. Here are tips on creating a 
standard curve:

• A standard curve can be generated using two or more standards.

• The multipoint curve capability allows multiple replicates for each standard. Standards 
can be run in any order; however, best practice dictates that the standards be measured 
from the lowest concentration to the highest.

• Determine whether or not to use a standard when analyzing samples against the standard 
curve.

• Establishing a new standard curve requires creating a new workbook.

• If a previously saved workbook is used, all concentration calculations for newly measured 
samples will be based on the standard absorbance values saved in the workbook.

Related Topics

Application Settings

Data Display

Unique Screen Features

Making Pierce 660 nm Protein Assay Measurements

Application Settings

Note  Each workbook will archive only one standard curve.

To set data acquisition parameters for a Pierce 660 nm 
Protein Assay workbook, click Settings.
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The follow tabs of settings are available:
Type Tab for Pierce 660 nm Protein Assay
Measurement Tab for Pierce 660 nm Protein Assay
Standards Tab for Pierce 660 nm Protein Assay
Instrument Tab for Pierce 660 nm Protein Assay
Accessories Tab for Pierce 660 nm Protein Assay
Samples Tab for Pierce 660 nm Protein Assay

Related Topics

Overview

Data Display

Unique Screen Features

Making Pierce 660 nm Protein Assay Measurements

Type Tab for Pierce 660 nm Protein Assay

Related Topics

Measurement Tab for Pierce 660 nm Protein Assay

Standards Tab for Pierce 660 nm Protein Assay

Instrument Tab for Pierce 660 nm Protein Assay

Accessories Tab for Pierce 660 nm Protein Assay

Samples Tab for Pierce 660 nm Protein Assay

Measurement Tab for Pierce 660 nm Protein Assay

Click Settings in Pierce 660 nm Protein Assay to display 
the Type tab in the right pane.

Feature Description

Name Application name.

Description (optional) Description of the template.

Standard curve Type of quantitative analysis used.

Pathlength Distance the light travels through the sample.

Click Settings in Pierce 660 nm Protein Assay to display 
the Measurement tab in the right pane.
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Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

• Single point. Enter a wavelength value to define the endpoint for 
the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the specified 
baseline point and calculating the absorbance value on the drawn 
baseline at the specified analytical wavelength. The software 
subtracts the calculated baseline absorbance value from the 
measured absorbance value and reports the corrected absorbance

• Sloping baseline. Enter two wavelength values to define the 
endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value from 
the measured absorbance value and reports the corrected 
absorbance.

• None. Uses uncorrected data. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, 
the calculated protein concentration may be higher than the true 
value.

Component name Component to quantify.
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Related Topics

Type Tab for Pierce 660 nm Protein Assay

Standards Tab for Pierce 660 nm Protein Assay

Instrument Tab for Pierce 660 nm Protein Assay

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

 To add one or more predefined formulas

1. Click Select.

2. For each desired formula, select it in the list and click Add.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click Close.

 To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available units depend on the Formulas & Units tab settings.

Feature Description
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Accessories Tab for Pierce 660 nm Protein Assay

Samples Tab for Pierce 660 nm Protein Assay

Standards Tab for Pierce 660 nm Protein Assay

Click Settings in Pierce 660 nm Protein Assay to display 
the Standards tab in the right pane.

Feature Description

Curve fit type Type of equation used to create the standard curve from standard 
concentration values.

Standard averaging Whether and how to average concentration values from multiple 
measurements of the same standard or from multiple standards 
prepared under the same conditions. To average multiple 
measurements of the same standard, select Replicate and set Number 
of replicates to the total number of measurements. To average values 
from two or three similar standards, select Duplicate or Triplicate, 
respectively.

Minimum r2 The r2 value indicates how well the standard curve fits the standard 
data points, with 1.0 a perfect fit. If Minimum r2 is selected, samples 
can be quantified only after that value is achieved for the standard 
curve.

Calculate from 
weight/volume

If available for the current unit, calculates concentration when the 
weight and volume of material used to prepare each standard is 
known. Enter the weight and volume for each standard in the 
appropriate table cells, or enter it later as part of running an analysis.

Use correction 
factor

If available and selected, specifies a multiplication factor for each 
standard. Can be used to correct for standard properties (percent 
purity, water content, etc.) or preparation steps that affect the 
measured result such as a dilution.

When this option is selected, two columns are added to the standards 
table: Correction Factor and Corrected Concentration. In the 
Correction Factor column, enter the desired factor for each standard 
in the table. The values in the Corrected Concentration column are 
used to create the calibration curve. If a report is generated that 
includes information about the standards, the report will also include 
the correction factors and corrected concentrations.

Standards Table Contains concentration and other information about the standards. 
To add information from a .csv (comma separated values) file or .tsv 
(tab separated values) file, click Import Standards. To save the 
information in a .csv file or .tsv file, click Export Standards.
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Related Topics

Working With Standard Curves

Type Tab for Pierce 660 nm Protein Assay

Measurement Tab for Pierce 660 nm Protein Assay

Instrument Tab for Pierce 660 nm Protein Assay

Accessories Tab for Pierce 660 nm Protein Assay

Samples Tab for Pierce 660 nm Protein Assay

Instrument Tab for Pierce 660 nm Protein Assay

Click Settings in Pierce 660 nm Protein Assay to display 
the Instrument tab in the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Related Topics

Type Tab for Pierce 660 nm Protein Assay

Measurement Tab for Pierce 660 nm Protein Assay

Standards Tab for Pierce 660 nm Protein Assay

Accessories Tab for Pierce 660 nm Protein Assay

Samples Tab for Pierce 660 nm Protein Assay

Accessories Tab for Pierce 660 nm Protein Assay

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Related Topics

Type Tab for Pierce 660 nm Protein Assay

Measurement Tab for Pierce 660 nm Protein Assay

Standards Tab for Pierce 660 nm Protein Assay

Instrument Tab for Pierce 660 nm Protein Assay

Samples Tab for Pierce 660 nm Protein Assay

Samples Tab for Pierce 660 nm Protein Assay

Click Settings in Pierce 660 nm Protein Assay to display 
the Accessories tab in the right pane. The available 
parameters depend on the installed accessories. For more 
information,  refer to the user guide for the accessory or 
search for “Evolution 200 Series Accessories” in the 
INSIGHT Help system.

Click Settings in Pierce 660 nm Protein Assay to display 
the Samples tab in the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.
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Related Topics

Type Tab for Pierce 660 nm Protein Assay

Measurement Tab for Pierce 660 nm Protein Assay

Standards Tab for Pierce 660 nm Protein Assay

Instrument Tab for Pierce 660 nm Protein Assay

Accessories Tab for Pierce 660 nm Protein Assay

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use sample 
correction factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table.

Use weight/volume 
correction

If available for the current unit, corrects sample concentrations using 
the entered target weight and volume:

corrected concentration = measured concentration * (actual weight / 
target weight) * (target volume / actual volume)

Use control limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table.

Save Samples Saves the contents of the samples table in a .tsv (tab separated values) 
file or .csv (comma separated values) file in a specified location.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Feature Description
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Unique Screen Features

Advanced calculations

For selecting predefined formulas for additional data processing, with the results appearing in 
a calculations table at the bottom of the right pane. Options include basic math and statistics. 
The formulas can be applied to specific samples and columns of data in the sample 
measurements table or to selected rows and columns in the calculations table for the current 
workbook or template. Calculations are applied to all subsequently acquired data. Custom 
calculations are saved with the workbook or template. Available for all applications except 
Rate.

To delete the contents of a cell in the calculations table, right-click the cell and choose Delete.

 To add column and row headings to the calculations table

1. Double-click a cell that needs a heading or other label.

2. In the Cell Properties box, choose Text.

3. Type the heading or label text.

4. To select the background color for the text displayed in the calculations table, click 
Background, choose a color and click OK.

5. To display the cell contents in bold text, click Bold Text.

6. Click OK.

 To define calculations based on the samples table

1. In the calculations table, double-click the cell where you want the calculation result to 
appear.

2. In the Cell Properties box, choose Calculation.

3. Select an Equation in the list.

The available equations are fixed.

4. Set Source to Samples table.

5. Select a sample measurement in the Measurements list.

6. Specify the sample rows to include by entering their ID numbers in the Range/Reference 
box.

Use a colon to specify a range (e.g., 2:5 or 1:N) or commas for individual samples (e.g., 
1,3,5).

These features are to the left of the spectral 
display:
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7. To select the background color for the cell that displays the calculated result, click 
Background, choose a color and click OK.

8. To display the cell contents in bold text, click Bold Text.

9. Choose OK.

The calculated result appears in the selected cell.

 To define a calculation based on the calculations table

1. In the calculations table, double-click the cell where you want the calculation result to 
appear.

2. In the Cell Properties box, choose Calculation.

3. Select an Equation in the list.

4. Set Source to Calculations Table.

5. Specify the table cells to include by entering their IDs in the Range/Reference box.

If Equation is set to Std. Deviation, Mean, or %RSD, use a colon to specify a range (e.g., 
A2:A5 or A1:AN) or commas for individual cells (e.g., A1,A3,A5).

If Equation is set to Addition, Subtraction, Multiplication, or Division, specify one cell 
location in each Reference box. (e.g., A1).

If Equation is set to a Factor, use the first (Reference) box to specify a cell location and 
the second (Factor) box to enter the factor.

6. To select the background color for the cell that displays the calculated result, click 
Background, choose a color and click OK.

7. To display the cell contents in bold text, click Bold Text.

8. Choose OK.

The calculated result appears in the selected cell.

Related Topics

Overview

Application Settings

Data Display

Making Pierce 660 nm Protein Assay Measurements
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Making Pierce 660 nm Protein Assay Measurements

See Sample and Standards Preparation for more information.

 To make Pierce 660 nm Protein assay measurements

1. Click Measure Pierce 660 nm Protein Assay in Pierce 660 nm Protein Assay.

2. If standards need to be acquired, click Measure. If standards have already been acquired, 
skip to step 7 to acquire sample data.

3. Follow the instructions that appear.

Use the appropriate buffer for the blank. See the reagent directions for details.

4. When the standards information appears, modify it if desired.

More:

If Standard averaging on the Standards tab in Settings was set to Duplicate, “D” at the 
end of a standard name indicates the second measurement to be made of the standard. If 
Sample averaging was set to Triplicate, “D” and “T” at the end of standard names indicate 
the second and third measurements to be made, respectively.

To enter previously saved standards information, use Import Standards.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each standard in the table.

To remove a standard, select it, right-click the table and choose Clear Standard. To 
remove all the standards, choose Clear Table.

To save standards information for later use, use Export Standards.

5. Click Continue.

6. Follow the instructions that appear, installing the specified standards.

The Standard Curve(s) tab displays the resulting standard curve (or curves). Specify the 
standards to use for the curve (or curves) by selecting Yes or No in the Use column in the 
table.

More:

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.
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The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

If Standard averaging was set to Duplicate, “D” at the end of a standard name indicates 
the second measurement. If Standard averaging was set to Triplicate, “D” and “T” 
indicate the second and third measurements, respectively.

To permanently remove an acquired standard from the analysis, right-click it and choose 
Remove. Its information is crossed out but not removed from the table.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
standard selected in the table. To access commands for customizing the display, including 
adding annotation, right-click the data. See Data Display for more information.

7. Click Measure.

8. Follow the instructions that appear.

9. When samples information appears, modify it if desired.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each sample in the table.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

If a standard curve is not calibrated...

• Try selecting a different curve fit type.

• Try remeasuring a standard using the correct standard material: 
select the listed standard, right-click the table and choose 
Remeasure.

• Try changing the setting of Minimum r2 on the Standards tab and 
acquire the standards again in a new workbook.

This is only an indicator that the required minimum number of points 
have been established for the selected curve fit type. It does not validate 
the integrity of the curve. For example, additional standards may be 
required to cover the expected assay concentration range.
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To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

10. If only one sample will be measured, install it.

11. Click Continue.

12. Follow any instructions that appear, such as to install a specified sample.

The sample results table contains the columns of information specified on the 
Configuration tab in Reports. If Sample averaging was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement. If Sample averaging was set to 
Triplicate, “D” and “T” indicate the second and third measurements, respectively.

The Standard Curve(s) tab shows graphically the relationship between the standard curve, 
measured spectral intensity and calculated concentration for the selected sample: A 
horizontal line connects the sample spectral intensity value on the Y-axis to the standard 
curve. A vertical line connects that point to the sample concentration value on the X-axis:

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:
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To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

To copy the data on the Standard Curve(s) tab or Run Chart tab, right-click the plot and 
choose Copy to Clipboard.

Related Topics

Overview

Application Settings

Data Display

Unique Screen Features

Working With Standard Curves

Protein Biuret

Overview

Working With Standard Curves

A standard curve is required for colorimetric protein analysis. Here are tips on creating a 
standard curve:

• A standard curve can be generated using two or more standards.

Contents

• Overview

• Application Settings

• Unique Screen Features

• Making Protein Biuret Assay Measurements

The Protein Biuret application is similar to the Pierce 
Modified Lowry application; however, it involves a single 
incubation and requires more protein for the analysis. The 
protein-dye complex that is formed in the assay has a deep 
purple color and is measured at 545 nm. The calibration 
curve for this assay is linear with standards that range in 
concentration from 0.5 mg/ml to 10 mg/ml.
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• The multipoint curve capability allows multiple replicates for each standard. Standards 
can be run in any order; however, best practice dictates that the standards be measured 
from the lowest concentration to the highest.

• Determine whether or not to use a standard when analyzing samples against the standard 
curve.

• Establishing a new standard curve requires creating a new workbook.

• If a previously saved workbook is used, all concentration calculations for newly measured 
samples will be based on the standard absorbance values saved in the workbook.

Related Topics

Application Settings

Data Display

Unique Screen Features

Making Protein Biuret Assay Measurements

Application Settings

The follow tabs of settings are available:
Type Tab for Protein Biuret
Measurement Tab for Protein Biuret
Standards Tab for Protein Biuret
Instrument Tab for Protein Biuret
Accessories Tab for Protein Biuret
Samples Tab for Protein Biuret

Related Topics

Overview

Data Display

Unique Screen Features

Making Protein Biuret Assay Measurements

Note  Each workbook will archive only one standard curve.

To set data acquisition parameters for a Protein Biuret 
workbook, click Settings.
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Type Tab for Protein Biuret

Related Topics

Measurement Tab for Protein Biuret

Standards Tab for Protein Biuret

Instrument Tab for Protein Biuret

Accessories Tab for Protein Biuret

Samples Tab for Protein Biuret

Measurement Tab for Protein Biuret

Click Settings in Protein Biuret to display the Type tab 
in the right pane.

Feature Description

Name Application name.

Description (optional) Description of the template.

Standard curve Type of quantitative analysis used.

Pathlength Distance the light travels through the sample.

Click Settings in Protein Biuret to display the 
Measurement tab in the right pane.
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Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

• Single point. Enter a wavelength value to define the endpoint for 
the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the specified 
baseline point and calculating the absorbance value on the drawn 
baseline at the specified analytical wavelength. The software 
subtracts the calculated baseline absorbance value from the 
measured absorbance value and reports the corrected absorbance

• Sloping baseline. Enter two wavelength values to define the 
endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value from 
the measured absorbance value and reports the corrected 
absorbance.

• None. Uses uncorrected data. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, 
the calculated protein concentration may be higher than the true 
value.

Component name Component to quantify.
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Related Topics

Type Tab for Protein Biuret

Standards Tab for Protein Biuret

Instrument Tab for Protein Biuret

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

 To add one or more predefined formulas

1. Click Select.

2. For each desired formula, select it in the list and click Add.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click Close.

 To define a formula

1. Click Build.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings.

3. Click OK.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available units depend on the Formulas & Units tab settings.

Feature Description



4 INSIGHT Bio Applications
Protein Biuret

290 Evolution 200 Series Spectrophotometer User Guide Thermo Scientific

Accessories Tab for Protein Biuret

Samples Tab for Protein Biuret

Standards Tab for Protein Biuret

Click Settings in Protein Biuret to display the Standards 
tab in the right pane.

Feature Description

Curve fit type Type of equation used to create the standard curve from standard 
concentration values.

Standard averaging Whether and how to average concentration values from multiple 
measurements of the same standard or from multiple standards 
prepared under the same conditions. To average multiple 
measurements of the same standard, select Replicate and set Number 
of replicates to the total number of measurements. To average values 
from two or three similar standards, select Duplicate or Triplicate, 
respectively.

Minimum r2 The r2 value indicates how well the standard curve fits the standard 
data points, with 1.0 a perfect fit. If Minimum r2 is selected, samples 
can be quantified only after that value is achieved for the standard 
curve.

Calculate from 
weight/volume

If available for the current unit, calculates concentration when the 
weight and volume of material used to prepare each standard is 
known. Enter the weight and volume for each standard in the 
appropriate table cells, or enter it later as part of running an analysis.

Use correction 
factor

If available and selected, specifies a multiplication factor for each 
standard. Can be used to correct for standard properties (percent 
purity, water content, etc.) or preparation steps that affect the 
measured result such as a dilution.

When this option is selected, two columns are added to the standards 
table: Correction Factor and Corrected Concentration. In the 
Correction Factor column, enter the desired factor for each standard 
in the table. The values in the Corrected Concentration column are 
used to create the calibration curve. If a report is generated that 
includes information about the standards, the report will also include 
the correction factors and corrected concentrations.

Standards Table Contains concentration and other information about the standards. 
To add information from a .csv (comma separated values) file or .tsv 
(tab separated values) file, click Import Standards. To save the 
information in a .csv file or .tsv file, click Export Standards.
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Related Topics

Working With Standard Curves

Type Tab for Protein Biuret

Measurement Tab for Protein Biuret

Instrument Tab for Protein Biuret

Accessories Tab for Protein Biuret

Samples Tab for Protein Biuret

Instrument Tab for Protein Biuret

Click Settings in Protein Biuret to display the 
Instrument tab in the right pane.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data.

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Related Topics

Type Tab for Protein Biuret

Measurement Tab for Protein Biuret

Standards Tab for Protein Biuret

Accessories Tab for Protein Biuret

Samples Tab for Protein Biuret

Accessories Tab for Protein Biuret

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Related Topics

Type Tab for Protein Biuret

Measurement Tab for Protein Biuret

Standards Tab for Protein Biuret

Instrument Tab for Protein Biuret

Samples Tab for Protein Biuret

Samples Tab for Protein Biuret

Click Settings in Protein Biuret to display the 
Accessories tab in the right pane. The available 
parameters depend on the installed accessories. For more 
information,  refer to the user guide for the accessory or 
search for “Evolution 200 Series Accessories” in the 
INSIGHT Help system.

Click Settings in Protein Biuret to display the Samples 
tab in the right pane.

Feature Description

Number of samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.
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Related Topics

Type Tab for Protein Biuret

Measurement Tab for Protein Biuret

Standards Tab for Protein Biuret

Instrument Tab for Protein Biuret

Accessories Tab for Pierce 660 nm Protein Assay

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use sample 
correction factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table.

Use weight/volume 
correction

If available for the current unit, corrects sample concentrations using 
the entered target weight and volume:

corrected concentration = measured concentration * (actual weight / 
target weight) * (target volume / actual volume)

Use control limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table.

Save Samples Saves the contents of the samples table in a .tsv (tab separated values) 
file or .csv (comma separated values) file in a specified location.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Feature Description
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Unique Screen Features

Advanced calculations

For selecting predefined formulas for additional data processing, with the results appearing in 
a calculations table at the bottom of the right pane. Options include basic math and statistics. 
The formulas can be applied to specific samples and columns of data in the sample 
measurements table or to selected rows and columns in the calculations table for the current 
workbook or template. Calculations are applied to all subsequently acquired data. Custom 
calculations are saved with the workbook or template. Available for all applications except 
Rate.

To delete the contents of a cell in the calculations table, right-click the cell and choose Delete.

 To add column and row headings to the calculations table

1. Double-click a cell that needs a heading or other label.

2. In the Cell Properties box, choose Text.

3. Type the heading or label text.

4. To select the background color for the text displayed in the calculations table, click 
Background, choose a color and click OK.

5. To display the cell contents in bold text, click Bold Text.

6. Click OK.

 To define calculations based on the samples table

1. In the calculations table, double-click the cell where you want the calculation result to 
appear.

2. In the Cell Properties box, choose Calculation.

3. Select an Equation in the list.

The available equations are fixed.

4. Set Source to Samples table.

5. Select a sample measurement in the Measurements list.

6. Specify the sample rows to include by entering their ID numbers in the Range/Reference 
box.

Use a colon to specify a range (e.g., 2:5 or 1:N) or commas for individual samples (e.g., 
1,3,5).

These features are to the left of the spectral display:



 4 INSIGHT Bio Applications
Protein Biuret

Thermo Scientific Evolution 200 Series Spectrophotometer User Guide 295

7. To select the background color for the cell that displays the calculated result, click 
Background, choose a color and click OK.

8. To display the cell contents in bold text, click Bold Text.

9. Choose OK.

The calculated result appears in the selected cell.

 To define a calculation based on the calculations table

1. In the calculations table, double-click the cell where you want the calculation result to 
appear.

2. In the Cell Properties box, choose Calculation.

3. Select an Equation in the list.

4. Set Source to Calculations Table.

5. Specify the table cells to include by entering their IDs in the Range/Reference box.

If Equation is set to Std. Deviation, Mean, or %RSD, use a colon to specify a range (e.g., 
A2:A5 or A1:AN) or commas for individual cells (e.g., A1,A3,A5).

If Equation is set to Addition, Subtraction, Multiplication, or Division, specify one cell 
location in each Reference box. (e.g., A1).

If Equation is set to a Factor, use the first (Reference) box to specify a cell location and 
the second (Factor) box to enter the factor.

6. To select the background color for the cell that displays the calculated result, click 
Background, choose a color and click OK.

7. To display the cell contents in bold text, click Bold Text.

8. Choose OK.

The calculated result appears in the selected cell.

Related Topics

Overview

Application Settings

Data Display

Unique Screen Features

Making Protein Biuret Assay Measurements
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Making Protein Biuret Assay Measurements

See Sample and Standards Preparation for more information.

 To make Protein Biuret assay measurements

1. Click Measure Protein Biuret in Protein Biuret.

2. If standards need to be acquired, click Measure. If standards have already been acquired, 
skip to step 7 to acquire sample data.

3. Follow the instructions that appear.

Use the appropriate buffer for the blank. See the reagent directions for details.

4. When the standards information appears, modify it if desired.

More:

If Standard averaging on the Standards tab in Settings was set to Duplicate, “D” at the 
end of a standard name indicates the second measurement to be made of the standard. If 
Sample averaging was set to Triplicate, “D” and “T” at the end of standard names indicate 
the second and third measurements to be made, respectively.

To enter previously saved standards information, use Import Standards.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each standard in the table.

To remove a standard, select it, right-click the table and choose Clear Standard. To 
remove all the standards, choose Clear Table.

To save standards information for later use, use Export Standards.

5. Click Continue.

6. Follow the instructions that appear, installing the specified standards.

The Standard Curve(s) tab displays the resulting standard curve (or curves). Specify the 
standards to use for the curve (or curves) by selecting Yes or No in the Use column in the 
table.

More:

Note  To start an analysis immediately after viewing or changing the template settings, 
click the Measure action button instead and skip to step 3.
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The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

If Standard averaging was set to Duplicate, “D” at the end of a standard name indicates 
the second measurement. If Standard averaging was set to Triplicate, “D” and “T” 
indicate the second and third measurements, respectively.

To permanently remove an acquired standard from the analysis, right-click it and choose 
Remove. Its information is crossed out but not removed from the table.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
standard selected in the table. To access commands for customizing the display, including 
adding annotation, right-click the data. See Data Display for more information.

7. Click Measure.

8. Follow the instructions that appear.

9. When samples information appears, modify it if desired.

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each sample in the table.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

If a standard curve is not calibrated...

• Try selecting a different curve fit type.

• Try remeasuring a standard using the correct standard material: 
select the listed standard, right-click the table and choose 
Remeasure.

• Try changing the setting of Minimum r2 on the Standards tab and 
acquire the standards again in a new workbook.

This is only an indicator that the required minimum number of points 
have been established for the selected curve fit type. It does not validate 
the integrity of the curve. For example, additional standards may be 
required to cover the expected assay concentration range.
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To enter previously saved samples information, use Load Samples. To save the samples 
information, use Save Samples.

10. If only one sample will be measured, install it.

11. Click Continue.

12. Follow any instructions that appear, such as to install a specified sample.

The sample results table contains the columns of information specified on the 
Configuration tab in Reports. If Sample averaging was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement. If Sample averaging was set to 
Triplicate, “D” and “T” indicate the second and third measurements, respectively.

The Standard Curve(s) tab shows graphically the relationship between the standard curve, 
measured spectral intensity and calculated concentration for the selected sample: A 
horizontal line connects the sample spectral intensity value on the Y-axis to the standard 
curve. A vertical line connects that point to the sample concentration value on the X-axis:

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:
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To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

To copy the data on the Standard Curve(s) tab or Run Chart tab, right-click the plot and 
choose Copy to Clipboard.

Related Topics

Overview

Application Settings

Data Display

Unique Screen Features

Working With Standard Curves
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5

Performance Verification

Overview of PV

PV Test Descriptions
This section describes the performance tests that can be run manually if you have the required 
standards. Many of the tests described here may also be included in the CVC test suites. For 
information about the test samples included with each CVC and the corresponding test suite,  
refer to the to the CVC User Guide in the “Accessories” section or your documentation media.

Contents

• Overview of PV

• PV Test Descriptions

• Performing PV Tests

Use Performance Verification to set up and run tests to 
check the performance of the instrument. Individual 
performance tests can be run manually or automatically 
using a compatible CVC (Calibrated Validation Carousel) 
accessory. For information about the available CVC 
configurations, refer to the CVC User Guide in the 
“Accessories” section or your documentation media.

Click here for information on running the performance 
tests. Test results are displayed in reports that are saved 
automatically and can be opened later (see My Data).
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Test Description

Wavelength Accuracy
(Hg lamp)

Locates the peaks from a mercury lamp accessory and 
displays their measured and allowed range of 
wavelengths. A mercury lamp has strong, fundamental 
lines throughout the UV-visible range. These emission 
lines are a property of the lamp and serve as a 
fundamental wavelength standard that does not require 
calibration. The wavelengths and tolerance values 
cannot be changed.

To run this test, use an empty cell holder and install the 
Mercury Lamp calibration accessory properly in the 
instrument. For more information, refer to the Mercury 
Lamp User Guide in the “Accessories” section of your 
documentation set.

Wavelength Repeatability
(Hg lamp)

Measures the ability of the spectrophotometer to return 
to an identical wavelength in a repeatable manner. The 
test uses a mercury lamp accessory, which has a strong, 
fundamental line near 546 nm. This emission line is an 
intrinsic property of the lamp and serves as a 
fundamental wavelength standard that does not require 
calibration. The wavelength and tolerance values cannot 
be changed.

To run this test, use an empty cell holder and install the 
Mercury Lamp calibration accessory properly in the 
instrument. For more information, refer to the Mercury 
Lamp User Guide in the “Accessories” section of your 
documentation set.

Wavelength Accuracy
(Xe lamp)

Locates the peak near 542 nm of the internal xenon 
lamp and displays the measured and allowed range of 
wavelengths. A xenon lamp has strong, fundamental 
lines throughout the UV-visible range. These are an 
intrinsic property of the lamp and serve as a 
fundamental wavelength standard that does not require 
calibration. The wavelength and tolerance values cannot 
be changed.

To run this test, use an empty cell holder.
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Wavelength Repeatability 
(Xe lamp)

Measures the ability of the spectrophotometer to return 
to an identical wavelength in a repeatable manner. The 
test uses the internal xenon lamp, which has a strong, 
fundamental emission line near 542 nm. This line is a 
property of the lamp and serves as a fundamental 
wavelength standard that does not require calibration. 
The wavelength and tolerance values cannot be 
changed.

To run this test, use an empty cell holder.

Wavelength Accuracy 
(Holmium glass, CP)

Locates the peaks of a holmium glass standard and 
displays their measured and allowed range of 
wavelengths as defined in the Chinese Pharmacopeia for 
this standard. The wavelengths and tolerance values are 
predefined and cannot be changed.

To run this test, install a holmium glass standard in the 
instrument.

Wavelength Accuracy
(Holmium oxide liquid)

Locates the peaks of a holmium oxide standard and 
displays their measured and allowed range of 
wavelengths. A holmium oxide solution prepared in 
dilute perchloric acid has well defined absorption peaks 
throughout the UV-visible range. These peaks are a 
property of the material and serve as a wavelength 
standard. The wavelengths and tolerance values cannot 
be changed.

To run this test, install a holmium oxide liquid standard 
prepared in dilute perchloric acid.

Wavelength Repeatability
(customized)

Measures the ability of the spectrophotometer to return 
to an identical wavelength in a repeatable manner using 
an appropriate standard. For example, a holmium oxide 
solution prepared in dilute perchloric acid has well 
defined absorption peaks throughout the UV-visible 
range.

To run this test, install a wavelength repeatability 
standard and enter its wavelength, absorbance and 
tolerance values in the boxes to the right of the test 
name. For more information, refer to the 
documentation that came with the standard.

Test Description
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Photometric Accuracy
(customized)

Automates the comparison of measured absorbance (or 
%T) of photometric accuracy standards with their 
certified values.

To run this test, install a photometric accuracy standard 
that has been calibrated to known absorbance values at 
specified wavelengths and enter its wavelength, 
absorbance and tolerance values in the boxes to the 
right of the test name.

Photometric Repeatability 
(customized)

Automates 10 absorbance (or % T) measurements of a 
photometric repeatability standard at a predefined 
wavelength and calculates the standard deviation of the 
measurements. Generates a Pass result when the 
standard deviation is less than 0.001.

To run this test, install a photometric repeatability 
standard that has been calibrated to known absorbance 
values at specified wavelengths and enter its wavelength, 
absorbance and tolerance values in the boxes to the 
right of the test name.

Resolution
(Toluene/Hexane)

Measures the ability of the spectrophotometer to resolve 
adjacent features in a spectrum.

To run this test, install a 0.02% (v/v) solution of 
toluene in hexane and a hexane blank. The wavelengths 
and tolerance values cannot be changed.

Stray Light , 
• KCl, 198 nm
• KI, 220 nm
• NaI, 220 nm
• NaNO2, 340 nm

Compares measured stray light at the indicated 
wavelength with the allowed range of values.

To run this test, install a stray light standard designed to 
measure stray light at one of the available wavelengths. 
The wavelength and tolerance values cannot be 
changed.

Photometric Noise
• 0A (260 nm)
• 1A (260 nm
• 2A (260 nm)

Measures the amount of noise at 260 nm.

To run the 0A (260 nm) noise test, use an empty cell 
holder. For the latter two tests, use 1A and 2A 
metal-on-quartz filters suitable for the UV region for 
these tests.

Test Description
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Related Topics

Overview of PV

Performing PV Tests

Performing PV Tests
 To perform PV tests

1. If using a CVC, install the CVC in the spectrophotometer sample compartment.

For information,  refer to the to the CVC User Guide in the “Accessories” section or your 
documentation media.

1. Click Performance Verification in the right pane in Home.

The available tests appear in the right pane. If no CVC is installed, all of the tests 
described in the previous section will be available. If a compatible CVC is properly 
installed and a valid calibration file has been loaded, the Performance Verification screen 
will display the names of the performance tests that CVC is designed to run. Refer to 
Calibrated Validation Carousels (CVCs) for more information.

2. Select the tests to run.

To select or deselect all the listed tests, double-click Run above the column of check 
boxes.

3. For selected tests that require it, enter information such as wavelength, value and 
tolerance in the provided boxes.

Baseline Flatness
(Abs, 800-200 nm)

Measures the flatness of a baseline scan over the region 
from 800 nm to 200 nm with smoothing applied to the 
data.

To run this test, use an empty cell holder.

Photometric Drift Measures the absorbance drift of the instrument over a 
one-hour period.

To run this test, use an empty cell holder. Let the 
instrument warm up fully before initiating this test.

Test Description

Note  Select the Classic group in Home if Performance Verification is not available 
for the current group.

Note  Tests that require the Mercury Lamp calibration accessory can be selected only 
after the accessory has been properly connected and installed in the instrument.
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Heed the following precaution if using an accessory:

4. Click the Run button in the left pane.

5. Follow the instructions that appear.

To end the tests before they are finished, click Stop. Alternatively, click Cancel when a 
prompt appears during a test.

The test results appear in a window. The test results can be printed or copied from the 
window. A signature block appears at the end.

Completed PV reports are saved automatically and appear on the PV Reports tab in My 
Data. See My Data for instructions for viewing results later.

6. Click Close.

Related Topics

Overview of PV

PV Test Descriptions

CAUTION  Avoid pinch hazard. If using a CVC accessory, keep hands and objects clear 
of the accessory during operation.
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6

INSIGHT Security Software

Optional INSIGHT Security software adds features for digitally signing files and verifying 
digital signatures, as explained in this document or Help system.

INSIGHT Security software, together with Thermo Security Administration software, also 
lets the system administrator set system policies and control user access to INSIGHT software 
features. See Access Control, System Policies, and Signature Meanings for complete 
information.

Getting Started with INSIGHT Security Software
The steps for setting up a secure system are outlined below. For more detailed instructions, 
read the indicated sections of the manuals on the documentation media for your 
spectrophotometer and INSIGHT software.

1. Set up Windows® administration including accounts, groups and other aspects of 
Windows administration—performed by the network administrator or system 
administrator. Include at least one user with full administrative rights and one with 
restricted rights. For more information, refer to the “Setting Up Windows 
Administration” chapter of the Security Administration User Guide.

NOTICE    You must install Security Administration software and associate INSIGHT 
Security software with it before running INSIGHT Security software for the first time.

Contents

• Getting Started with INSIGHT Security Software

• Access Control, System Policies, and Signature Meanings

• Event Logging

• Sample History Information

• INSIGHT Security Software Icons

• Signing a File

• Verifying a Signature
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2. Install Security Administration software and add INSIGHT Security software to the 
security database—performed by the system administrator or lab manager. Security 
Administration can be installed on the computer running INSIGHT Security software or 
on a computer that will be the server for Security Administration (recommended if 
multiple computers will run INSIGHT Security software).

To add the INSIGHT Security application to the security database:

a. Open the Security Administration program.

b. Choose File (menu) > Add Application.

c. Select the INSIGHT.XML file. The file is found on the Root directory of the 
software installation media.

d. If you will be installing other add-on software such as CUE that require access 
control, repeat steps a through c to add their XML files (for example CUE.XML) to 
the security database.

e. Restart the computer that has INSIGHT Security software installed, search for the 
server and then test the connection.

f. Start INSIGHT Security software and complete the hardware installation of the 
spectrophotometer. (If you are running workstation software, this step is not needed.)

3. Install INSIGHT Security Software on each computer that will be used to run INSIGHT 
software—performed by the system administrator or lab manager. Any other add-on 
software you purchased can also be installed at this time.

If you are using a network, after installing INSIGHT software, set the Thermo Fisher 
Scientific service accounts so that they are not running as local system accounts. Refer to 
the “Setting Service Accounts” chapter of the Security Administration User Guide for more 
information.

4. Set up INSIGHT software accounts and file permissions—performed by a system 
administrator or lab manager familiar with INSIGHT software. For more information, 
refer to the “Setting Up Client Application Accounts” chapter of the Security 
Administration User Guide and Access Control, System Policies, and Signature Meanings 
in this document.

Access Control, System Policies, and Signature Meanings
The Access Control features, System Policies and Signature Meanings described below are 
available in Security Administration for INSIGHT software when INSIGHT Security 
software is installed and added to the security database.

Use the Access Control and System Policy features to set the rights of individual users or 
groups of users to use the protected features of INSIGHT software (the features included in 
the security database). A protected feature will be available only if the logged-in user has the 
right to use it.
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Use the Signature Meanings features to specify the meanings that will be available for 
electronic signatures for each user or user group. For example, the Signature Meanings can be 
set so that only a particular user—for instance, the lab manager—is allowed to sign a file with 
the “Approval” meaning.

 To set access control features, system policies and signature meanings for INSIGHT

1. Start the Security Administration program.

2. Open the Access Control folder for INSIGHT by clicking its plus sign.

A tree of folders and other items appears. Each item in the tree represents a protected 
function or group of functions for which access control is available.

3. Click a feature to display options for controlling access to that feature. For more 
information about a feature, see Table 1.

4. Open the System Policies folder for INSIGHT by clicking its plus sign.

A tree of icons appears. Each icon in the tree represents a system policy or group of 
policies; that is, operations for which access control is available.

5. If a check box appears to the left of a policy, you can specify whether it is selected or not 
selected for different “policy groups.” A policy group is a group of users for whom you can 
set system policies. For more information, refer to the “Creating a policy group” chapter 
of the Security Administration User Guide.” Other policies let you specify system attributes 
such as a default configuration or default directory.

6. Open the Signature Meanings folder for INSIGHT by clicking its plus sign.

The first time Security Administration is run, the default list of signature meanings 
appears. See Table 1 for descriptions of the default signature meanings for INSIGHT 
software.

7. Click a signature meaning in the list to display information about its access rights. If a 
check mark appears to the left of a listed user group, those users can select that signature 
meaning when signing a file.

If changes have been made to the list, the available meanings in INSIGHT software may 
be different. Refer to the “Changing the Available Signature Meanings” chapter of the 
Security Administration User Guide for more information.

8. When you are finished setting access options for all features and policies, choose File > 
Save to save the settings in the security database.

For more information, refer to the “Setting Security Policies for Client Applications” chapter 
of the Security Administration User Guide.

Note  If a client application was running while you used Security Administration to 
change its security policy settings, the new settings will not take effect until the 
application is exited and restarted.
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The table below describes INSIGHT access control features and policies.

Table 1. INSIGHT access control features and policies

Feature Description

Ability to run INSIGHT Specifies which users can run INSIGHT software. (See 
“Controlling access to client application features” in the 
“Using Security Administration” chapter of the Security 
Administration User Guide for general instructions.) If a user 
has not been granted the ability to run the software, an error 
message appears when the user attempts to start it.

Ability to delete workbooks Specifies which users can delete workbook files with the 
Delete button in My Data.

Ability to delete PV reports Specifies which users can delete Performance Verification 
reports with the Delete button in My Data.

Ability to delete templates Specifies which users can delete template files with the Delete 
button in My Data.

Ability to delete Scan 
samples

Specifies which users can delete Scan sample data files from 
the current workbook by right-clicking a sample in the results 
table in Measure Scan and choosing Remove.

Ability to edit templates Specifies which users can set parameters in Settings.

Ability to configure reports Specifies which users can change settings in Reports.

Ability to perform PV tests Specifies which users can run Performance Verification tests.

Ability to perform 
wavelength calibration

Specifies which users can use the Wavelength Calibration 
buttons on the Calibrations tab in System Settings.

Ability to calibrate Sipper Specifies which users can use the Sipper Calibrate button on 
the Calibrations tab in System Settings.

Ability to calibrate Linear 
Cell Changer

Specifies which users can use the Linear Cell Changer 
Calibrate button on the Calibrations tab in System Settings.

Ability to update CVC 
calibration

Specifies which users can use the Load CVC Calibration 
button in Performance Verification.

Ability to select CVC tests 
to perform in PV

Specifies which users can select listed tests for the CVC in 
Performance Verification.

Math menu Specifies which users can use the commands in the Math 
menu.

Analyze menu Specifies which users can use the commands in the Analyze 
menu.

Ability to set Rate 
parameters

Specifies which users can set parameters in Settings for the 
Rate application.
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Options tabs Specifies which users can change settings on the tabs in 
Options.

System Settings tabs Specifies which users can change settings on the tabs in 
System Settings.

Authenticate on startup Requires users in the specified policy groups to enter a valid 
name and password when starting INSIGHT software.

Prevent overwriting of files Ensures that existing files are not overwritten when users in 
the specified policy groups save workbook or template files.

If a user for whom this policy is selected attempts to save a file 
using the same file name as an existing file, a message says the 
file cannot be overwritten. The user can choose OK to close 
the message and then save the file using a different file name.

If a user saves a file while this policy is selected, the file will be 
set to read-only in its properties. In the future, users will not 
be able to overwrite this file, even when this policy is not 
selected.

Prevent delete, rename and 
right-click in file dialog 
boxes

Prevents users in the specified policy groups from performing 
these operations in file dialog boxes:

• Deleting a file by selecting it and pressing the Delete key 
on the keyboard.

• Renaming a file by selecting its name (by slowly clicking 
the name twice) and typing a new name.

• Displaying a shortcut menu by right-clicking a file. 
Normally a menu displayed this way lets the user perform 
operations such as copying, deleting or renaming the file.

This policy can be used in conjunction with the Prevent 
changing directories when saving files policy (see below) to 
achieve the desired type of control over file operations for each 
user.

Prevent printing unsaved 
data

Prevents users in the specified policy groups from printing 
spectral data that has not been saved.

Prevent changing 
directories when saving files

Prevents users in the specified policy groups from changing 
directories (“browsing”) when saving files.

Feature Description
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Prevent signature reason 
entry when signing files

Prevents users in the specified policy groups from entering a 
custom signature meaning when signing a file.

When this policy is selected, only the standard signature 
meanings are available for the affected users.

When this policy is not selected, the prompt requesting a 
signature lets the user type a meaning in the Reason For 
Signature text box.

Require signature when 
saving workbook files

Requires users in the specified policy groups to provide a 
digital signature when saving workbooks with Save Workbook 
or Save As Workbook in the File menu. If this policy is not 
selected, users in the specified policy group must use Security 
(menu) > Sign > Active Workbook or Workbook File to sign a 
workbook after it has been saved.

Require signature when 
saving template files

Requires users in the specified policy groups to provide a 
digital signature when saving templates with Save Workbook 
Settings as Template in the File menu. If this policy is not 
selected, users in the specified policy group must use Security 
(menu) > Sign > Template File to sign a workbook after it has 
been saved.

Require signature when 
saving PV results

Requires users in the specified policy groups to provide a 
digital signature when saving Performance Verification results.

Directory for workbooks Designates for each policy group a directory for saving 
workbooks with Save Workbook or Save As Workbook in the 
File menu.

Directory for templates Designates for each policy group a directory for saving 
templates with Save Workbook Settings as Template in the 
File menu.

Feature Description
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The signature meanings in the default list for INSIGHT software are described below.

Event Logging
To provide a system audit trail, Security Administration uses the Event Log service in 
Windows software to record Security Administration and client application operations, or 
“events,” in a log that you can view with Event Viewer. Examples of logged events include the 
date the event occurred, the type of event, and the user name of the person who was logged in 

Directory for PV reports Designates for each policy group a directory for automatically 
saving Performance Verification reports.

Allow access only to listed 
button groups (blank field 
allows access to all groups)

Specifies the INSIGHT software user groups that are available 
to users in the specified policy group. Selecting a user group in 
Home displays the application buttons for that group. See 
Applications Tab for more information.

Type the desired user groups in the text box in the Description 
box, with a comma and a space between them; for example:

Classic, Quality Control

In this example, these users would have access to the 
applications for the Classic group (Fixed, Scan, Quant, Rate, 
Bio Applications and Performance Verification) and the 
applications for the Quality Control group.

Leave the text box blank to give users in the specified policy 
group access to all applications.

Signature Meaning Description

Authorship - signifies ownership Indicates that the user signing the file is the person who 
created it.

Approval - the record is 
approved for use

Indicates that the user signing the file has approved it for 
use.

Reviewed - record contents have 
been reviewed

Indicates that the user signing the file has reviewed it.

Revision - the record has been 
revised

Indicates that the user signing the file has changed it.

Note  Users can be allowed to enter custom signature meanings. See “Prevent signature 
reason entry when signing files” in Access Control, System Policies, and Signature 
Meanings for details.

Feature Description
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when the event occurred. The Event Log service allows all file operations to be logged, both 
within and outside of applications that are run on the system, even if a client application is 
not running. By recording this information, Security Administration allows your system to 
meet the audit trail requirements of 21 CFR Part 11.

 To view the log of events for Security Administration and your client applications

1. Start the Windows Event Viewer on the computer where Security Administration is 
installed.

Refer to your Windows documentation for information about locating the Event Viewer 
feature in your version of Windows software.

2. In the left pane of the Event View window, click the Thermo Electron icon.

A log of significant events that occurred while your client applications were being used 
appears in the right pane. You can sort the events according to date, category, user and so 
on by clicking the column headings.

3. To see detailed information about an event, double-click the event (use the up and down 
arrows to see information about the previous or next event).

You can also export the list of events.

4. When finished, close the Event Viewer.

For more information on the Windows Event Viewer, see its associated Help system.

Sample History Information
To access information about a data point or spectrum, open the workbook, right-click its row 
in the sample measurements table and choose Properties. Click the tabs along the top of the 
Sample Properties window to see information about the sample, the instrument and any 
accessories that were used to collect the data, and any electronic signatures that were applied.

INSIGHT Security Software Icons

To see information about the signature status of the current workbook, click any of these 
icons.

This icon at the bottom of the INSIGHT window indicates that the current workbook 
is signed.

This icon indicates that current workbook has not been signed since it was last 
changed.

This icon indicates that current workbook has not been saved (or signed).
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When INSIGHT Security software is installed...

• The root directory for template groups shown on the Preference tab in Options is set 
using Thermo Security Administration.

• A Sign button appears in the Performance Verification report window. Use it to sign the 
displayed report.

Related Topics

Signing a File

Verifying a Signature

Signing a File
If INSIGHT Security Software is installed, use the following procedures to digitally sign 
workbook and template files. The visible portion of a digital signature consists of a user name, 
a date and a stated reason for signing. A digital signature also contains encrypted information 
used to detect whether the file has changed since it was signed.

 To sign the open workbook

1. Choose Security (menu) > Sign > Active Workbook.

2. Enter a password.

3. Select a signature reason (if permitted).

4. Choose OK.

A verification message appears.

5. Choose OK.

 To sign a saved workbook

1. Choose Security (menu) > Sign > Workbook File.

2. Locate and select the desired file and then click Open.

3. Enter a password.

4. Select a signature reason (if permitted).

5. Choose OK.

A verification message appears.

6. Choose OK.
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 To sign a saved template

1. Choose Security (menu) > Sign > Template File.

2. Locate and select the desired file and then click Open.

3. Enter a password.

4. Select a signature reason (if permitted).

5. Choose OK.

A verification message appears.

6. Choose OK.

Related Topics

INSIGHT Security Software

Verifying a Signature

Verifying a Signature
If INSIGHT Security Software is installed, use the following procedures to verify digital 
signatures for workbook and template files.

 To verify the signature for a workbook

1. Choose Security (menu) > Verify Signature > Workbook File.

2. Locate and select the desired file and then click Open.

A verification message appears.

3. Choose OK.

 To verify the signature for a template

1. Choose Security (menu) > Verify Signature > Template File.

2. Locate and select the desired file and then click Open.

A verification message appears.

3. Choose OK.

Related Topics

INSIGHT Security Software

Signing a File
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I

Symbols
%T button  66

Numerics
3D image

displaying  63
rotate, zoom, pan  57

A
Abs button  66
absorbance values

display for quant  111
access control  307–308
access cover

instrument detector  20
mercury lamp  20
sample compartment  18
tubing  19

accessories
aligning  155
parameters  102, 108, 117, 125, 167, 182, 196, 211, 223, 

236, 250, 264, 278
standard  24
status  64
tubing connectors  19

Accessories tab
DNA Melting  196
Fixed  102
Nucleic Acid  167
Nucleic Acid Labels  182
Pierce 660 nm Protein Assay  278
Pierce BCA  236
Pierce Modified Lowry  264
Protein A280  211
Protein Biuret  292
Protein Bradford  250
Proteins & Labels  223
Quant  117
Rate  125

Scan  108
accessories, manual

installing  25
removing  26

accessories, Smart
installing  27
removing  28

accessories, thermostatted
installing  29

acquiring data  60, 71, 73, 79, 172, 186, 201, 214, 227, 240, 254, 
268, 282, 296

acquiring fixed wavelength data  68
action button

Export  132
Measure  98
Preview  132
Print  132
Reset  98
Unlock  98

action buttons  48
adapter

tubing  19, 30
adapters

for connecting tubing  19
Add  140
adding

constant to spectrum  146
group  151
spectra  140

Advanced  294
advanced calculations  49, 85, 170, 184, 213, 225, 238, 252, 266, 
280, 294

advanced equations for Quant  154
air, for instrument purge  23
aligning

accessory  155
detector module  41
single cell holder  24

Alignment tab  155
Analyze menu  64, 147, 149

Index
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Index: B

annotate displayed data  56
annotation  54

add to data display  58
antistatic wipes, for cleaning touchscreen  40
application  43

action buttons  48
associating with group  151
biological  159
data display  54
DNA Melting  190
Fixed  44, 68, 98
Nucleic Acid  161
Nucleic Acid Labels  176
parameters  97
Pierce 660 nm Protein Assay  271
Pierce Modified Lowry  257
Protein A280  205
Protein Bradford  243
Proteins & Labels  217
Quant  44, 73
Rate  45, 120
sample measurement  60
Scan  44, 71, 104
task buttons  47

application buttons  52
Applications tab  151
area, peak  94
arithmetic operations for Fixed, Scan and Quant equations  
86

Auto Trigger  152
autoscale  55
Average  145
averaging

concentration  118, 167, 182, 211, 223, 236, 250, 264, 
278, 292

spectra  145
axes

change appearance of  55
set scale  55

B
bandwidth  100, 107, 116, 124, 166, 181, 195, 210, 222, 235, 
249, 263, 277, 291

bandwidth status monitor
displaying  64

base name  102, 126, 197
Baseline button  48
baseline correction  104
baseline flatness PV test  302
baseline scan

initiating from instrument keypad  36

beam height
spectrophotometer  13

biological applications  159
default values  160
DNA Melting  190, 201
Nucleic Acid  161–162, 168, 172
Nucleic Acid Labels  176, 183, 186
Pierce 660 nm Protein Assay  271–272, 282
Pierce BCA  229, 240
Pierce Modified Lowry  257–258, 268
Protein A280  205, 212, 214
Protein Biuret  296
Protein Bradford  243–244, 254
Proteins & Labels  217, 224, 227, 238, 252, 266, 280, 

294
boot record

System tab  156
button

assign program to instrument front panel  37
Enter  36
Export  132
Extend Time  201
Function  36
Measure  98
Power  36
Preview  132
Print  132
Reset  98
Run  36
Stop  36
Unlock  98
Zero/Base  36

buttons
on instrument front panel  36

C
cable

precaution for connecting detector  41
routing to sample compartment  19, 21
shielding USB  16

calculate additional results  178, 207, 219, 231, 246, 259, 273, 
287

calculations
add for DNA Melting measurements  198
add for Fixed measurements  98
add for Quant measurements  111
add for Rate measurements  127
add for Scan measurements  104
adding custom  85
advanced  49, 85, 170, 184, 213, 225, 238, 252, 266, 280, 

294
between samples  49
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Index: C

edit for DNA Melting  204
edit for rate  81

calculations table  49
adding to reports  134
described  86

calibrating
instrument wavelength  156

Calibrations tab  156
caustic samples

protecting instrument from  22
caution

UV radiation hazard  20, 40
cell changer status monitor

displaying  64
cell holder

alignment  24
installing  25, 27, 29, 31
standard reference  25
standard sample  24

chemicals
precautions for  12

cleaning
instrument exterior  39
instrument touchscreen  40

Clear button  66
closing

reference compartment door  13
sample compartment door  13

color
of axes in data display  55
of spectrum in data display  54

comments
adding to reports  134

company name
adding to reports  152

comparison operations for Fixed, Scan and Quant equations  
86

compartment
reference  13
sample  13

compartment, reference
cleaning  39
installing cell holder in  31

compartment, sample
cleaning  39
installing manual accessory in  25
installing Smart Accessory in  27
installing thermostatted accessory in  29

compliance label  10
component

concentration  111, 164, 178, 207, 219, 231, 246, 259, 
273, 287

INSIGHT software  14
keypad  14
molecular weight  111
name  111, 164, 178, 207, 219, 231, 246, 259, 273, 287
reference compartment  13
sample compartment  13
touchscreen  14

computer
connector  15
external  14
remote  34
switching between local and remote  34

computer control  14
Computer Control instrument

setting up  32
turning off  33

computer, remote
attaching to Local Control instrument  34
switching control to  34

concentration
averaging  118, 167, 182, 211, 223, 236, 250, 264, 278, 

292
factor  174, 188
limits  118, 167
nucleic acid  161
unit  111, 164, 178, 207, 219, 231, 246, 259, 273, 287

configuring
home page  53
report  128

connecting
computer  32
detector cable  41
external computer  15
external trigger  16
mercury lamp  15
power cord  15
purge gas  23
recirculator  29
USB devices  16

connector  15
external trigger  16
external tubing  19
for Smart Accesories  17
instrument detector  20
internal tubing  19
mercury lamp  15, 20
power cord  15
purge  15
remote computer  15
USB  16

connector, electrical
routing to sample compartment  19

constant from spectrum  146
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constants
calculate for DNA Melting experiments  198
calculate for rate experiments  127

contact closure trigger  16
control

local or computer  14
switching from local to remote  34

control limits  100, 118, 167, 182, 211, 223, 236, 250, 264, 278, 
292

displayed for Fixed data  55
conventions  3
Convert Spectra  139
copying

fixed wavelength analysis results  69
quantitative analysis results  73, 75
Scan analysis results  71

cord
routing to sample compartment  19, 21

correction
baseline for Scan  104
for integrating sphere  104
Nucleic Acid  164
quantitative analysis  111, 164, 178, 207, 219, 231, 246, 

259, 273, 287
single beam substitution error  104

correction factor
for quant samples  118
for quant standards  117
for samples  102, 167, 182, 211, 223, 236, 250, 264, 278, 

292
for standards  234, 248, 262, 276, 290

corrosion protection  22
cover

instrument detector  20
mercury lamp  20
reference compartment  13
sample compartment  13

CSV export format  132
CUE script

assign to instrument front panel button  37
running from instrument keypad  36

curve
edit for DNA Melting  204
edit for rate  81

custom calculations
adding  85

cycle time  121, 193

D
data

add 3D image to  57
add ellipse to  56

add grid lines to  58
add image to  56
add rectangle to  56
add text to  56
annotate  56
autoscale  55
lines or points  55
overlaying  49
preventing removal of  152

data acquisition  60, 68, 71, 73, 79, 172, 186, 201, 214, 227, 240, 
254, 268, 282, 296

data display  54
data interval  100, 107, 116, 121, 124, 166, 181, 193, 210, 222, 
235, 249, 263, 277, 291

Data Store tab  153
date  152
decimal digits  152
default values

Bio applications  160
default workbook settings  62
deleting

group  151
spectrum from workbook  60
workbook, template or PV report  130

Derivative  138
derivative  107, 116, 124

converting spectrum to  138
detector

access cover  20
access panel  21
connector, accessing  20
installing  41
intensity  155
precaution for connecting cable  41
removing  40
routing cable  21
storing  41

detector compartment
and UV radiation hazard  20

devices
external keyboard  16
external mouse  16
high power USB  16
portable memory  16
printer  16
supported  16

diameter
for fluid tubing  19
for purge tubing  23

digital signature  315
verifying  316

digits  152
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Index: E

directory  152
display

live  45
dividing

spectra  144
spectrum by constant  146

DNA Melting
Accessories tab  196
application  201
Instrument tab  195
Measurement tab  193
overview  190
Samples tab  197
Tm Calculations tab  198
Type tab  192

DNA melting point
measuring  202

document
organization  3

drain
for sample and reference compartments  39

dry air or nitrogen, for instrument purge  23
duplicate standard  117, 234, 248, 262, 276, 290
duplicates  73, 75

measure with Fixed  70
measure with Quant  74, 76–77

dust
precautions for  12
removing from touchscreen  40

dwell time  121, 193
Dye Chromophore Editor  177, 218

E
editing

CUE scripts  36
DNA Melting calculations  204
label  59
rate calculations  81

ellipse
add to data display  56

e-mailing
data files  4
workbook  62, 153

Enter keypad button  36
equation  115
equations

applying to all measurements in a workbook  86
applying to selected measurements in a workbook  86
available functions  86
for Quant  154

Evolution 200 spectrophotometer

models  9
Export action button  132
exporting

Measure Rate results  62
report  131
standards  117

extend
DNA Melting data acquisition  203
rate data acquisition  81

Extend Time button  201
external

computer  14
computer connector  15
instrument connectors  15

extinction coefficient  111, 174, 188

F
Factor  146
factor

correction for quant samples  118
correction for quant standards  117

Ferrite ring
for shielding USB devices  16

file
Excel  132
image  152
importing spectra  63
template  153
verifying for software installation  65
workbook  62
XML  133

File menu  62
filter, purge gas  23
fingerprints

removing from touchscreen  40
firmware

updating  156
Fixed  44

Accessories tab  102
calculate additional results  98
data acquisition parameters  98
functions  86
Instrument tab  100
Measurement tab  98
parameters  68
sample analysis  69
Samples tab  102

Fixed button  66
Fixed data

display control limits for  55
fixed kinetics data acquisition  79
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flammable gases
precautions for purge  23

fluid
external connectors  19
internal connectors  19

font  152
footer  152
for Quant standard curve  115
Formula and Units tab  154
formulas

define for Fixed measurements  98
define for Quant measurements  111
define for Scan measurements  104
select for data processing  49

formulas for Quant  154
front panel  36

sample compartment, removing  18
function buttons

for switching control to remote computer  34
Function keypad buttons  36
functions

keypad  36
functions for Fixed, Scan and Quant  86
functions for Quant  111

G
gas

installing for purge  23
precautions for purge  23

goggles, safety  40
graphs

adding to reports  134
grid  54
grid lines

add to data display  58
group  52

adding or deleting  151
applications  151

H
hazard

explosion  23
UV radiation in detector compartment  20
UV radiation in mercury lamp compartment  20

header  152
adding to reports  134

heading
adding to reports  134

height of peak  93
Help

organization  3
Help menu  64
Hg lamp

access cover  20
connector  15, 20
for wavelength calibration  156
UV radiation hazard  20

hiding
label  59

high power USB devices  16
hold time

for DNA Melting experiments  193
Home button  47
home page

configuring  53

I
image

add to data display  56
displaying 3D  63

importing
data from another workbook  62
sample list  77
spectrum  62
standards  75, 117

indicator
power  32–34

initializing
instrument  32–34

INSIGHT Security  307–309, 315–316
INSIGHT software  156

for Evolution 200 series spectrophotometer  14
INSIGHT window  45

navigation pane  46
right pane  52

installation qualification  65
installing

instrument detector  41
manual accesory  26
purge gas  23
purge gas filter  23
reference cell holder  31
sample cell holders  25
sample compartment windows  22
Smart Accessory  27
thermostatted accessory  29

instrument  36
cleaning exterior  39
cleaning touchscreen  40
computer  15
Computer Control  32
corrosion protection  22
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Index: K

Enter button  36
initalizing  32–34
installing detector  41
installing manual accessories  25
installing reference holder  31
installing Smart Accessories  27
installing thermostatted accessories  29
keypad buttons  14
keypad functions  36
keypad shortcuts  36
lifting or moving  11
Local Control  33
major components  13
operating precautions  12
ordering parts  42
performance verification  301–302, 305
removable panels  17
removing detector  40
repairing  6
routine maintenance  39
Run button  36
running CUE scripts from keypad  36
safety considerations  9
safety label locations  10
setting up  31
standard cell holders  24
Stop button  36
Zero/Base button  36
z-height  13

Instrument Local parameter  35
instrument panel

assign program to button  37
instrument status monitors  64
Instrument tab

DNA Melting  195
Fixed  100
Nucleic Acid  166
Nucleic Acid Labels  181
Pierce 660 nm Protein Assay  277
Pierce BCA  235
Pierce Modified Lowry  263
Protein A280  210
Protein Biuret  291
Protein Bradford  249
Proteins & Labels  222
Quant  116
Rate  124
Scan  107

instrument, Computer Control
setting up  32
turning off  33

instrument, Local Control
attaching remote computer  34

setting up  33
switching between local and remote  36
turning off  35

integration time  100, 107, 116, 121, 124, 166, 181, 193, 210, 
222, 235, 249, 263, 277, 291

intensity crossings  109
intensity status monitor

displaying  64
interval  121, 193
IQ  65
IWBK export format  133

K
keyboard

connecting  16
Local Control instrument  45
right-clicking with  45
shortcuts  157

keypad
buttons  14
location  13
operation  36
shortcuts  36

keypad button
Enter  36
Function  36
Power  36
Run  36
Stop  36
Zero/Base  36

kinetics  79
data acquisition  79, 83
data acquisition parameters  120

L
labels  54, 59

display or remove  55
safety  10

Lamp tab  156
lamp, mercury

access cover  20
connector  15
for wavelength calibration  156

lamp, xenon
status  156

Layout tab (Reports)  134
layout, report master page  152
left pane

action buttons  48
task buttons  47

legend  54
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Index: M

light beam
height  13

limits
control for Quant  118

line type  55
liquid thermostatted accessories

connecting tubing  19
installing  29

Live Display  45, 66
loading

sample  102, 108
Loading Guide

and Run button  36
and Stop button  36

local control
switching to remote  36

Local Control instrument  14, 156
cleaning touchscreen  40
keyboard  45
setting up  33–34
switching INSIGHT software to  35
touchscreen  14
turning off  35

logarithmic functions for Fixed, Scan and Quant equations  
86

logical operations for Fixed, Scan and Quant equations  86
logo

adding to reports  152

M
maintenance

cleaning instrument  39
cleaning touchscreen  40
installing instrument detector  41
removing instrument detector  40

manual accessories
installing  25
removing  26

math
for data processing  49

Math menu  63, 136, 138–142, 144–146
maximum values

finding  109, 147
Measure action button  98
Measure button  48
Measure button (Live Display)  66
measurement

initiating from instrument keypad  36
stopping from instrument keypad  36

measurement functions for Fixed, Scan and Quant equations  
86

measurement results  60
Measurement tab

DNA Melting  193
Fixed  98
Nucleic Acid  164
Nucleic Acid Labels  178
Pierce 660 nm Protein Assay  273
Pierce BCA  231
Pierce Modified Lowry  259
Protein A280  207
Protein Biuret  287
Protein Bradford  246
Proteins & Labels  219
Quant  111
Rate  121
Scan  104

measuring samples  60
mechanical shock

precautions for  12
melting point  174, 188

measuring for DNA  202
memory device

connecting  16
menu

Analyze  64
File  62
Help  64
Math  63
View  63

menus  62
mercury lamp

access cover  20
connector  15
for wavelength calibration  156
UV radiation hazard  20

merging
workbooks  62

microcuvettes
aligning  24

minimum r squared  117, 234, 248, 262, 276, 290
minimum values

finding  109, 147
modifying

DNA Melting calculations  204
rate calculations  81

module, detector
installing  41
removing  40
storing  41

moisture
precaution for instrument  12

molecular weight  111, 174, 188
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Index: N

component  111
mouse

connecting  16
moving

label  59
multiplying

spectrum by constant  146
My Data  130

N
navigation pane  46
nitrogen, for instrument purge  23
Normalize  141
normalizing spectrum  141
notes

adding to reports  134
Nucleic Acid

Accessories tab  167
application  161–162, 168, 172
Instrument tab  166
Measurement tab  164
overview  161
Samples tab  167
Type tab  163

nucleic acid  161
concentration  161
purtiy  162

Nucleic Acid Labels  183, 186
Accessories tab  182
Instrument tab  181
Measurement tab  178
overview  176
Samples tab  182
Type tab  177

nucleic acids
measuring  172

number of cycles  121
number of samples  102, 108, 118, 126, 167, 182, 197, 211, 223, 
236, 250, 264, 278, 292

number of stages  193

O
off button

for Computer Control instrument  33
for Local Control instrument  35

off switch  15
oil

removing from touchscreen  40
Oligo Calculator  174, 188
on switch  15
opening

reference compartment door  13
sample compartment door  13
workbook, template or PV report  130

operating precautions  12
Options  151
ordering parts  42
overlaying data  49
overlaying spectra  54

P
page

layout  152
number  152

pan
3D image  57

panel
for external tubing connectors  19
instrument  36
sample compartment front  18
sample compartment side  21

panels
removable  17

parameters
resetting  98

parts
ordering  42

path  130, 152
pathlength  163, 177, 206, 218, 231, 245, 259, 273, 287

for quant  110
peak

area  94
height  93

peak area tool  94
Peak Pick  147
Peak Pick tab

Scan  109
peak/valley measurement tool  93
peaks

finding  109, 147
Performance Verification  301, 305

report  130
test descriptions  302

Performance Verification test
baseline flatness  305
noise  304
photometric accuracy  304
photometric drift  305
photometric repeatability  304
resolution  304
stray light  304

photometric accuracy PV test  302
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photometric drift PV test  302
photometric noise PV test  302
photometric repeatability PV test  302
Pierce 660 nm Protein Assay  272, 282

Accessories tab  278
Instrument tab  277
Measurement tab  273
overview  271
Samples tab  278
Standards tab  276
Type tab  273

Pierce BCA  229, 240
Accessories tab  236
Instrument tab  235
Measurement tab  231
Samples tab  236
Standards tab  234
Type tab  231

Pierce Modified Lowry  258, 268
Accessories tab  264
Instrument tab  263
Measurement tab  259
overview  257
Samples tab  264
Standards tab  262
Type tab  259

portable memory
connecting  16

ports
for cords and cables  19
for external tubing  19
for internal tubing  19

power
button  36
connector  15
switch  15

Power button  36
power indicator  32–34
powering off

Computer Control instrument  33
Local Control instrument  35

precautions
explosion hazard  23
operating for instrument  12
safety for instrument  9
shock hazard  16
UV radiation hazard  20

Preferences tab  152
Prevent Removal Of Data  152
Preview action button  132
previewing report  62, 131
Print action button  132

Print button  48
Print button (Live Display)  66
printer

connecting  16
printing

report  62, 131, 152
probe

trigger connector  16
program

assign to instrument panel  37
properties of spectrum  60
protecting

against electrical shock  16
against explosion hazard  23
against UV radiation hazard  40
against UV radiation in detector compartment  20
against UV radiation in mercury lamp compartment  

20
instrument from corrosion  22
USB cables  16

Protein A280  212, 214
Accessories tab  211
Instrument tab  210
Measurement tab  207
overview  205
Samples tab  211
Type tab  206

Protein Biuret  296
Accessories tab  292
Instrument tab  291
Measurement tab  287
Samples tab  292
Standards tab  290
Type tab  287

Protein Bradford  244, 254
Accessories tab  250
Instrument tab  249
Measurement tab  246
overview  243
Samples tab  250
Standards tab  248
Type tab  245

Proteins & Labels  224, 227, 238, 252, 266, 280, 294
Accessories tab  223
Instrument tab  222
Measurement tab  219
overview  217
Samples tab  223
Type tab  218

purge
and subambient temperature samples  23
explosion hazard  23
installing  23
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purge connector  15
purge gas

specifications  23
purging

sample compartment  23
purity

nucleic acid  162
PV  301, 305

test descriptions  302
PV reports

directory for saving  152

Q
Quant  44

Accessories tab  117
calculate additional results  111
data acquisition parameters  110
formulas and units  154
functions  86
Instrument tab  116
Measurement tab  111
parameters  73
sample analysis  73, 75
Samples tab  118
Standards tab  117
Type tab  110

quantitative analysis  73, 75
settings  110

R
r squared  117, 234, 248, 262, 276, 290
radiation hazard

in detector compartment  20
in mercury lamp compartment  20

radiation safety label
detector compartment  11
mercury lamp compartment  10

ramp rate  121, 193
Rate  45, 79

Accessories tab  125
data acquisition  79, 83
data acquisition parameters  120
exporting results from  62
Instrument tab  124
Measurement tab  121
Rate Calculations tab  127
Samples tab  126
Type tab  120, 192

rate calculations
perform or modify  81

Rate Calculations tab  127

Ratio  144
ratioing spectra  144
reagents  229, 244, 272
recirculator

connecting to instrument  29
rectangle

add to data display  56
reference cell holder

installing  31
standard  25

reference compartment
cleaning  39
installing cell holder in  31
location  13
opening and closing  13

reference correction
for DNA Melting experiments  195
for rate experiments  124

reference detector
intensity  155

reference sample
cell holder for measuring  25

reference wavelength correction  100
reflection correction  104
region

finding peaks in  109, 147
limiting  95

region-threshold tool  95
remote computer

attaching to Local Control instrument  34
switching control to  34

remote control
switching to local  36

removable panels  17
removal of data

preventing  152
removing

instrument detector  40
manual accessory  26
sample compartment windows  22
Smart Accessory  28

repairing instrument  6
replicate standard  117, 234, 248, 262, 276, 290
replicates  73, 75

measure with Fixed  70
measure with Quant  74, 76–77

report
adding sample data to  49
configuring  128
layout  152
printing  62
signing  307
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Report Master Page tab  152
Reportable Data tab  134
reports  131

fitting to page width  134
Reset action button  98
resetting

template settings  97
resolution

PV test  302
results

calculate additional  178, 207, 219, 231, 246, 259, 273, 
287

results table
adding to reports  134
described  55

right pane  52
right-clicking using touchscreen keyboard  45
rotate

3D image  57
label in data display  59

Run button  36

S
safety

label locations  10
lifting or moving instrument  11
removing and installing detector  40
using mercury lamp  20

safety considerations  9
safety goggles  40
safety label

compliance  10
UV radiation  11

safety warning
explosion hazard  23
general operation  9
shock hazard  16
UV radiation hazard in detector compartment  20
UV radiation hazard in mercury lamp compartment  20

sample
legend  54
loading or saving  102, 108
measuring  60, 73, 79, 172, 186, 201, 214, 227, 240, 254, 

268, 282, 296
measuring fixed wavelength  68–69
measuring with Scan  71
name  54, 102, 108, 118, 126, 167, 182, 197, 211, 223, 

236, 250, 264, 278, 292
quantifying  73, 75

sample averaging  102
sample cell holder

10 mm rectangular  24
installing  26

sample compartment
cleaning  39
connector  17
fluid ports  19
installing manual accessory in  25
installing Smart Accessory in  27
installing thermostatted accessory in  29
location  13
opening and closing  13
purge connector  15
purging  23
removing manual accessory from  26
removing side panel from  21
removing Smart Accessory from  28
routing cords and cables to  19

sample compartment front panel
removing or replacing  18

sample compartment windows
and corrosive samples  22
and purge  23
removing and replacing  22

sample correction factor  167, 182, 211, 223, 236, 250, 264, 278, 
292

sample data
selecting for reports  134

sample detector
installing  41
intensity  155
removing  40

sample ID
display or remove  55

sample labels
display or remove  55

sample measurements table
adding to reports  135
described  55

sample point
X and Y values  92

samples
calculations between  49
volatile, corrosive or caustic  22

Samples tab
DNA Meltiing  197
Fixed  102
Nucleic Acid  167
Nucleic Acid Labels  182
Pierce 660 nm Protein Assay  278
Pierce BCAl  236
Pierce Modified Lowry  264
Protein & Labels  223
Protein A280  211
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Protein Biuret  292
Protein Bradford  250
Quant  118
Rate  126
Scan  108

Samples tab (Reports)  134
samples table  102

adding to reports  134
described  55

samples table columns
adding to reports  134

samples, subambient temperature
and purge  23

saving
PV reports  152
sample  102, 108
template  152
workbook  62, 152–153

Savitzky-Golay algorithm  138
scale

for data axes  55
scale of displayed data  54
Scan  44

Accessories tab  108
calculate additional results  104
data acquisition parameters  104
functions  86
Instrument tab  107
Measurement tab  104
parameters  71
Peak Pick tab  109
sample analysis  71
Samples tab  108

scan
acquire over time  120, 192

Scan button  66
Scan data

displaying 3D image of  63
scan kinetics data acquisition  83
scan speed  107, 116, 124, 166, 181, 210, 222, 235, 249, 263, 277, 
291

script
assign to instrument front panel button  37

scripts
running from instrument keypad  36

security  307–309
selection tool

zooming in  92
selection tool (Live Display)  66
setting up

Computer Control instrument  32
Local Control instrument  33

Local Control instrument with remote computer  34
settings  98
Settings button  97
sharing custom templates  63
shielding

for USB devices  16
shipping cost for warranty repair  6
signature  315

meanings  309
verifying  316

signed workbook  307
signing

file  315
report  307

single cell holder
installing  26
removing  26
standard  24

Smart Accessory
connector  17
installing  27
removing  28

Smooth  107, 136
smoothing  116, 124, 138

spectrum  109, 136
software  156

CUE  36
INSIGHT  14

specifications
fluid tubing  19
instrument beam height  13
purge tubing  23

spectra
displaying  54
overlaying  49, 54

spectral cursor tool  92
spectral cursor tool (Live Display)  66
spectral region

finding peaks in  109, 147
spectrophotometer

assign program to front panel button  37
cleaning exterior  39
cleaning touchscreen  40
computer connector  15
Computer Control  32
connecting to recirculator  29
corrosion protection  22
Enter button  36
external connectors  15
initializing  32–34
INSIGHT software  14
installing detector  41
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installing manual accessories  25
installing purge  23
installing reference holder  31
installing sample compartment windows  22
installing Smart Accessories  27
installing thermostatted accessories  29
internal connectors  17
keypad buttons  14
keypad functions  36
keypad shortcuts  36
lifting or moving  11
Local Control  33
major components  13
models  9
opening and closing reference compartment  13
opening and closing sample compartment  13
operating precautions  12
ordering parts  42
performance verification  301–302, 305
Power button  36
removable panels  17
removing detector  40
routine maintenance  39
Run button  36
running CUE scripts from keypad  36
safety label locations  10
setting up  31
shielding of USB cables  16
standard cell holders  24
Stop button  36
touchscreen  14
Zero/Base button  36
z-height  13

spectrophotometer, Computer Control
setting up  32
turning off  33

spectrophotometer, Local Control
attaching remote computer  34
setting up  33
turning off  35

spectrum
adding  140
averaging  145
converting spectrum to derivative  138
converting to other Y-axis units  139
deleting from workbook  60
display attributes  54
displaying  54
expanding, contracting or rolling  96
finding peaks in  109, 147
finding value crossings in  149
normalizing  141
overlaying  49

performing math operations on  146
properties  60
ratioing  144
remeasuring  60
smoothing  109, 136
subtracting  142
zooming in on or moving  92

stages  121, 193
standard cell holders  24
standard curve  111
standard deviation  73, 75
standards  75, 110–111, 117, 234, 248, 262, 276, 290

adding to reports  134
import or export  117
replicate, duplicate or triplicate  117, 234, 248, 262, 276, 

290
Standards tab

Pierce 660 nm Protein Assay  276
Pierce BCA  234
Pierce Modified Lowry  262
Protein Biuret  290
Protein Bradford  248
Quant  117

statistical functions for Fixed, Scan and Quant equations  86
statistics

for data processing  49
status monitors  64
Stop button  48
Stop button (Live Display)  66
Stop keypad button  36
Store button  66
storing

instrument detector  41
stray light PV test  302
string functions for Fixed, Scan and Quant equations  86
Subtract  142
subtracting  146

spectra  142
switch

power  15
system policies  307–308
System Settings  154

T
table

calculations  49, 86
Peak Pick results  147
results  55
sample measurements  55, 135
samples  102
Value Level Crossing results  149
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target temperature
for DNA Melting experiments  193
for rate experiments  121

task buttons  47
temperature

record for rate experiments  120, 192
unit for DNA Melting experiments  193
unit for rate experiments  121

temperature controller status monitor
displaying  64

temperature range
for DNA Melting experiments  193
for rate experiments  121

template
deleting  130
description  110, 120, 192
directory for saving  152
list  52
name  110, 120, 192
opening  130
resetting settings in  97
saving workbook settings as  62
settings  110
sharing  63
signing  315
verifying signature for  316

tests
Performance Verification  302

text
add to data display  56
adding to reports  134

Thermo Security Administration  307
Thermo Software IQ  65
thermostatted accessory

installing  29
tubing connections  19

time  152
record for rate experiments  120, 192
unit for DNA Melting experiments  193
unit for rate experiments  121

Tm calculations
perform or modify  204

Tm Calculations tab  198
tools

for Live Display  66
touchscreen

and Local Control instruments  14
cleaning  40
keyboard  45
location  13
switching control to  35

trademarks  7

Trigger port
location  16

trigonometric functions for Fixed, Scan and Quant equations  
86

triplicate standard  117, 234, 248, 262, 276, 290
triplicates  73, 75

measure with Fixed  70
measure with Quant  74, 76–77

TSV export format  132
tubing

adapters  19, 30
tubing access panel

removing and replacing  19
tubing specifications

for fluids  19
for purge gas  23

turning off
Computer Control instrument  33
Local Control instrument  35

turning on
Computer Control instrument  32
Local Control instrument  33
Local Control instrument with remote computer  34

Type tab
DNA Melting  192
Nucleic Acid  163
Nucleic Acid Labels  177
Pierce 660 nm Protein Assay  273
Pierce BCA  231
Pierce Modified Lowry  259
Protein A280  206
Protein Biuret  287
Protein Bradford  245
Proteins & Labels  218
Quant  110
Rate  120, 192

U
unit  121, 193

component concentration  111, 164, 178, 207, 219, 231, 
246, 259, 273, 287

units  139
for Quant  154

Unlock action button  98
unlocking

application settings  98
update policy  6
USB connector

for external computer  15
USB connectors

for external devices  16
USB devices
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high power  16
shielding  16
supported  16

use sample correction factor  102
user group  52
user name  315
UV radiation safety label

detector compartment  11
mercury lamp compartment  10

V
valleys

finding  109, 147
measuring  93

Value Level Crossing  149
verifying

signature  316
software installation  65

view finder  96
View menu  63
viewing

3D image  57
control limits  74
PV reports  130
report  128
sample data  54
spectral data  54
standard curve for Quant  76

volatile samples
protecting instrument from  22

W
warning

explosion hazard  23
safe operation  9
shock hazard  16
UV radiation hazard  20

warranty  4
and failure to use sample compartment windows  22
items not covered by  5
period  5
repair  6
shipping cost for items covered by  6
update policy  6

wavelength
calibrating  156
multiple for rate  120, 192
range  107, 116, 166, 181, 210, 222, 235, 249, 263, 277, 

291
wavelength accuracy PV test  302
wavelength correction

for DNA Melting experiments  195
for rate experiments  124

wavelength repeatability PV test  302
wavelength status monitor

displaying  64
wavelengths

for DNA Melting experiments  195
for Fixed experiments  102
for Quant experiments  111
for Rate experiments  124
for Scan experiments  107

weight/volume
calculate for quant standards  117

windows, sample compartment
and corrosive samples  22
and purge  23
removing and replacing  22

workbook  130
appending data to  60
closing  62
creating  62
default settings  62
deleting  130
deleting spectrum from  60
directory for saving  152
e-mailing  4, 62, 153
opening  130
saving  62, 153
signed  307
signing  315
verifying signature for  316

workbooks
merging  62

X
xenon lamp

status  156
XML export format  132
X-Y pairs

adding to reports  134

Y
Y-axis unit  100, 107, 116, 124, 195

Z
Zero button  48
Zero button (Live Display)  66
zero scan

initiating from instrument keypad  36
Zero/Base keypad button  36
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z-height
spectrophotometer  13

zoom
3D image  57
spectrum  66, 92
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